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Notice
Every effort was made to ensure that the information in this document was accurate at 
the time of printing. However, information is subject to change without notice, and VIAVI 
reserves the right to provide an addendum to this document with information not avail-
able at the time that this document was created.

Copyright 
© Copyright 2021 VIAVI, LLC. All rights reserved. VIAVI, Enabling Broadband and 
Optical Innovation, and its logo are trademarks of VIAVI, LLC. All other trademarks and 
registered trademarks are the property of their respective owners. No part of this guide 
may be reproduced or transmitted electronically or otherwise without written permission 
of the publisher.

Trademarks
VIAVI, MTS/T-BERD 4000 V2, MTS/T-BERD 2000 and SmartOTDR are trademarks or 
registered trademarks of VIAVI in the United States and/or other countries.

Microsoft, Windows, Windows CE, Windows NT, and Microsoft Internet Explorer are 
either trademarks or registered trademarks of Microsoft Corporation in the United States 
and/or other countries.

Netscape Navigator is a trademark or registered trademark of Netscape Communica-
tions Corporation in the United States and other countries.

Ordering information
This guide is a product of VIAVI's Technical Information Development Department, 
issued as part of the User Manual.

Product Regulatory Compliance

California Proposition 65

California Proposition 65, officially known as the Safe Drinking Water and Toxic Enforce-
ment Act of 1986, was enacted in November 1986 with the aim of protecting individuals 
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in the state of California and the state's drinking water and environment from excessive 
exposure to chemicals known to the state to cause cancer, birth defects or other repro-
ductive harm.

For the VIAVI position statement on the use of Proposition 65 chemicals in VIAVI prod-
ucts, see the Hazardous Substance Control section of VIAVI's Standards and Policies 
web page.

EU WEEE and Battery Directives

This product, and the batteries used to power the product, should not be disposed of as 
unsorted municipal waste and should be collected separately and disposed of according 
to your national regulations.

VIAVI has established a take-back processes in compliance with the EU Waste Electrical 
and Electronic Equipment (WEEE) Directive, 2012/19/EU, and the EU Battery Directive, 
2006/66/EC.

Instructions for returning waste equipment and batteries to JDSU can be found in the 
WEEE section of VIAVI's Standards and Policies web page.

If you have questions concerning disposal of your equipment or batteries, contact 
VIAVI's WEEE Program Management team at WEEE.EMEA@VIAVISolutions.com.

EU REACH

Article 33 of EU REACH regulation (EC) No 1907/2006 requires article suppliers to 
provide information if a listed Substances of Very High Concern (SVHC) is present in an 
article above a certain threshold.

For information on the presence of REACH SVHCs in VIAVI products, see the 
Hazardous Substance Control section of VIAVI's Standards and Policies web page.

EU CE Marking Directives (LV, EMC, RoHS, RE)

This product conforms with all applicable CE marking directives. Please see EU Decla-
ration of Conformity for details.
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About This Guide

The MTS/T-BERD 2000 of VIAVI provides a handheld, modular platform designed for 
the construction, validation and maintenance of fiber networks.

The topics discussed in this chapter are as follows:

• “Purpose and scope” on page xviii

• “Assumptions” on page xviii

• “Technical assistance” on page xviii

• “Recycling Information” on page xviii

• “Conventions” on page xviii
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Purpose and scope
The purpose of this guide is to help you successfully use the MTS/T-BERD 2000 
features and capabilities. This guide includes task-based instructions that describe how 
to install, configure, use, and troubleshoot the MTS/T-BERD 2000 with modules.

Assumptions
We are assuming that you have basic computer and mouse/track ball experience and 
are familiar with basic telecommunication and fiber optic concepts and terminology.

Technical assistance 
If you require technical assistance, call 1-844-GO-VIAVI. For the latest TAC information, 
go to http://www.viavisolutions.com/en/services-and-support/support/technical-assis-
tance.

Recycling Information
VIAVI recommends that customers dispose of their instruments and peripherals in an 
environmentally sound manner. Potential methods include reuse of parts or whole prod-
ucts and recycling of products components, and/or materials.

Waste Electrical and electronic Equipment (WEEE) 
Directive

In the European Union, this label indicates that this product should not be 
disposed of with household waste. Il should be deposited at an appropriate 
facility to enable recovery and recycling.

Conventions
This guide uses naming conventions and symbols, as described in the following tables.
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Table 1 Typographical conventions

Description Example

User interface actions appear in this typeface. On the Status bar, click Start.

Buttons or switches that you press on a unit 
appear in this TYPEFACE.

Press the ON switch

Code and output messages appear in this type-
face.

All results okay

Text you must type exactly as shown appears in 
this typeface.

Type: a:\set.exe in the dialog box

Variables appear in this typeface. Type the new hostname.

Book references appear in this typeface. Refer to Newton’s Telecom Dictio-
nary

A vertical bar | means “or”: only one option can 
appear in a single command.

platform [a|b|e]

Square brackets [ ] indicate an optional argu-
ment.

login [platform name]

Slanted brackets < > group required arguments. <password>

Table 2 Keyboard and menu conventions 

Description Example

A plus sign + indicates simultaneous keystrokes. Press Ctrl+s

A comma indicates consecutive key strokes. Press Alt+f,s

A slanted bracket indicates choosing a submenu 
from menu.

On the menu bar, click 
Start > Program Files.
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Table 3 Symbol conventions

Table 4 Safety definitions

This symbol represents a general hazard.

This symbol represents a risk of electrical shock.

NOTE

This symbol represents a Note indicating related information or tip.

This symbol, located on the equipment or its packaging indicates that 
the equipment must not be disposed of in a land-fill site or as municipal 
waste, and should be disposed of according to your national regula-
tions.

WARNING

Indicates a potentially hazardous situation which, if not avoided, could result 
in death or serious injury.

CAUTION

Indicates a potentially hazardous situation which, if not avoided, may result 
in minor or moderate injury.
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Chapter 1Principle of Measurement

This chapter gives the principles of the measurements made by the optical modules.

The topics discussed in this chapter are as follows:

• “Principle of reflectometry measurements” on page 2

• “Principle of optical power and attenuation measurements” on page 4
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Principle of reflectometry measurements
Optical time domain reflectometry consists in injecting a light pulse into one end of the 
optical fiber to be analyzed and observing, at the same end, the optical intensity passing 
through the fiber in the opposite direction to the propagation of the pulse.
The signal detected is exponentially diminishing in form, typical of the phenomenon of 
backscattering, with superimposed peaks due to reflections from the ends of the fiber or 
other variations in the refractive index.

Information yielded by the measurement
From a backscatter trace it is possible, in particular, to determine the position of a section 
of fiber within a link. The measurement result must reveal: 

• the attenuation

• the location of faults, by their distance from a point of origin,

• attenuation with respect to distance (dB/km)

• the reflectance of a reflective event or a link.

Figure 1 Trace showing typical backscattering
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Validity of Measurement ITU-T
ITU-T in recommendations G.650, G.651 and G.652, give backscatter measurement as 
an alternative method for measuring attenuation, the method of reference being the cut 
fiber.

The field of application of backscatter is not limited, but the conditions for application of 
this method are nevertheless stipulated:

• injection conditions: Fresnel reflections must be limited at fiber input.

• a high-power source (laser) should be used.

• receiver bandwidth should be chosen to achieve a compromise between pulse 
rise time and noise level.

• backscatter power should be represented on a logarithmic scale.

Reflectance
Reflectance is a value with which the coefficient of reflection of a reflecting optical 
element can be quantified. It is defined as the ratio of the power reflected by the element 
over the incident power.

These reflections are due to variations in refractive index all along the optical link in 
certain telecommunications applications. If they are not controlled, they may degrade 
the performance of the system by perturbing the operation of the emitting laser (espe-
cially DFB lasers) or may generate interference noise in the receiver by multiple reflec-
tions.

The reflectometer is particularly well suited to the measurement of discrete reflectances 
on an optical fiber link. To calculate the coefficient of reflection, it is necessary to 
measure the total amplitude of the Fresnel reflection generated and then to apply a 
conversion formula to obtain the reflectance value.

This formula takes into account:

• the total amplitude of the reflection measured by the reflectometer.

• the pulse width used to measure the amplitude of the reflection (in nanoseconds) 

To locate faults, a reflectometer measures only time. Consequently, group 
velocity must be introduced in order to determine the distance of the loca-
tion. This is done by introducing the refractive index of the fiber into the 
instrument.
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• the backscatter coefficient of the fiber used:

– typical values of the backscatter coefficient for a pulse of 1 ns and

– for a single-mode fiber:-79 dB at 1310 nm

-81 dB at 1550 nm and 1625 nm

– for a multi-mode fiber:-70 dB at 850 nm

-75 dB at 1300 nm

Principle of optical power and attenuation 
measurements

Power measurements
A power meter, is all that is needed to measure emitted or received power:

• to measure emitted power, connect the power meter directly to the output of the 
optical emitter;

• to measure the power at the input of an optical receiver, the power meter is 
connected to the end of the fiber, at the point where the optical receiver would be 
connected.

Attenuation measurements (optical link loss)
For measurement of the attenuation of power in a complete link or in elements such as 
sections of fiber, connections or optical components, a light source and a power meter 
are required. 

This attenuation is usually deduced from the measurement of optical power at two 
points:

NOTE

To measure the widest range of reflection coefficient, it is necessary to insert 
a variable optical attenuator between the reflectometer and the link to be 
tested. This attenuator enables the level of the trace to be adjusted so as to 
avoid saturation of the reflectometer by the reflection to be evaluated.
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Attenuation A(dB) = P1 (dBm) - P2 (dBm)

To perform accurate measurements, the following conditions are necessary

• Use a light source which is stable both in time and as a function of temperature.

• Make sure that all connections and fibers and the receiving cell are perfectly 
clean.

• Use a reference link between the laser source and the test subject. If several 
measurements are to be made under identical light injection conditions, this refer-
ence fiber must not be disconnected during the period while measurements are 
taking place.

Insertion loss method

1 The power meter is first connected to the laser source via the reference fiber: P1 
is measured.

2 Then the fiber to be tested is inserted between the reference fiber and the power 
meter: P2 is measured.

The difference between P2 and P1 gives the attenuation of the fiber under test.

It is preferable to use the same type of connector at both ends of the fiber being 
tested, to ensure the same connection conditions for measuring P1 and P2.

Accuracy of measurements

• A high degree of accuracy is often required. It is then necessary to perform a 
preliminary calibration without the fiber under test to eliminate the losses due to 
connections as far as this is possible. To do this, use the «Reference Value» func-
tion.

Laser light 
source Reference 

fiber
Link under test 

Power meter of the 
MTS/T-BERD 
2000/4000 V2

1 2
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Chapter 2Starting up

This chapter describes how to start using the MTS/T-BERD or the SmartOTDR.

The topics discussed in this chapter are as follows:

• “Unpacking the device - Precautions” on page 8

• “Precautions relating to the OTDR Module use” on page 8

• “Fitting and removing a module (not available with SmartOTDR)” on page 8

• “Connecting fiber optic cable” on page 10

• “Optical connectors and interchangeable adapters” on page 13
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Unpacking the device - Precautions
We suggest that you keep the original packing material. It is designed for reuse (unless 
it is damaged during shipping). Using the original packing material ensures that the 
device is properly protected during shipping.

If another packaging is used (for returning the equipment for example), VIAVI cannot 
give warranty on good protection of the equipment.

If needed, you can obtain appropriate packing materials by contacting VIAVI Technical 
Assistance Center.

Precautions relating to the OTDR Module use
If the equipment is used in a manner not specified by the manufacturer, the protection 
provided by the equipment may be compromised.

Contact authorized, trained and qualified service personnel for all services.

Fans on OTDR Modules

Take care fans may be present on the side of the OTDR product. Under normal opera-
tion, no injury may occur to the user

Fitting and removing a module (not available with 
SmartOTDR)

The MTS/T-BERD must be switched off, and if it is operating on the 
mains, its supply cable must be unplugged.

NOTE

Refer to MTS/T-BERD user manual to check other pertinent environmental 
conditions related to the mainframe.
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Fitting a module
1 Turn the instrument face down on the work surface.

2 Set the two notches on the module part (1a) into the two holes provided for that 
purpose on the Base (1b).

3 Make flush the 2 connections (2a & 2b), on module and base.

4 Once positioned, fix the module to the base screwing the 2 screws (3a) fixing the 
receptacle.

5 With a T-BERD/MTS 4000 V2, repeat the process if a small module must be 
installed at the back of the platform.

Figure 2 Fixing the module to the 2000 Base-Unit

Captive screws fixing the module

1b
1b

2a

2b

2000 Platform with 
module installed

2000 Platform without module

1a
1a

3a
3a
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Removing a module
1 Unscrew the two captive fixing screws of the module completely (up to the stop).

2 Remove the two slots of the module from their housing onto the base.

3 Carefully remove the module out of its slot.

Connecting fiber optic cable

Inspecting and cleaning connector end faces

Figure 3 Fixing the module to the 4000 V2 Base-Unit

Captive screws fixing the module(s)

1a1b

2b

2a

Always inspect and clean the connector end face of the optical fiber 
cable and the test port before mating both together.

VIAVI is not responsible for damage and reduced performance caused 
by bad fiber handling and cleaning.
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• Optical connector contamination is the #1 source of performance degradation 
and test equipment repair

• A single particle mated into the core of a fiber can cause significant back reflec-
tion, insertion loss and equipment damage. Visual inspection is the only way to 
determine if the fiber connectors are truly clean before mating them.

Follow this simple "INSPECT BEFORE YOU CONNECT" process to ensure fiber end 
faces are clean prior to mating connectors

Optical connector types
There are many optical connectors in the market place. Always ensure to use a high 
quality connector that meets the international standards. 

Two main types of connectors are deployed in the telecommunication industry: 

1 Straight polished connectors, so called PC or UPC

2 Angled polished connectors, so called APC

The PC or UPC-type test port is identified by a grey cap with the addition of a "PC" label.
The APC-type test port is identified by a green cap with the addition of a "APC" label.

Figure 4 "Inspect Before You Connect" process
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Caution

Never connect a PC connector into an APC test port or vice versa. This will result in 
damaging the connector end faces.

Figure 5 Modules with APC and PC connector for T-BERD/MTS 2000 & 4000 V2

Figure 6 PC/APC bad connection

WARNING

VIAVI declines responsibilities of connector damages if a poor quality con-
nector is used or APC to PC connections made. Test port connector repair 
will be charged
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Connecting Fiber optic cable to test port
After ensuring proper cleaning of both end connectors, follow the below steps in order 
to correctly and safely connect the optical fiber into the test port:

1 Carefully align the connector and test port to prevent the fiber end from touching 
the outside of the port and scratching the end face.

2 Push the connector to firmly place it inside ensuring physical end face contact.

Optical connectors and interchangeable adapters
Fiber Optic modules will come with a UPC or APC connector.

WARNING

All the universal connectors are available on the OTDR Modules, except on 
the LA Module.

NOTE

If your connector features a keying mechanism, ensure that it is correctly fit-
ted into the test port's insert.

NOTE

If your connector features a screw-on sleeve, tighten the connector to firmly 
maintain the fiber in place. Do not over tighten as this will damage the fiber 
and the test port.

WARNING

Never force the connector ferrule or insert it with an angle into the test port 
adapter. Mechanical stress may permanently damage the ceramic sleeve of 
the adapter or the end face of the connector. A new adapter purchase only 
will get the unit back to operation
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Interchangeable adapters
VIAVI offers interchangeable adapters, allowing the user to switch from one adapter to 
another according to which fiber type he intends to work with.
Adapter types supplied are: FC, SC, DIN and ST.

In order to switch from an adapter to another, proceed as shown.

Switchable Adapters
For the SmartOTDR and some test modules, VIAVI offers switchable adapters (also 
called screw-type adapters). Adapter types supplied are: FC, SC and LC.

To mount a switchable adapter:

1 Unscrew the two screws of the adapter currently mounted onto the connector.

2 Remove the adapter

3 Set the new adapter vertically on the optical connector, making flush the «mark» 
on the adapter with the mark on the connector.

Figure 7 4 different types of adapters may be mounted on the universal connector

FC Adapter (EUFCAD)

DIN Adapter (EUDINAD)

ST Adapter (EUSTAD)

SC Adapter (EUSCAD)

Figure 8 Removing and refitting an adapter

Pull out in the direction of the 
arrow in order to release the 
adapter from the lug holes

To place an adapter, position 
the handle as shown in order to 
engage with the the lugs, push 
hard and pull the handle down
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4 Fix the adapter with the two screws.

Once adapter is mounted, the module is ready to be used onto the Base-Unit.

Figure 9 Position of the adapter onto the connector

Figure 10 Fixing the adapter

NOTE

It is recommended to use a magnetic screwdriver.

NOTE

When changing the optical connector, take caution not to scratch the con-
nector mating surfaces. Carefully align the removable piece and the base-
plate ferrule when inserting the adapter part.
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Cleaning universal connectors
Remove the adapter in order to access the ferrule and clean it using a cotton swab.
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Chapter 3Activating OTDR function

For the T-BERD/MTS, make sure the OTDR module is correctly set onto the equipment. 

One the equipment is switched on, the desired OTDR function must be selected before 
any OTDR configuration, or measurement.

The topics discussed in this chapter are as follows:

• "Selecting the Smart Test" page 18

• "Selecting the OTDR Expert function" page 19
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Selecting the Smart Test

Principle of the Smart Test
The Smart Test is used to perform OTDR acquisitions using a pre-loaded configuration 
file (no setup required) and access to essential analysis features.

Selecting Smart Test
The Smart Test function is available whatever is the OTDR module set onto the MTS/T-
BERD or whatever is the SmartOTDR used.

To select this function, after the equipment starts:

1 Press the HOME button

2 Select the Smart Test icon.

The icon turns yellow   .

3 Press SETUP or RESULTS button to display the page for the configuration file 
selection displays (see Figure 13 on page 23).

.

Figure 11 Home page

NOTE

The selection of Smart Test icon automatically deselects the Expert OTDR 
icon and vice-versa.
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Selecting the OTDR Expert function

Principle of the OTDR Expert
The OTDR Expert is used to

• perform OTDR acquisitions with full OTDR setup capabilities, and advanced anal-
ysis features.

• create configuration files that can be loaded by Smart Test users.

Selecting OTDR Expert
The OTDR Expert function is available whatever is the OTDR module set onto the MTS/
T-BERD or whatever is the SmartOTDR used.

To select this function, after the equipment start:

1 Press the HOME button

2 Select the OTDR Expert icon .

The icon turns yellow .

3 Press SETUP button to configure the acquisition.

NOTE

In the case a Singlemode/Multimode module, one line contains the Multi-
mode icons and a second one the Singlemode icons.

To distinguish both modes, multimode icons contain the MM mark.

NOTE

The selection of OTDR Expert icon automatically deselects the Smart Test 
icon and vice-versa.

NOTE

In the case a Singlemode/Multimode module, one line contains the Multi-
mode icons and a second one the Singlemode icons.

To distinguish both modes, multimode icons contain the MM mark.
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Chapter 4Configuring the reflectometry 
test

This chapter describes the different stages in configuring a reflectometry measurement 
using an OTDR module, in Smart Test or Expert OTDR.

The topics discussed in this chapter are as follows:

• "Configuring the unit for Smart Test" page 22

• "Configuring the test in Expert OTDR" page 25
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Configuring the unit for Smart Test
1 Once the Smart Test icon is validate, press SETUP or RESULTS button to display 

the Configuration file selction screen.

Smart Test standard process
2 Select the configuration file, which contains all acquisition parameters and file 

storage setup, and which has been created in Expert mode (see “Saving OTDR 
configuration in a file” on page 48).

3 Configure / modify some parameters before starting the test.

4 Start the acquisition (standard or real time)

5 Save the results

Selecting the configuration file
To load the configuration file to be used for Smart Test test:

1 In the selection file screen, select the configuration file to be used for the acquisi-
tion on Smart Test mode.

The file is underlined in purple.

2 Press Load to load the selected file and display the current parameters for this 
configuration.

Figure 12 Standard Smart Test Process
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3 Once loaded, the configuration parameters that can be modified displays.

Modifying some parameters before the acquisition
In Smart Test mode, the user have access to 4 parameters he can modified before 
launching the test.

• Laser The acquisition will be carried out on the wavelength(s) 
selected (for multiple-wavelength modules). In case of a multi-
wavelength module, select All to perform a measurement for 
all the wavelengths available (this parameter visible exclusively 
on modules with one single OTDR port). The possible values 
depend on the module used. 

Figure 13 Load file as Smart Test Configuration

Location of the 
configuration files 
for Smart Test

Figure 14 Smart Test Setup page
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• Distance unit select the unit to be used for distance (km / kfeet / miles / 
meter / feet / inch).

• Launch cable Define if the Launch Cable must be taken into account for the
acquisition: No / Yes.
If Yes is selected, set the length clicking on Set Length and
enter the distance using the numeric keypad. Click on  to
validate (or on  to cancel) 

• Alarms Define if alarms thresholds must be applied for the acquisition:
Select No if no alarm thresholds must be applied.
Select Yes to define alarms, and press Alarm Level to define 
the pre-defined thresholds for the acquisition.

See Table 1 and Table 2 to get the values for each pre-defined alarm thresholds.

The thresholds can be modified only in Expert mode and saved in a new configu-
ration file.

Once all configuration parameters are correctly defined, the acquisition can be 
launched.

Press the Config key to return to configuration selection screen (see Figure 14 on 
page 23).
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Configuring the test in Expert OTDR
1 Once the Expert OTDR icon is selected, press the SETUP button.

Dialog boxes and menu keys on the same screen enable selection of

In these windows, the parameter selected is in video inverse.

Configuring the Acquisition parameters
You can choose the OTDR acquisition parameters. 

1 Once the Setup page is displayed, press Acquisition menu key to configure the 
Acquisition parameters.

– Acquisition parameters

Used for the OTDR acquisition– Alarms parameters

– Analysis parameters

– Link parameters
Used for the OTDR results saving

– File parameters 

Figure 15 OTDR setup in Expert OTDR mode
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The Acquisition Setup page is divided into two parts: the Acquisition box and the 
Launch cable box.

Parameters

Switch Port (MPO only)
If an MPO Switch Module is installed onto the Platform, select manually the switch port 
on the parameter Switch Port.

Laser
The acquisition will be carried out on the wavelength(s) selected (for multiple-wave-
length modules). In case of a multi-wavelength module, select All to perform a measure-
ment for all the wavelengths available (this parameter visible exclusively on modules 
with one single OTDR port). The possible values depend on the module used. 

Acquisition Mode
Select the kind of acquisition to be performed:

Manual The acquisition parameters Pulse / Range / Resolution can be set 
by user.

Auto The acquisition parameters Pulse / Range / Resolution are defined 
automatically and cannot be modified.

The Measurement time will be set to Auto, but can be modified (see "Acq. Time" 
page 27).

Smart Acq (not available in Multimode) It is a fully automated acquisition 
process which uses different width of pulses, for a single wavelength, 
to maximize the events detection. The multiple traces coming from 
the different acquisition are displayed individually with each one’s 
table of events.

The option of SmartAcq forms a single graph and table of events per 
wavelength, recombining the most relevant sections of each pulse. It 
also allows displaying the Smart Link Mapper (SLM) view

If some acquisition parameters are not accessible (not visible or displayed in 
grey), check in the Home page that the Expert OTDR function is selected 
(see "Selecting the OTDR Expert function" page 19).
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Range
The possible range depends on the pulse length selected. This range is given for each 
pulse length in the paragraph “Ranges” on page 253. This parameter is exclusively 
configurable if Acquisition parameter is set to Manual. It depends on the module/Smar-
tOTDR used.

Auto allows to detect automatically the range.The range is selected as a 
function of the end of the fiber.

Pulse
From 3ns to 20µs according to module/SmartOTDR used. Parameter selectable only if 
Acquisition parameter is set to Manual.

See "Typical specifications" page 249.

Resolution
This parameter is exclusively configurable if Acquisition parameter is set to Manual.

Auto resolution is selected automatically according to the last two parame-
ters above.

High Resolution the highest resolution is applied

High Dynamic the highest dynamic is applied

Acq. Time
Real time the equipment performs up to ten acquisitions per second (see 

"Performing OTDR acquisitions" page 52).

NOTE

According to the value selected for Pulse parameter, the Range parameter 
can be automatically modified, and vice-versa.

NOTE

Whatever is the acquisition mode selected, an acquisition in real time mode 
can be launched maintaining the START/STOP button pushed for about 2 sec-
onds.
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Manual Enter the acquisition time desired (from 5 s. to 5 minutes max).

Predefined Select one of the acquisition times predefined: 10 seconds / 20 
seconds / 30 seconds / 1 minute / 2 minutes / 3 minutes.

Otdr Connector test
This parameter allows to choose if a test of the front connector must be performed when 
acquisition is launched.

No the OTDR connection is tested with indication Bad/Good.

Yes & Continue the OTDR connection is tested, and if the state is not good, the 
acquisition continues but a warning displays.

Yes & Abort the OTDR connection is tested, and if the state is bad, a warning 
displays and the acquisition stops.

Launch cable parameters

Launch Cable End / Receive Cable Start
No All the results are displayed and referenced on the basis of the board 

of the module.

Evt 1, 2, 3 The results relating to the launch cable are eliminated from the table. 
Attenuation and distances are then measured on the basis of the 
marker Evt 1, 2 or 3 selected.

Distance Use the Edit Number key to enter a distance (Min= 0 / Max=50 km / 
164.042 kfeet / 31.075 miles) or affect the active cursor value, using 
the Set Cursor Distance key.

NOTE

If the Acquisition parameter is defined to Auto, then the Time parameter is 
defined to Auto, but can be modified.
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Include Link Start Connector / Include Link End Connector 
Defining the Launch Cable End parameter with an event number or a distance will auto-
matically activate the corresponding parameter Include Link Start Connector. This 
parameters can be set to Yes if the budget must include the connectors loss of the 
launch cable at end 

Defining the Receive Cable Start parameter with an event number or a distance, will 
automatically activate the corresponding parameter Include Link End Connector. This 
parameters can be set to Yes if the budget must include the connectors loss of the 
launch cable at start 

If those parameters are set to No, the budget only displays the connector loss of the 
fiber.

Specific Acquisition parameters with DWDM 
Modules
If a DWDM Module is installed onto the Platform, the Setup > Acquisition screen allows 
to configure specific parameters for acquisition on DWDM networks:

Figure 16 Launch Cable / Receive Cable

OTDR 

Launch Cable Receive Cable
Fiber Under Test

Launch 
Cable end

Receive Cable 
start

Distance of the 
launch cable

Distance of the 
receive cable
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Wavelength
The acquisition will be carried out on the wavelength selected. Once a wavelength is 
selected, the Channel is indicated just before to the wavelength.

Click on Prev10 or Next10 to display the 10 previous / following wavelengths.

Unit
Define the wavelength unit to be used for acquisition: THz or nm.

Dwdm Grid
Select one of the pre-defined Grid to be used for acquisition: 50 GHz / 100 GHz / 200 
Even / 200 Odd.

Or

Select User and press the Edit User Dwdm Grid menu key to define a grid.

Defining a grid

1 Once the menu key Edit User Dwdm Grid is pressed, a table displays.

Figure 17 Acquisition parameters with DWDM module
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2 Click on Channel menu key to display either a list of the channels selected, or a 
list of all channels available.

3 To configure your own grid, click on one channel (highlighted) and click on Yes or 
No to modify the selection.

or

Click on Select all or Unselect all to select all channels of the table, or to unse-
lect the selected ones.

4 Once configuration of the grid is completed, press Exit to return to Setup screen.

Configuring the Alarms parameters
In the Setup page, press Alarms softkey (if one parameter is selected in the current 
screen, press Top Menu soft key to display the right menu keys and click on Alarms).

Once the Alarms page is displayed, configure the parameters for applying thresholds to 
results displayed.

Threshold
None The alarm function is not active.

User Thresholds can be defined for: Splice Loss / Connector Loss / 
Reflectance / Splitter Alarm / Mux/Demux / Slope / Fiber Length Min 
and Max / Link Loss Min and Max / ORL.

TIA-568 3 / TIA-568 3.RL35 / ISO/IEC 11801 2002 or 2010 / ISO/IEC 14763-3 2006 or 
2014 / Default / G.697/G.98x PON / G.697/IEEE PON

Figure 18 User-defined grid
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Select one of this parameter to configure the alarm thresholds with 
predefined values:

Splitter alarms for Default and G.697/G.98x PON & G.697/IEEE PON

Table 1 Singlemode Module

Splice Loss Connector loss Slope1 Reflectan
ce

ORL
Mux/

Demux

Default > 0.20 dB > 0.50 dB > 1.00 dB/km > - 35 dB < 27 dB No

TIA-568.3

> 0.30 dB

> 0.75 dB > 1.00 dB/km No

No

-

TIA-568.3 RL35 > 0.75 dB > 1.00 dB/km > - 35 dB -

ISO/IEC 11801 
(2002)

> 0.75 dB > 1.00 dB/km No -

ISO/IEC 11801 
(2010)

> 0.50 dB > 0.40 dB/km > - 35 dB -

G.697/G.98x 
PON
G.697/IEEE PON

> 0.50 dB No > - 35 dB < 25 dB -

ISO/IEC 14763-3 
(2006)

> 0.50 dB > 1.00 dB/km No

No

-

ISO/IEC 14763-3 
(2014)

> 0.75 dB > 0.40 dB/km No -

1. This parameter is not available in OEO-OTDR configuration

Splitter Alarm Default G.697/G.98x PON / G.697/IEEE PON

1 X 2 > 5.0 dB > 4.2 dB

1 X 4 > 8.0 dB > 7.8 dB

1 X 8 > 11.0 dB > 11.4 dB

1 X 16 > 14.0 dB > 15.0 dB

1 X 32 > 17.0 dB > 18.6 dB

1 X 64 > 21.0 dB > 22.0 dB

MTS2100 4100 Module US rev015.book  Page 32  Jeudi, 14. janvier 2021  3:41 15



Chapter 4 Configuring the reflectometry test
Configuring the test in Expert OTDR

User Manual 77000010208 Rev. 015 33

Link Loss Max for G.697/G.98x PON & G.697/IEEE PON
Select: No/ Manual or: 

• for G.697/G.98x PON: 20 dB (A) / 25 dB (B) / 30 dB (C)

• for G.697/IEEE PON: 23 dB (PX-10) / 26 dB (PX-20)

If results are above those thresholds, they are highlighted in red in the table of results, 
and the icon  appears at the top right of the screen.

If all the results lie within the thresholds (no result is in red or yellow), they are displayed 
in green in the table and the icon  is displayed at the right top of the trace.

Configuring the Analysis parameters
In the Setup page, press Analysis softkey (if one parameter is selected in the current 
screen, press Top Menu soft key to display the right menu keys and click on Analysis).

The Analysis Setup page is divided into two parts: the Parameters box and the 
Measurement box.

Parameters

Section Attenuation
dB/km Displays the section slope in the table of results. When the fiber is 

too short to measure the slope accurately, no value is displayed 
(empty field).

Table 2 Multimode Modules (not available in SmartOTDR)

Default TIA-568C / ISO/IEC 11801 / ISO/IEC 14763-3

Splice Loss > 0.20 dB > 0.30 dB

Connector Loss > 0.50 dB > 0.75 dB
>0.50 dB for ISO/IEC 14763-3 standard

Slope 850 nm > 3.50 dB/km > 3.50 dB/km

Slope 1300 nm > 1.50 dB/km > 1.50 dB/km

Reflectance > - 35 dB -

ORL < 27 dB -
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dB Displays the section Loss in the table of results. With short fiber 
where the slope cannot be measured with a good accuracy, the loss 
in dB is approximate and displayed.

None The section attenuation and Loss values are not displayed in the 
table of results.

Section Length
Define if the distance between the marker of the event and the previous marker must be 
indicated in the results table: select Yes or No.

Index of refraction
Choice of group refraction index of the whole fiber. 

User Define for each wavelength (1310 SM, 1360-1510 SM, 1550 SM, 
1625 SM) a refraction index of 1.30000 to 1.69999. The selection of 
an index alters the value of the section AB (actual distance between 
cursors A and B).

or,

If the actual distance between the cursors A and B is known, enter its 
value under Section AB to establish the index of the fiber. Selection 
of this distance causes the display of the indices. The extreme 
distance values are given by the index values (1.30000 to 1.70000).

or

You can also enter the Link Length, if it is known, using the Numeric 
keypad.

Predefined It is possible to choose one of the predefined values given for certain 
cables. The corresponding indices given in the table below are 
repeated on the screen.

Figure 19 Predefined index values (Single Mode)

Wavelength (nm) 1310 SM 1360 - 1510 SM 1550 SM 1625 - 1650 SM

Generic G652 G657 1.46750 1.46800 1.46800 1.46850

Generic G653 G655 1.46750 1.46800 1.46800 1.46850

ATT SM 1.46600 1.46700 1.46700 1.46700

Corning SMF-28 1.46750 1.46810 1.46810 1.46810

Corning SMF-DS 1.47180 1.47110 1.47110 1.47110

Corning SMF-LS 1.47100 1.47000 1.47000 1.47000
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Scatter coefficient
User Selects for each wavelength, the backscatter coefficient of -99 dB to 

-50 dB by increments of 0.1dB. Modification of the backscatter coeffi-
cient K changes the measurements of reflectance and ORL. 

Auto Backscatter coefficients are selected automatically for each wave-
length.

In Multimode, two predefined scatter coefficients are available:

Corning-Leaf 1.46890 1.46840 1.46840 1.46900

Draka SMF 1.46750 1.46800 1.46800 1.46850

Draka Longline 1.46700 1.46700 1.46710 1.46750

Draka Teralight 1.46820 1.46820 1.46830 1.46850

Draka Benbright 1.46750 1.46750 1.46800 1.46850

Fitel Furukawa 1.47000 1.47000 1.47000 1.47000

OFS Lucent Allwave 1.46750 1.46750 1.46750 1.46850

Lucent Truewave 1.47100 1.47100 1.47000 1.47000

SpecTran SM 1.46750 1.46810 1.46810 1.46810

Sterlite 1.46700 1.46700 1.46750 1.46750

Sumitomo Litespec 1.46600 1.46600 1.46700 1.47000

Sumitomo Pure 1.46600 1.46600 1.46700 1.47000

Figure 20 Predefined index values (Multi Mode) - Not available in SmartOTDR

Wavelength (nm) 850 MM 1300 MM

Corning 62.5 1.50140 1.49660

Corning 50 1.48970 1.48560

SpecTran 62.5 1.49600 1.49100

Generic 50 1.49000 1.48600

Generic 62.5 1.49000 1.48700

Generic OM1-62/125 1.49600 1.49100

Generic OM2-3- 4  50/125 1.48200 1.47700

Figure 19 Predefined index values (Single Mode)

Wavelength (nm) 1310 SM 1360 - 1510 SM 1550 SM 1625 - 1650 SM
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Generic 50 850 MM - > -66.3 dB

1300 MM -> -73.7 dB

Generic 62.5 850 MM -> -66.1 dB

1300 MM -> -70.3 dB

The default values are given in the paragraph "Reflectance" page 3.

Distance Unit
Define the unit of the distances displayed: km, kfeet, miles, meter, feet, inch.

Results on trace
None the trace alone

All the trace with results and markers.

Graphics the trace with markers only.

If All or Graphics is selected, the reflectometry trace is displayed with a dotted vertical 
line set on the end of launch cable  (if the Launch Cable is defined in the SETUP 
menu) and a dotted vertical line on the end of fiber .

Event Notes1

No no display of notes

Notes display of notes entered by the user 

Uncertainty display of indicators of the level of confidence in the measurement 
result.

Measurement

Otdr Connector Measurement
This parameter allows to choose if a measurement of the front connector must be 
performed when acquisition is launched.

No In the results table, the first line corresponds to the first event 
detected.

Yes In the results, the first result corresponds to the front connector 
measurement, at 0 meter (estimated value).

1.Available exclusively if Super Expert license is installed
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Detection
Splice Select if a level of detection for splice must be defined.

Press Edit Number soft key and select a value:

– Enter a min level of detection, from 0.01 to 1.99 dB

– No: no splice detection

– Auto: to automatically detect splice

Reflectance Select if level of detection for reflectance must be defined.

Press Edit Number soft key and select a value:

– Enter a min level of detection, from -98 to -11 dB

– None: no reflectance detection

– All: all reflectances are detected

Ghosts Choice (Yes / No / No Analysis) of whether information relating to 
ghosts is to be displayed. If ghosts are displayed, the reflection icon 
in the table of results appears dotted and the reflection value is 
displayed in brackets on the trace, for example «(R:-50 dB)».

Fiber end Once parameter is selected, press Edit Number key to display the 
numeric keypad and select the wished value:

– Auto (recommended): option in which the equipment automatically detects 
the end of a fiber.

– > 3 to > 20 dB (steps of 1 dB): threshold of detection of end of fiber. 

Bend (not available in Multimode) With any dual or triple-wavelength 
measurement module, the user will have access to the macro bend 
detection function in the test setup. Each event of the selected wave-
lengths will then be compared.

Once parameter is selected, press Edit Number key to display the numeric 
keypad and select the wished value:

– None: Bend will not be detected.

– Auto: Bend will be automatically detected.

– Define by user: Enter the bend value (in dB), with direction keys or 
numeric keypad.

Mux/Demux Once parameter is selected, press Edit Number key to display the 
numeric keypad and select the wished value:

– Auto (recommended): option in which the T-BERD/MTS automatically 
detects the mux/demux.

– > 0.50 to > 4.99 dB: threshold of detection of mux/demux. 

– None: no mux/demux available.
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Event After Fiber End1

If Yes, the events after the end of the link are detected.

Total Loss1

Before evt for a given line on table, the total loss result does not include the 
splice/connector loss of the corresponding line

After evt on the table, for a given line, the total loss measurement on the table 
does include the splice/connector loss of the corresponding line.

Configuring the Link parameters
In the Setup page, press Link softkey (if one parameter is selected in the current screen, 
press Top Menu soft key to display the right menu keys and click on Link).

The information entered in the Link Description window concerns the editing and/or the 
modifications of the cable and fiber parameters. When a trace is recalled without recall 
of the configuration, the parameters of this trace will be present only in its signature.

Link Description

Fiber Id
Select the parameter Fiber Id and enter a name for the fiber, using the edition keypad.

1.Available exclusively if Super Expert license is installed

NOTE

The softkey Copy File/Link to all is displayed when one parameter is 
selected in the Link or File Setup page and when the Powermeter or Source 
function is active. 

It allows to apply the Link and File configuration parameters of the current 
applications to all the other active Fiber Optic applications (powermeter, and 
source).
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Fiber Number / Fiber Code1

The parameter Fiber Number becomes Fiber Code if, in the Cable Structure window, 
the Cable Content parameter is defined on another parameter than Fiber (Ribbon/
Fiber, Tube/Fiber or Tube/Ribbon/Fiber). See page 41.

The fiber code corresponds to the fiber number if, in the Cable Structure, the parameter 
Color coding is defined on No. 

The fiber code corresponds to the fiber color if, in the Cable Structure, the parameter 
Color coding is defined on Yes.

1 Select the parameter Fiber Number/Fiber Code and modify the parameter using 
the left and right direction keys.

The fiber number can be automatically incremented/decremented at each new 
file save if it has been configured in the File Setup page (see “Configuring the File 
parameters” on page 43).

1.Fiber Code is available exclusively if Super Expert license is installed.

NOTE

The Fiber Code and the fiber number concatenated with Fiber Name are 
interdependent: they are incremented or decremented at the same time. 
However, the fiber number remains a number only, while the fiber code is 
alphanumerical. Whether it includes a color code or not (see “Cable struc-
ture” on page 41), it may be composed of one, two or three parts (see figure 
Table 21 on page 39). 

Figure 21 Example of incrementation of fiber code

Fiber and cable parameters used in the example:

Fiber Name: ’Fiberx’
Cable Content: ’Tube/Fiber’
Max Tube: 12
Max Fiber: 24
Coding used for the fiber and the tube: TIA

Fiber N Fiber N+1

 Color Code  Yes No Yes  No

<Fiber Name> Fiberx24 Fiberx24 Fiberx25 Fiberx25

<Fiber Code> Bl/Aq- 1/24 Gold/Bl 2/1
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Change Fiber Nbr 
Increment the fiber number is automatically incremented at each new file-save.

Decrement the fiber number is automatically decremented at each new file-save

User defined Use Edit Number softkey to enter the increment/decrement value for 
fiber number.

Note: to decrement the number, enter the sign «-» before the number. Example: -
1.

Min: -999 / Max: 999 / Auto: 0

 No the Fiber number must not automatically modified.

Extremities are different1

In some cases, it is interesting to save different information for the origin and the 
extremity of the cable.

If this option is validated, it is possible, after selecting the extremity to be edited in the 
Cable Structure menu, to modify the values specific to the cable (cable name, color 
coding, content of the coding), for each of these extremities. See chapter “Cable struc-
ture” on page 41) 

To display/modify the data specific to the fiber (name and code), it is necessary to 
change direction temporarily. In the "O->E" direction, the information on the origin can 
be edited, and in the "E->O" direction, that on the extremity.

Cable Id
This parameter allows to enter an identification of the cable, using the Edition menu.

Direction
The direction shows if the acquisition has been made from the origin to the extremity (A-
>B) or from the extremity to the origin (B->A). Changing direction makes it possible, 
when different extremities are handled, to see the parameters of the fiber for the other 
extremity.

Location A
The name of the Location A of the link may be entered here.

1.Available exclusively if Super Expert license is installed
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Location B
The name of the Location B of the link may be entered here.

Cable structure1

This line opens a sub-menu, all the parameters of which can be different for each 
extremity.

View extremity If extremities are declared as different (see “Extremities are different” 
on page 40), this parameter allows to navigate between the 
Extremity and Origin parameters.

Cable Id If the extremities are different, you can specify the cable identification 
for the origin and the extremity.

Color Coding Choice of whether or not to apply a color coding to the fiber. This 
choice is made at link level, as all the fibers of a given link, for a 
given extremity, will be coded the same way. This choice modifies 
the result of the <Fiber Code> line. See “Fiber Number / Fiber Code” 
on page 39.

Cable content Shows how the color code is to be used (see figure “Cable structure 
menu” on page 41):

1.Available exclusively if Super Expert license is installed

Figure 22 Cable structure menu

NOTE

The Cable Structure window is specific to an extremity. Each struc-ture 
keeps its own parameters by default. Modifications made to the one are not 
automatically applied to the other. Thus, after the values relating to the origin 
have been modified, it is normal not to find these same values entered for 
the extremity.
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– Fiber Only the color code of the fiber is proposed (example: 
«Gold»)

– Ribbon/Fiber The color code of the fiber is preceded by that of the ribbon, 
and separated by a ’/’ (example: ’Bl/Or’)

– Tube/Fiber The color code of the fiber is preceded by that of the tube, 
and separated by a ’/’ (example: ’Br/Or’)

– Tube/Ribbon/Fiber
The color code of the fiber is preceded by that of the tube, 
then by that of the ribbon; the three being separated by a ’/’ 
(example: ’Br/Bl/Or’). See “Fiber Number / Fiber Code” on 
page 39. 

Max tube Shows the maximum number of tubes in the cable for the extremity 
selected. This information influences the automatic coding of the 
fiber. See “Fiber Number / Fiber Code” on page 39.

Max ribbon Shows the maximum number of ribbons in the cable for the extremity 
selected. This information influences the automatic coding of the 
fiber. See “Fiber Number / Fiber Code” on page 39.

Max fiber Shows the maximum number of fibers in the cable for the extremity 
selected. This information influences the automatic coding of the 
fiber. See “Fiber Number / Fiber Code” on page 39.

Tube Coding, Ribbon Coding, Fiber Coding

The lines Tube Coding, Ribbon Coding and Fiber Coding enable 
selection of the color coding of the tube, the ribbon and the fiber from 
5 different codes described below: TIA, USER 1, USER 2, USER 3 
and USER 4.

Code Definition
The Code Definition line opens a sub-menu, with which the different 
color codes possible on the instrument can be displayed and modi-
fied.

Five different codes can be managed by the equipment, including a standard code. 

The standard code (TIA) may be displayed but it cannot be modified.

NOTE

Certain parameters are not valid in the configuration selected. Thus, if no 
tube is selected in Cable Content, all the lines relating to the tube concept 
will be deactivated (grayed out in the menu).
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The other codes, called by default USER1, USER2, USER3 and USER4, can be entirely 
personalized.

– Edited code selects the code for display or modification.

– Code name to give a new name to the code selected, press the  key, 
which calls up the edit menu.

– View codes displays the color codes 1 to 12, 13 to 24 or 25 to 36.

– Code 1...23 Use the arrow  to modify the codes if necessary.

Project Information

Technician Id
Use the arrow  to enter the name of the operator carrying out the measurement.

Job Id
Use the arrow  to enter a description of the measurement to be performed.

Comment
In contrast to the other data in this menu, the comment is specific to a fiber. This line is 
thus used to enter a new comment and not to display it. The comment appears at the 
top of the screen, with the other parameters of the fiber.
This comment will remain available for the next acquisition, unless it is deleted. It is also 
saved when a trace is saved with a comment.

Configuring the File parameters
The File storage parameters must be also configured, in order to define how the results 
traces will be saved onto the equipment.

In the Setup page, press File softkey (if one parameter is selected in the current screen, 
press Top Menu soft key to display the right menu keys and click on File).
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Directory

Dir. Naming
Click on Current Directory menu key to select the directory currently selected inthe 
explorer for files saving

or

Use the arrow  to enter the directory name and path:

In the edition keypad, select the pre-defined parameters available or, press abc 
key to enter a name manually for the directory. Then, press Enter to validate.

Example: disk/OTDR/Test

or

Press Auto Naming to apply the name by default to the directory:

disk/[Cable_Id]

NOTE

The softkey Copy File/Link to All is displayed when one parameter is 
selected in the Link or File Setup page and when the Powermeter or Source 
function is active. 

It allows to apply the Link and File configuration parameters of the current 
applications to all the other active Fiber Optic applications (powermeter, and 
source). 

Figure 23 Directory - Edition keypad
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Press Clear and validate (Enter key) in order to define the [Current directory] 
selected as directory for saving measurements.

Dir
This parameter cannot be configured, and display the directory selected/created by 
default into which the file(s) will be saved.

Result storage

Filenaming
Select Filenaming parameter and press the right arrow key to modify the name of the 
file for the result trace.

In the edition keypad, select the pre-defined parameters available or, press abc 
key to enter a name manually for the file. Then, press Enter to validate.

or

Press Default Filename to apply the name by default to the file:

Fiber[Cable_Id][Fiber_Num]_[Lambda]_[Direction]

The name of the file is displayed in grey under Filenaming parameter

File Content
In this parameter, select the file content for traces saving:

One Trace in case of traces in overlay, each trace is saved in a distinct file (.sor 
extension).

Figure 24 Filenaming - Edition keypad (auto)
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All Traces in case of traces in overlay, all traces are saved in one single file 
(.msor extension).

One and All Traces
this option combines the two previous ones: in case of traces in 
overlay, each trace is saved in a distinct file and all traces are saved 
in one single file.

Auto Store
Select Yes to store automatically the trace or traces resulting from each acquisition 
according to the filenaming rules.

Select Confirm if alarm = Fail to display a confirmation dialog box if a value exceeds 
alarm thresholds, and to be able to choose to save or not the trace.
If no alarm is detected on trace, it is automatically stored.

Report Configuration

A report can be generated from the OTDR results page at the same time as the trace 
saving (see “Saving the trace(s) and generating a report” on page 87).

The report configuration is performed form the File Setup page

Report As
Select the report format to be generated:

txt file select Yes to save the results in a .sor file and to generate a txt 
file of the results.

pdf file select Yes to save the results in a .sor file and to generate a 
report in a pdf file.

json file select Yes to save the results in a .sor file and to generate a 
json file.

If all parameters are defined with No, only the .sor (or .msor) file will be saved.

Report Layout
This parameter allows to define the report page setting:

Standard in multi-traces display, one report page is generated for each trace.

Consolidated in multi-traces display, one report page is generated for all traces
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Report naming
If Consolidated is defined for Report Layout, select Report naming parameter and 
press the right arrow key to modify the name of the report file for the result trace.

In the edition keypad, enter a name manually for the file and press Enter to validate.

If no name is entered, the report name by defaut applies: Report_SM/MM-OTDR.

Include Microscope Image
In the report page, an image of the scope test result can be displayed on the upper part 
of the report. Select Yes to include the scope test result image into the report.

Configuration in Test Auto mode
The Test Auto key imposes the parameters for acquisition, measurement and display 
of results defined as default settings in factory.

NOTE

This parameter is available exclusively if the report format selected is a Pdf 
file.

ACQUISITION Acquisition Laser All

Acquisition Auto

Time Auto

Smart Acq No

OTDR Connector Test Yes & Cont

Launch Cable No

ALARMS Alarms Levels None

ANALYSIS Parameters Section Attenuation dB/km

Section Length Yes

Index of Refraction G652 G657

Scatter Coefficient Auto

Results on trace Graphics
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Saving OTDR configuration in a file
Once File and Measurement parameters have been configured, those parameters can 
be kept in memory and saved in a configuration file.

This configuration file can then be recalled in two cases:

• in order to be applied when acquisition in Smart Test mode is performed.

• in order to be recalled for future acquisition in Expert OTDR

To save parameters in a configuration file:

1 If necessary, press SETUP to return to Setup page.

2 Select one parameter in one of the setup page (acquisition, link..)

3 Press menu key .

An edition keypad displays

4 Enter a name for the configuration file (max. 20 characters).

Event Notes No

Measurement OTDR Connector Meas. No

Splice Auto

Reflectance All

Ghost No

Fiber End Auto

Bend Auto

Mux/Demux Auto

Event After Fiber End No

Total Loss Before evt

LINK Link Description Change Fiber Nr Increment

FILE File configuration Filenaming Auto filenaming

Fiber[Cable_Id][Fiber_Num]_[Lambda][Direction]

Auto Store Yes
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5 Press Enter to validate

A sound is emitted to indicate the file is saved.

The configuration file is saved with the extension .fo_cfg (icon ) and can be 
recalled at any time from the Explorer page.

It can be selected in Smart Test (see “Selecting the configuration file” on page 22) or 
loaded for Expert OTDR.

Loading an existing OTDR configuration
To load a configuration file previously created or available in the T-BERD/MTS/ Smar-
tOTDR and apply parameters to new OTDR Expert tests:

From the File Explorer page

1 Press FILE hard key

2 Select the configuration file desired

3 Press Load > Load Config.

• Press SETUP hard key to display the OTDR acquisition parameters saved in the 
selected configuration file.

You can modify some acquisition or file storage parameters, and save them in a new 
configuration file (see “Saving OTDR configuration in a file” on page 48).

NOTE

Configuration file is saved by default in the directory disk/config.

Figure 25 Save Configuration file - Edition keypad

Directory into 
which file will be 
saved
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From the Setup page

1 Select one header in either Setup page (Acquisition, Link, File...)

2 Press Load Config. menu key.

The file Explorer page displays

3 Select the configuration file desired

4 Press Load Config. to load the configuration file for acquisition in OTDR Expert 
mode.

A sound is emitted to confirm the loading.

The Setup screen is displayed again.

NOTE

Most of the configuration files are available into the equipment, in disk/
config.

Figure 26 Loading a configuration file

Configuration file will be 
used for Expert OTDR 
acquisition only

The main parameters available in the selected configuration file 
are displayed in the File signature.
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Chapter 5Launching a reflectometry test 

and displaying results

Once the configuration for acquisition and file storage has been defined, the instrument 
is ready to launch an OTDR measurement.

Pressing the START/STOP key is all that is needed to start or stop an OTDR measurement 
on the MTS/T-BERD or on the SmartOTDR.

This chapter describes the different stages in a reflectometry measurement. It then 
describes the functions available on trace(s).

The topics discussed in this chapter are as follows:

• "Performing OTDR acquisitions" page 52

• "Saving results for Smart Test acquisitions" page 60

• "Results display" page 62

• "Advanced functions in Expert OTDR mode" page 76

• "Saving the trace(s) and generating a report" page 87
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Performing OTDR acquisitions

Performing an acquisition in Real Time mode

Principle of the Real time mode
Acquisition in real time must not be used if a precise measurement is required because 
of the high noise level, but it is sufficient for rapid optimization of a connection and for 
observing a fiber in process of utilization.

Performing acquisition in Real Time
To carry out an acquisition in real time:

1 Hold the START/STOP key down for about three seconds, to launch the acquisition 
in real time, either in Smart Test or Expert OTDR mode, whatever is the acquisi-
tion mode selected.

or

If the Time parameter is defined with Real Time in Setup page in Expert OTDR 
mode, press START/STOP hard key.

or

In the Setup page of the Smart Test mode, press Real Time key  (see 
Figure 14 on page 23).

The red Testing indicator will go on to show that real time acquisition is in prog-
ress. The trace acquired is displayed in real time. 

An indicator of the state of the connection (Good/Bad) is displayed below the 
trace:
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If the state of the connection is bad, it is still possible to carry out a measurement, 
but the results will not be very reliable.

Traffic detection

Traffic on the fiber under test is automatically detected and reported.

Press the START/STOP key to begin the measurement. A message indicates there is 
traffic on the fiber and asks you if you wish to continue or not:

• If you click on NO, the measurement is not launched.

• If you click on YES, the measurement is performed, despite the traffic.

Table 3 Connection indicator

State Connection

Good The connection is OK

Bad • There are several connectors close to the external connector of the equip-
ment

• One of the connectors is dirty or badly connected. Replace the launch 
cable, make the connection again properly or clean the connector of the 
OTDR or of the jumper.

• No fiber is connected.

Figure 27 Example of acquisition in Real Time (with Expert OTDR)
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The functioning of Traffic Detection is then indicated in the scaled down representation 
of trace, on the upper left part of screen .

During an acquisition in real time, several actions can be made on results in progress: 
see "Actions on trace during acquisition" page 58.

Stopping the real time acquisition
To stop or interrupt an acquisition in real time mode, press the START/STOP key at any 
time.

Performing a measurement with Smart Test
The acquisition is carried out with the parameters saved in the Configuration file. It may 
be stopped at any time using the START/STOP key.

At the end of test, the results page displays.

1 From the Setup page, press Start Test key  to launch measurement 
(see Figure 14 on page 23).

The red Testing indicator goes on to show that the T-BERD/MTS is in process of 
acquisition and the screen displays the trace in process of acquisition.

2 The quality of the connection is displayed for a few 
seconds (see Table 3 on page 53)

3 Then, a bar graph shows elapsed and remaining acqui-
sition time. 

NOTE

If the measurement is validated despite the traffic (key Yes), the next mea-
surement will be automatically performed, even if traffic is still detected on 
fiber.

If the measurement is cancelled (key NO), and the START/STOP pushed 
another time, the box asking if you wish to continue or not is displayed.
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At the end of the acquisition, a beep is emitted, and the measurements are displayed, in 
SLM view, with a dialog box indicating the pass or fail verdict and asking if results must 
be saved.

Performing an acquisition with Expert OTDR
In this mode, the equipment carries out a number of averagings defined as a function of 
the maximum acquisition time specified in the Acquisition menu, and then terminates the 
acquisition. 

The acquisition is carried out with the parameters previously selected in the Acquisition 
menu. It may be stopped at any time using the START/STOP key.

1 Press the START/STOP key to start the acquisition.

The red indicator goes on to show that the product is in process of acquisition and 
the screen displays the trace in process of acquisition.

Figure 28 Acquisition in progress in Smart Test

Number of 
averages calculated

Elapsed 
acquisition time

Total acquisition timeElapsed time

NOTE

During acquisition, the traffic on fiber is automatically detected (see "Traffic 
detection" page 53)
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2 The quality of the connection is displayed for a few 
seconds (see Table 3 on page 53)

3 Then, a bar graph shows elapsed and remaining acquisition time. 

At the end of the acquisition, a beep is emitted, the trace is displayed and an automatic 
measurement is started.

Figure 29 Acquisition in progress with Expert OTDR

Number of averages 
calculated

Elapsed acquisition 
time

Total acquisition 
time

Elapsed 
time

NOTE

During acquisition, the traffic on fiber is automatically detected (see "Traffic 
detection" page 53)

NOTE

To stop the acquisition, the START/STOP key may be pressed at any time. 
Then an automatic measurement is carried out, but some events cannot be 
detected (a manual measurement must then be made).
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Performing an acquisition from Results page
Once the results page is displayed, you can perform a new acquisition modifying the 
main acquisition parameters.

1 On Results page, in Expert OTDR mode, press the softkey Quick Setup.

The acquisition parameters that can be modified display under the results trace.

2 Modify the acquisition parameters wished in the displayed menu:

Laser / Acquisition / Range / Pulse / Time: See page 26 and page 27.

3 Once configured, launch the new OTDR test pressing the START/STOP hard key.

Press again Quick Setup menu key to hide the menu under the trace.

Multi-wavelength acquisition 
If the module possesses several lasers, to perform successive acquisitions on all the 
wavelengths:

1 In the SETUP menu, check in Laser line, that several lasers are selected (or select 
All if a module with only one OTDR port is used).

2 Start the acquisition by pressing the START/STOP button.

Before launching a new OTDR acquisition, make sure the trace(s) dis-
played have been previously saved if necessary, as the new acquisi-
tion will automatically delete the displayed results.

Figure 30 Results page and Quick Setup menu (Expert OTDR)
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3 Once the acquisition for the first wavelength is finished, the acquisition for the 
following wavelength starts automatically.

or 

To stop manually the acquisition for current wavelength, click on Stop Wave-
length. This will allow to automatically start the measurement for the following 
wavelength.

The different traces appear in the same window and can be handled similarly to overlaid 
traces (see "Overlay trace function" page 83).

Actions on trace during acquisition
During an acquisition, several actions are available on results in progress.

Positioning Cursors A and B
1 Select Cursor A or Cursor B and:

– Set both cursors A & B to control distance between two points.

– Set one cursor A or B to get the distance from one point.

– Set one cursor A or B to zoom on this cursor

Zooming on trace
1 Select Zoom function:

– use the menu key  in Smart Test; 

– the key  in Expert OTDR

2 Use touchscreen or validation key to zoom in and zoom out on trace (see “Zoom 
function” on page 72)

Shifting the trace (Expert OTDR and Real Time only)

In Expert OTDR mode or in Real Time, the trace can be shifted vertically or horizontally 
during the acquisition:

1 Select Shift function on menu key 

2 Use touchscreen or direction keys to shift horizontally or vertically the trace (see 
“Shift function (Expert OTDR only)” on page 74)

Displaying Trace or Smart Link page

1 Use the menu key Trace/Smart Link to display either:
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• the acquisition trace in progress and the bar graph of time

• the Smart Link page with exclusively the bar graph of time.

In the case of measurement on several wavelengths, once a measurement is completed 
for one wavelength:

• the Trace function allows to display the trace and results table for this wave-
length: once Trace is selected, press validation key (  or ENTER) to pass from 
Trace + results table on 1 line to Trace + results table on 4 lines, and vice-versa,

• the Smart Link function allows to display a graphical view of results for this wave-
length.

Modifying acquisition parameters (in Real Time mode only)

You can modify the acquisition parameters without returning to the SETUP menu. 

1 Press the Acquisition Param key.

2 Use displayed keys to scroll through the possible values of the parameters.

Zooming on the fiber end (in Real Time mode only)

During a real time acquisition, you can reach the end of the fiber under test at any time:

1 Press Zoom to End menu key.

The display automatically reaches the end of the fiber under test.

The menu key Zoom to End becomes Zoom to Start.

Press Zoom to Start to display the start of the fiber under test.

Figure 31 Example of acquisition in Real Time
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Performing measurements during acquisition (Real Time 
mode only)

The real time mode allows to make Loss, ORL or Reflectance measurement using the 
A & B cursors and the key Loss / ORL / Reflect.:

1 Position A & B cursors on the trace

2 Click as many times as necessary on key  to get the measurement 
between A & B cursors.

Saving results for Smart Test acquisitions
Once the acquisition is completed, the results trace displays, in Smart Link view, with the 
Save menu keys displayed. 

1 Click on Save menu key  to save the results in a file.

The Recording Information page displays

Figure 32 Example of loss measurement
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2 Click on one parameter configuration (white background) to modify it using the 
edition or numeric keypad displayed:

– Fiber Id: click on the fiber name currently defined to display the edition 
keypad and enter a new fiber name.

– Fiber Number; click on the fiber number currently defined to display the 
numeric keypad and enter a new fiber number.

– Location A / Location B: click on the location name currently defined to 
display the edition keypad and enter a new name.

– Job Id: click on the Job description currently defined to display the edition 
keypad and enter a new description.

3 Once the recording information are defined as wished, select the saving mode 
wished:

– Click on FILE ONLY  to save exclusively the results trace to the 
.sor format

– Click on FILE + PDF  to save the results trace in a .sor file and to 

generate a pdf report of the results.

– Click on Results  to return to Smart Test result view.

Figure 33 Save results in Smart Test mode

NOTE

The file is saved automatically by default with the Job Id parameter.

Example: if the Job Id is defined with Test Fiber 1, the otdr filename will be 
Test Fiber 1.sor.
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Results display
The traces acquired or recalled from a memory are displayed on the Results page. 
According to the mode of acquisition (Expert OTDR or Smart Test), the results page 
offers similar functions, but also different functions.

The Smart Test mode displays automatically the Smart Link view after an acquisition. 

Smart Link view
Once the results trace is displayed, click on Trace / Smart Link menu key to select the 
Smart Link view.

A screen as the following one is displayed:

The screen is divided into three zones:

NOTE

The Smart Link view is displayed by default after an acquisition in Smart 
Test.

Figure 34 SmartLink function

Zone 1

Zone 2

Zone 3
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• Zone 1: Graphical representation of the link, with icons symbolizing the different 
events detected.

• Zone 2: Link Table, which gives a summary of results for each wavelength, with 
results within/without thresholds in green/red (according to Alarm thresholds 
defined in the setup screen).

• Zone 3: Alarms table (if any)

Show the detailed information of one event
The information concerning the event, its type and the alarm thresholds defined for this 
event, can be displayed from the SmartLink screen.

1 Select the event for which information must be displayed, on the graphic using 
the touchscreen or direction keys.

The event is highlighted in yellow once selected.

2 Click on the Event Diagnosis menu key.

A small window displays. It describes: 

– the event type 

– the value above which it is on defect

Event View
1 Click on Event View menu key to display a detailed description of one event 

detected on trace.

2 Select the event to be described on graphic (highlighted in yellow).

Figure 35 Event Diagnosis

MTS2100 4100 Module US rev015.book  Page 63  Jeudi, 14. janvier 2021  3:41 15



Chapter 5 Launching a reflectometry test and displaying results
Results display

64 User Manual 77000010208 Rev. 015

The corresponding event description is displayed on the Zone 3, with a recall of 
alarm threshold for this event:

3 Click on View Trace to display the selected event in the results table and zoomed 
on trace.

Changing the type of an event

Once the Event View is displayed, the type of event can be modified:

1 Select the event to be modified (framed in yellow)

2 Press Event Code menu key

3 Click on the event type to be applied to the selected event:

Figure 36 SmartLink: Event View

NOTE

The event is framed in red if it is above the alarm thresholds defined in the 
setup menu.
It is framed in green if it lies within the thresholds.
It is framed in grey if no alarm has been defined in the Setup menu

MTS2100 4100 Module US rev015.book  Page 64  Jeudi, 14. janvier 2021  3:41 15



Chapter 5 Launching a reflectometry test and displaying results
Results display

User Manual 77000010208 Rev. 015 65

4 Click on Exit to return to Event View.

5 Click back on Event View menu key to return to Summary screen

or

Click on Trace View menu key to return to trace (and table) results screen.

Splitter sub-menus
The Splitter icon is different according to the menu key pressed in the Splitter sub-
menus.

Example:

If the menu key  is pressed, the icon  is displayed

If the menu key  is pressed, the icon  is displayed.

Moreover, the icon and splitter configuration is different according to the number of 
«clicks» on one menu key.

Example with the menu key :

• Click once: the icon is 

Figure 37 Event Code

NOTE

The event modification is automatically applied on trace and in the results 
table.
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• Click twice: the icon is 

• Click three times: the icon is 

• Click four times: the icon is 

Click a sixth time to reset the event by default.

Trace View
To display the trace and results table, click on Trace / Smart Link menu key to select 
Trace.

Click on Assistant softkey to return to Setup Information page.

Figure 38 Example of results trace with Smart Test
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• On the upper right side, the alarm icon is displayed (if some alarm thresholds are 
defined in the pre loaded configuration file).

Common functions on Trace View

Display of events on the trace

Each event detected is referenced under the trace by a serial number. The reflectometry 
trace is displayed with a dotted vertical line set on the start of launch cable  (if the 
Launch Cable End parameter is defined in the SETUP menu)

The trace can also be displayed with a dotted vertical line on the end of fiber .

The icon  is displayed on trace if the Receive Cable Start parameter has been 
defined in the Setup menu.

The results of the measurements of attenuation, reflectance and slope can be marked 
on the trace.

The reflectance of a ghost event is displayed in brackets on the trace.

Figure 39 Example of results trace with Expert OTDR

Table 4 Alarms display

Fail Indicates that at least one result exceeds the alarm thresholds defined in 
the configuration file used for acquisition
Results are displayed in red in table.

Valid Indicates that all the results lie within the thresholds (no result in red/yellow)
Results are displayed in green in the table.
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Criteria for display of an event
An event will be displayed if its attenuation or its reflectance exceeds the corresponding 
threshold selected in the SETUP menu (see "Configuring the test in Expert OTDR" page 
25). Attenuation and reflectance results for an event will be displayed if they can be 
calculated

The reflectance of an event is always measured except when the event causes a satu-
rated Fresnel peak or if it is drowned out by noise. In this case, the T-BERD/MTS 
displays > to show that the actual reflectance exceeds the value displayed. 

Results table

Under the trace is displayed the results table with all the events detected during acqui-
sition.

In ExpertOTDR only, once Trace is selected, press validation key (  or ENTER) to pass 
from Trace + results table on 1 line to Trace + results table on 4 lines, and vice-versa 

The table with one line displayed under the trace gives the type and characteristics of 
the event nearest to the cursor.

The 4 lines table gives the type and the characteristics of all the events detected during 
the measurement: the 4 first lines displayed correspond to the 4 first events nearest to 
the cursor. The line corresponding to the event nearest to the cursor is highlighted. This 
highlighting moves if the cursor is moved.

Figure 40 Example of trace and 4 lines table (Expert OTDR)
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At the top of the table, a line shows the generic parameters of the fiber: numbers of 
events present, total ORL of the link and, in ExpertOTDR mode, reference trace icon (if 
trace is the reference trace - see “Reference Trace function” on page 86).

Each event is referenced under the trace by a number which is repeated in the first 
column of the table. The table then shows:

• icon symbolizing the type of the event: 

Receive cable Start

Launch cable End: the attenuation and distances are measured on the basis of 
the corresponding marker.

Non-reflective attenuation (e.g. splice).

Splitter.

Mux/Demux

Reflective event. (e.g. connector)

Ghost reflection

Slope of the fiber (when no fault follows the slope).

End of fiber

OTDR connector

Merged Connectors Loss 

– Total group loss = loss on last connector

– Loss connector N-1 = 0 dB)

Bend on connector

Event marker when a measurement cannot be carried out. If the event to be added 
is too close to an existing event, the icon appears on the trace and the table, but no 
measurement is carried out: to obtain the results for this event, a manual measure-
ment is necessary.

The event underlined in yellow is the one the nearest of the cursor set on trace. To visu-
alize an event, click on this event on the table to set the cursor on it onto the trace.

Detailed description of an event
Click on one event icon in the results table to display the event type and the alarm 
threshold defined for this event (if Alarms have been defined in the Setup page).
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If the value of the event selected exceeds the defined threshold, then the possible 
causes for this alarm are described in the window:

The following columns are then displayed next to each event icon:

Cursors

The cursors A and B are represented by vertical lines of different colors:

• in a solid line if the cursor is selected.

• in a dotted line if the cursor is not selected.

Positioning the cursor
1 Press the key  to active the cursor.

Figure 41 Event description

C
lic

k

Distance
The distance of the event from the beginning of the fiber, in 
meters (or miles)

Loss The attenuation due to the event, in dB

Reflect. The reflectance of the event, in dB

Slope
(Expert OTDR only)

The slope before the event, in dB/km (or dB/kft) if it can be 
measured

Section
(Expert OTDR only)

The length of the section = the distance between the marker 
of the event and the previous marker.

T. Loss The total attenuation of the fiber (total loss), in dB
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2 Touch the screen on the required location on trace where the active cursor must 
be set.

You can also use the direction keys  and  to move the selected cursor along 
the trace

Above the trace is shown the 2-points loss measurement between the two cursors, 
together with the distance between the two cursors.

When the cursor function is selected, the keys  and  move the trace vertically.

Cursors information
The information related to cursors are displayed exclusively when the Cursor function is 
selected (menu key  selected).

Above the trace are shown the co-ordinates of the points of intersection of the cursors 
A and B with the trace, together with the distance between the two points.

 

The cursors data are displayed exclusively if the Cursor menu key is 
active. If another key is active, the display shows help tooltips, differ-
ent according to the selected function.

Figure 42 Cursors information

The Cursor function is 
not selected

The Cursor function is 
selected

NOTE

The cursors information are displayed in the report when the Cursor function 
is selected (active key). If the cursors values must not be displayed in the 
report, select another softkey than the Cursor one before performing the 
report (softkey Trace or Zoom for example).
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Cursor and Zoom
If the Cursor key is selected, press the validation button (  or ENTER) to perform an 
automatic zoom until the fiber end or until the end of the range (Range parameter 
defined in the configuration screen).

This will modify the cursors position, which will be positioned automatically at the begin-
ning and at the end of the link (taking into account the possible launch cables). 

If another key than the key Cursor A / Cursor B is activated when the validation key is 
pressed (Trace or Zoom), the cursors’ position is unchanged.

Cursor function not selected
When Cursor menu key is not selected, the upper banner displays information, different 
according to the menu key selected:

• If the Trace/Smart Link key is selected, with Trace function valid, the upper 
banner indicates that to change the displayed trace, you can click on the banner 
or on the right arrow key

• If the Zoom/Shift key is selected, and the Zoom function valid, the upper banner 
indicates that to get an automatic or full zoom, you must press validation key (  
or ENTER).

Zoom function

The Zoom function is used to analyze part of the trace in greater detail. 

The zoom is centered on the active cursor.

The position of the section of trace displayed with respect to the complete trace is repre-
sented by a red rectangle on the mini-trace at the top left-hand corner of the screen. 

Defining a zoom on the trace using the touchscreen or screen 
deported on PC
1 Press Zoom or Zoom/Shift softkey to activate the zoom function

– menu key  in Smart Test 

– menu key  in Expert OTDR

2 Press once in one location on the screen, which will represent the upper left 
corner of the zoomed area.

The icon  is displayed on the screen.
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3 Press another time on the location which will represent the lower right corner of 
the zoom.

Defining a zoom level on the trace using direction keys
4 Select Cursor A or B and center it on the zone to be examined

5 Press Zoom softkey.

6 Use the or key to increase or reduce the zoom factor, keeping the selected 
cursor centered on screen.

Swapping from an automatic zoom to full trace and vice-versa
The automatic zoom allows to get an optimized display of the trace.

To apply an automatic or entire zoom on the trace:

1 Press Zoom softkey.

2 Press validation key (  or ENTER) to apply an auto zoom on trace.

Press again validation key (  or ENTER) to display the trace in full screen.

Specific functions of the zoom with a touchscreen
With the touchscreen, once the Zoom function is selected on menu key Zoom, you can:

• maintain your finger pressed on screen and shift the traces horizontally or verti-
cally

• position your finger on a cursor and move it on trace maintaining your finger 
pressed and moving it toward left or right

• once a zoom is performed, double click on the zoomed zone to undo the zoom

Zooming on the different events in succession
1 Set the cursor on one event

Figure 43 Zoom on trace using touchscreen

First press

Second press

Zoomed area
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2 Define a zoom on this event.

3 Click on another event in the results table.

The cursor is automatically positioned on this event, which is always centered on 
the screen, keeping the zoom level selected.

Shift function (Expert OTDR only)

The Shift function is used to displace the displayed section of the trace by pressing the 
direction keys or directly clicking on the touchscreen. 

The horizontal shift is performed maintaining the point of intersection between the trace 
and the selected cursor at the same level, scrolling the trace horizontally while following 
it vertically, so that it never goes off the screen.

To use this function:

1 Select the zoom factor as described above.

2 Choose cursor A and cursor B position.

3 On the Zoom/Shift key, select Shift.

4 Displace trace manually on touchscreen toward left/right or upward/backward.

or

Use the direction keys to shift the trace in the desired direction.

Display of traces in overlay

• The traces are shown in different colors (the active trace is green).

• The mains acquisition parameters are displayed at the top of the screen.

MTS2100 4100 Module US rev015.book  Page 74  Jeudi, 14. janvier 2021  3:41 15



Chapter 5 Launching a reflectometry test and displaying results
Results display

User Manual 77000010208 Rev. 015 75

Selecting one trace from overlaid traces
To make actions on a trace in overlay (move on events, set a cursor...), it must first be 
swapped with the active trace. To do this:

1 Press the Trace key

2 Press the direction keys  and , as many times as necessary, 
until the active trace is displayed in green. 
or
Click on the trace numbers in the upper right side of the result page 
until the trace desired is selected.
or
Click on the upper part, in Trace information zone to scroll the traces

Traces display in double acquisition mode

When a double acquisition has been performed, i.e. a short acquisition preceding a stan-
dard one (see “Acquisition Mode” on page 26), two traces are displayed in the same 
window.

Figure 44 Traces in overlay

NOTE

Actions relative to traces (move cursors, move on events...) are exclusively 
done on the active trace (in green), not on the other ones.

traces 
numbers
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The short trace is the one resulting from the short acquisition and stops while the stan-
dard one continues until the end of measurement.

Advanced functions in Expert OTDR mode
Several actions on trace displayed can be performed in ExpertOTDR mode only.

Automatic measurement and detection
If the instrument does not detect all the expected events, additional manual measure-
ments can be carried out.

To delete all the markers:

1 Press the Advanced key

2 Press the Modify meas.key, 

3 Select Delete.
4 Press validation key (  or ENTER)

The following procedure is then recommended:

1 By default, the instrument locates the events and proceeds to the measurements.

Figure 45 Traces display in double acquisition mode

Short acquisition (in 
green)

Standard acquisition 
(in blue)
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2 Addition of events (see “Addition of events” on page 77) in the cases of splices 
showing low attenuation and of close events. The T-BERD/MTS then automati-
cally measures the slope before and after the markers selected and measures 
the attenuation of the splice.

3 Addition of manual measurements if necessary (for deeper analysis). The T-
BERD/MTS performs the measurements requested by the user.

To start an automatic measurement while a measurement is already in progress:

1 Press the Advanced key.

2 Press the Modify meas.key

3 Select Delete and press validation key (  or ENTER).

4 Select Auto Meas. and press validation key (  or ENTER).

Addition of events
You can also manually place markers in addition to those positioned automatically 
during automatic measurement.

Representation of the events
The events are represented by the symbol : if they are set during a measurement.

The events are represented by the symbol  if they are set manually in Advanced 
mode.

To add markers of events:

1 Select a cursor (A or B).

2 Use the direction keys or touchscreen to move the cursor to the place where you 
want to position a marker.

3 Press the keys: Advanced > Set Event.

4 An event marker  is displayed at the position of the cursor and a measurement 
is carried out on the event. 

Measurement of slope before the marker starts just after the previous event (or at 
the end of the dead zone at the beginning of the fiber); measurement of slope 
after the marker stops just before the next marker or at the end of the fiber.
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Hints on the positioning of markers
• Do not add markers (with the Set Event key) after a manual measurement, as all 

the results will be recalculated automatically by the instrument.

• If two markers are too close together, they will appear on the trace and the table 
but no measurement will be carried out on the second marker: to obtain results 
for this marker, a manual measurement is necessary.

• If you press the Set Event key when the cursor is very close to a marker, the 
latter will be deleted.

Deleting events
To delete an event, move the cursor onto the event and press the Set Event key. The 
event selected will be deleted and a complete measurement, without this event, is 
carried out.

Deletion of events can cause incorrect measurement results.

Manual measurements
As soon as you have made an acquisition, with or without automatic measurement, you 
can make manual measurements on any event on the trace by means of the cursors A 
and B, in association with the functions of slope, detection of splice and calculation of 
ORL.

1 The manual measurements are accessible in the Results page, after pressing 
the keys: Advanced, Modify meas, then Manual Measurement.

Measurements of slope
To make a manual measurement of slope, press the RESULTS button to call up the trace 
and then:

1 Place the cursor A at the beginning of the section of the trace where the slope is 
to be measured.

2 Place the cursor B at the end of this section.

3 Press the Advanced key

4 Press the Modify Meas. key

5 Press the Manual key, then select Slope. 
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6 Press validation key (  or ENTER) : the slope of the specified trace section is 
displayed.

Result of slope measurement
The result is displayed on the screen between the two slope indicators [ and ]. 

The measurement results are also available in the table:

1 Press Exit to return to the initial results page.

2 Select Trace using Trace/Smart Link soft key

3 Press validation key (  or ENTER)  to display results table under the trace.

"Distance" shows the distance between the beginning of the trace and the end of the 
slope; 

If no result is displayed in the table, this means that the distance between the cursors A 
and B is too small.

Deleting a slope measurement
To delete a particular slope measurement result:

1 Superimpose the cursors A and B on the slope concerned

2 Select Slope (after, if necessary, pressing Advanced > Modify Meas.> Manual 
Meas.).

Figure 46 Manual Measurement results

Slope
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3 Press validation key (  or ENTER) : the slope of the specified trace section is 
deleted.

Measurement of ORL
It is possible to carry out an ORL measurement on a part of the fiber.

Follow the following procedure to measure a part of the fiber:

1 Position the cursors A and B to delimit the section that you wish to measure.

2 Press the Advanced > Modify Meas.> Manual Meas., then select ORL.

3 Press validation key (  or ENTER) .

The ORL is measured for the section of trace defined. 

ORL on a saturated trace
If saturation occurs during an ORL measurement, the result is given with the sign <. This 
means that the actual ORL value is less than the value displayed.

Measurement of Reflectance
It is possible to carry out a reflectance measurement of a Fresnel for a reflective event.

Follow the following procedure to measure the reflectance:

1 Position the cursor A at the base of the peak 

Figure 47 Result of ORL measurement
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2 Position the cursor B at the top of the peak of the required Fresnel, or after the 
peak to calculate automatically the maximum reflectance.

3 Press the Advanced > Modify Meas.> Manual Meas., then select Reflec..

4 Press validation key (  or ENTER) .

The Reflectance value is defined in dB, and displayed in the trace in purple.

Splice measurements
There are two methods of carrying out manual measurements of splices on the trace: 
the two-cursor method and the five-cursor method.

The five-cursor method is the more accurate, as it takes into account the difference of 
level between the slope before the splice and the slope after the splice. This method 
should be used whenever possible.

If very close events have created a dead zone preventing the measurement of slope by 
the five-cursor method, it is possible to use the two-cursor method. This considers the 
difference in level between the cursors.

Before performing one of these measurements, define in the Setup menu the splice 
detection threshold.

Two points method

To perform a splice measurement by the "two-points" method, display the Results page, 
then:

Figure 48 Reflectance measurement
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1 Place cursor A exactly on the fault, then place cursor B after the splice that you 
wish to define.

2 Press the Advanced key, then Modify Meas.> Manual Meas., then select the 
function 2 Pt Loss.

3 Press validation key (  or ENTER).

The splice marker is placed at the point defined by the first (left-hand) cursor and 
the result is displayed on the screen. If the fault is reflective, the reflectance value 
is also measured and displayed. These results are added to the table of results.

Five points method

To carry out a splice measurement by the "five points" method:

1 Measure the slope preceding the fault to be measured, then the slope following it.

2 Place the cursor on the fault (between the two sections).

3 Press the Advanced key, then Modify Meas.> Manual Meas., then select 5 Pt 
Loss.

4 Press validation key (  or ENTER).

The splice event marker is placed on the cursor and the result is displayed on the 
trace and in the table of results.

NOTE

If you try to measure a splice on a slope, the measurement is not carried out 
and the following error message is displayed: "Slope found between 
two cursors".

NOTE

If no result is displayed, it is possible that the display threshold of the attenu-
ation measurement result is higher than the attenuation that you are trying to 
measure.

NOTE

If you try to measure a splice on a slope, the measurement is not carried out 
and the following error message is displayed: Slope found between two 
cursors.
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Memorization of the position of events
To memorize the position of events with a view to repeating the measurements at the 
same place during a future acquisition or on another trace, press the Advanced key, 
then select Lock Evts. The event memorization icon  will appear in the title bar. 

The positions memorized will then be used in the subsequent measurements, either at 
the end of the manual acquisition, or when a stored trace is recalled.

The following procedure is recommended to start a measurement with markers:

1 Carry out an automatic measurement.

2 Memorize the position of the events selecting Lock with the key in the 
Advanced menu .

3 Add the manual measurements required (keys: Advanced > Manual Meas.).

CAUTION

If an event is added (with the Set Events key) after manual measurements have been 
performed, then all the events on the trace will be converted into AUTO markers and an 
automatic measurement will be performed using these events. The previous manual 
measurements will be lost.

Provided the event memorization icon  is displayed, the automatic measurement 
following the acquisition is carried out using the events which were present before the 
acquisition.

If you wish to make a measurement without events, deactivate memorization of events 
by pressing the Free Events key.

Overlay trace function 
This very useful function enables up to eight traces to be displayed on the screen at 
once:

• either to compare traces acquired on a number of different fibers in the same 
cable, 

• or to observe changes over time in traces taken of one and the same fiber.

NOTE

This function memorizes the markers placed on the current trace.
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Overlaying several traces stored in memory
To display up to 8 traces from the memory, deleting the current trace(s) already loaded:

1 Press the FILE button. 

2 Select the files of the traces for display.

3 Press the Load key.

4 Press View trace(s).

5 When loading is complete, the Results screen appears: the first trace selected is 
the active trace (in green), the other traces being overlaid.

Display of traces in overlay
• The traces are shown in different colors (the active trace is green).

• Their serial numbers are repeated at the top of the screen.

• The OTDR markers are referenced on the active trace by the symbol , and on 
the other traces by vertical dashes.

Adding traces in overlay
With one or more traces already displayed, to add further traces to the display (the 
number of traces displayed cannot exceed 8):

Figure 49 Example of overlaid traces
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1 Define at least one trace as reference (see “Reference Trace function” on 
page 86)

2 Press the FILE button, and in the Explorer , select the files of the traces to be 
added.

3 Press Load key.

4 Press the View Trace(s) or Load Trace + Config.

When loading is complete, the new traces are displayed in overlay with those that 
were defined as reference traces (see.“Reference Trace function” on page 86)

Swapping overlay traces
Measurements can only be made on the active trace and not on overlaid traces. To make 
measurements on a trace in overlay, it must first be swapped with the active trace. 

1 Press the Trace key, 

2 Press the  and  direction keys, as many times as necessary, until the active 
trace is displayed in green.

or

Click on the trace numbers in the upper right side of the result page 
until the trace desired is selected.

Removing a trace

Removing the current trace in overlay

It is possible to remove a trace displayed. To do this, first select it (see previous para-
graph), then successively press Advanced > Overlay > Remove Current Trace.

Removing all the traces in overlay

To remove all the traces except the current trace, then successively press Advanced > 
Overlay > Remove Other Traces.

NOTE

If the number of files selected exceeds the display capacity, a message gives 
warning that loading will be incomplete: only the trace or traces selected first 
will be displayed, up to the permitted limit of 8 traces.

traces 
numbers
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Quitting the overlay menu
To quit the overlay menu, press the Exit key. 

Reference Trace function
The reference trace function consists in defining trace(s) which will be «blocked» on 
screen and used as models before acquiring or loading other standard trace(s).

Use of the reference trace function in the Result 
page
Once one or several trace(s) is/are displayed, after an acquisition or loaded from the 
explorer:

1 If several traces are in overlay, check the correct current trace is selected

2 Go in the Advanced menu

3 Click on Overlay

4 Click on Set curve As Reference key.

The active trace becomes the reference trace; 

• the icon  appears on the upper right hand part of the results table.

To define all the traces displayed as reference traces, click on Set All As Reference key 
(whatever is the active trace).

Removing the reference trace(s)

To change one reference trace into a «standard» trace, select it using the Trace/Event 
key, and in the Advanced > Overlay menu, click once again on Reset Reference.

To change all the reference traces displayed into «standard» traces, whatever is the 
active trace, go in the Advanced > Overlay menu and click on Set All As Reference.

Performing an acquisition once one or several trace(s) is/are 
defined

Three situations can occur once an acquisition is performed:

• Only reference trace(s) is/are displayed: the trace acquired is added to the refer-
ence ones.
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• Reference trace(s) and «standard» trace(s) are displayed: the reference trace(s) 
are «blocked», the standard ones are removed and the new trace acquired is 
displayed with the reference one(s).

• No reference trace(s) defined: all the «standard» traces are removed and only the 
new trace acquired is displayed.

Using the reference trace function in the explorer
A trace stored in memory can be set as reference trace before loading one or several 
«standard» trace(s).

To open one or several reference trace(s)

1 Go on the File Explorer

2 Select the trace(s) to be defined as reference

3 Click on Load and select Reference = Yes on the key 

4 Click on View Trace(s) or Load Trace + Config.

The icon  appears on the upper right part of the results table.

To open «standard» traces to be added to the reference 
ones

1 Go back to the Explorer

2 Select the trace(s) to be opened in the same screen as the reference traces

3 Click on Load and select Reference = No on the key 

4 Click on View Trace(s) or Load Trace + Config.

Saving the trace(s) and generating a report
Once the results page is displayed, the trace(s) can be saved and a report can be gener-
ated directly from the results screen, in Expert Mode only.

The traces saving and report generation can have already been performed automatically 
if the parameter Auto Store was defined on Yes in the Setup screen (see “Auto Store” 
on page 46) with the appropriate Save Mode (file only or file + txt or + pdf).
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Saving results and creating a report from results page
To save the trace and generate a report:

1 Press Fast Report key  -> .

A menu displays under the trace.

2 In the menu, configure the file saving mode (and the report)

a Modify the Fiber Number/Fiber Code using the key .

In the Save Mode parameter, select:txt fileselect Yes to save the results in 
a .sor file and to generate a txt file of the results.

pdf file select Yes to save the results in a .sor file and to generate a 
report in a pdf file.

json file select Yes to save the results in a .sor file and to generate a 
json file.

If all parameters are defined with No, only the .sor (or .msor) file will be saved.

b In the Cable Id parameter, enter/modify the name of the Cable using the 
edition keypad.

c In the Direction parameter, select/modify the direction, to define if the 
measurement has been performed from Origin to Extremity (A -> B) or from 
Extremity to Origin (B -> A)

d In the Location A and Location B parameters, enter/modify the name of 
Origin and Extremity.

3 Once saving is configured as wished, press Save All menu key 

Figure 50 Fast report configuration
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4 Enter a name for the file in the edition keypad.

or

Click on Auto Filenaming menu key to apply the file name defined in the Setup 
screen, in Filenaming parameter (see “Filenaming” on page 45)

5 Press Enter to validate

The icon  displays during saving process.

Once saving is completed, a sound is emitted onto the Platform.

Saving and report for traces in overlay

If several traces are displayed in overlay in the results page, one or several file(s)/
report(s) is/are generated:

• If in the File Setup page (SETUP > File), the parameter File Content is defined 
with One Trace, one .sor file and one pdf/txt report will be generated for each 
trace 

Example: if 3 traces are displayed in overlay, 3 .sor files and 3 pdf/txt files will be 
saved.

• If in the File Setup page (SETUP > File), the parameter File Content is defined 
with All Traces, one single .msor file and one single txt/pdf report will be gener-
ated, bringing together all traces.

Example: if 3 traces are displayed in overlay, one single .msor file and one single 
txt/pdf file (with one trace per page; except if the results table is too long for one 
page) will be saved.

Opening a report
1 To open the report, press FILE hardkey

2 In the Explorer page, in the directory selected, select the file/report.

The file name is: 

NOTE

The sor file and the txt or pdf file will have the same name.

NOTE

The file and the report are saved in the last storage media and directory 
selected.
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For the txt file: trace file_sor.txt

For the pdf file: trace file.sor.pdf

3 Press Load.

The file opens on the equipment.

Figure 51 PDF report

CAUTION

To modify the VIAVI logo, set by default on the header of the pdf report, save 
your logo in a jpg file called logo.jpg and place it to the root of the disk: 
disk > logo.jpg.

NOTE

A PDF Report can also be generated from the File Explorer page onto the T-
BERD/MTS 2000/4000 V2 (see “Generating pdf report(s)” on page 244).
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Chapter 6Power meter and Source options 

of the OTDR Modules

A variety of options are available when ordering an OTDR Module.

With the T-BERD/MTS 2000 and T-BERD/MTS 4000 V2:

• E41OTDRPM is the power meter option for the OTDR Modules

• E41OTDRLS is the Light Source option for the OTDR Modules.

With the SmartOTDR:

• E10PM is the built-in powermeter option

The topics discussed in this chapter are as follows:

• “Connection to the power meter” on page 92

• “Configuring the Power meter” on page 92

• “Activating the Source function” on page 95

• “Result page” on page 95

• “Performing the power level measurement” on page 99

• “Performing the insertion loss measurement” on page 100

• “Storing and reloading results” on page 104

• “Terminated PON Powermeter (SmartOTDR only)” on page 105
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Connection to the power meter

The type of optical connector used for the power meter is the same as the OTDR port.

With 2 OTDR ports, select the port of connection according to the wavelength available 
at each port (a label gives information at the back of the OTDR module).

Configuring the Power meter
For T-BERD/MTS 2000/4000 V2, the power meter function is an option chosen at the 
time of order and incorporated into the OTDR module in the factory.

To activate the function:

1 Press the HOME button

Figure 52 Optical connector for the Powermeter or Source on the OTDR Module (T-
BERD/MTS 2000/4000 V2)

Connector

It is not possible to use simultaneously the Source function and the 
Power meter function, when both options are set onto the OTDR mod-
ule, as they use the same connector.
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2 Select the power meter icon in the section of the OTDR Module

The icon turns yellow .

The effect of this action will to be to bring the power meter into use.

The measurement parameters can be accessed with the SETUP key.

Configuring the alarm parameters
• Alarm Activation of the Alarm function: any result below the lower 

threshold or above the upper threshold will be displayed in red 
on the Results page.

• Min and max thresholds
Choice of lower and upper thresholds for each available 
wavelength, from -60 to +40 dBm.

The Powermeter icons of the singlemode port and the one of the Multimode 
port cannot be selected at the same time. When one is selected, it automat-
ically deselects the other one.

Figure 53 Configuration of power measurement

See “Configuring the 
Link parameters” on 
page 38

See “Configuring the File 
parameters” on page 43
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Configuring the Measurement parameters
In the Setup page, press Measur’t soft key (if one parameter is selected in the current 
screen, press Top Menu soft key to display the right menu keys and click on Measur’t) 

• Wavelength Select wavelength:
Auto: the wavelength of the input signal will be automatically 
detected and selected to perform the measurement:
1310, 1490, 1550, 1625 or 1650 nm: measurement performed 
at specified wavelength.

• Beep on modulation
Select if a sound must be heard when a modulation occurs 
(Yes / No)

• Unit Unit of power displayed:
Watt, dBm for displaying absolute power
dB for displaying a result relative to a reference (link loss)

• Reference level If dB units were chosen in the previous line, selection of the 
reference value for the wavelength selected. Using the 
direction keys, first choose the wavelength, then press the > 
key to access choice of the value (+XXX.XX), then confirm this 
value with the ENTER key.This reference is also automatically 
available, in the Results page, using the Set as Reference 
key.

NOTE

To copy one value of the Lower or/and Upper threshold for all wavelengths, 
select the reference value and click on Update for All Wavel..

NOTE

A continuous push on direction keys increments the value by 10 dBm.

NOTE

Using MP 60 or MP80 power meter, set manually to Auto the Lambda to auto-
matically detect the wavelength: in results page, press Power Config. > 
Wavelength key multiple times until Auto is displayed.
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• Attenuator compensation
Choice of level to be applied to the wavelength chosen for 
measurement to compensate for the loss due to the external 
attenuator (+XX.XX dB). First use the direction keys to choose 
the wavelength, then press  to access choice of value, then 
confirm this value pressing ENTER.

Activating the Source function
The Source function is an option chosen at the time of order and incorporated into the 
OTDR module in the factory.

To activate the function:

1 Press the HOME button.

2 Click on the icon Source in the OTDR Section.

The icon turns yellow .

Result page
The results page, automatically displayed after the icon selection, gives the information 
relating to the measurement in progress, results previously saved and the commands 
available for measurement and saving.

Result page of the Power meter
The power measured by the power meter is displayed in large characters, in the units 
selected in the Setup menu, together with:

NOTE

To copy a Reference Level/Attenuator Compensator on all wavelengths, 
select the reference wavelength and click on Update for All Wavel..

CAUTION

The Singlemode and Multimode Source icons cannot be selected at the 
same time. When one is selected, it automatically deselects the other one.
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• the mode of transmission of the signal measured: continuous (CW) or modulated 
to a frequency of 270Hz, 330Hz, 1KHz, or 2KHz.

• the wavelength of the signal measured. 

• the reference level expressed in dB.

• the level of Attenuation Compensation.

Table of results
For one and the same fiber, the power meter displays a table of 9 results corresponding 
to the different possible wavelengths. The table shows the power measured in dBm, the 
relative power (in dB) and the reference level in dBm (if units = dB), together with the 
mode.

• A measurement result is displayed in the table when the Keep Result softkey is 
pressed. 

• The Clear Table softkey orders deletion of all the results displayed in the table. 

• If the Alarm function has been activated, any result that exceeds the selected 
thresholds appears in red in the table. Otherwise, results are shown in the table in 
green.

• When the instrument is switched off, results present in the table are saved.

Commands of the power meter parameters
When the Powermeter function is selected, the following softkeys are available on the 
results page.
The different configuration buttons are displayed:

Figure 54 Results and commands of the power meter

Results
of  the
power meter

MTS2100 4100 Module US rev015.book  Page 96  Jeudi, 14. janvier 2021  3:41 15



Chapter 6 Power meter and Source options of the OTDR Modules
Result page

User Manual 77000010208 Rev. 015 97

Wavelength selection of the wavelength

Unit choice of the unit

Zero adjustment of the Zero value when the power meter’s optical input is 
closed with a plug (a validation is required).

On the results page, the following actions are available:

Set as Reference Selects the current result as reference value to measure the atten-
uation of a link. This reference is displayed under the measure-
ment result until a new reference value is chosen.

Keep Result Saves the result on the corresponding line of the table.

Clear Table Deletes all the results recorded in the table.

If the Source function is selected (either on this Platform, on the base Unit or on an 
OTDR module, or on another Platform), the Power meter results page is different:

• The Wavelength, Unit and Zero menu keys are accessible via the menu key 
Power Config.

• The Power Ref. menu key allows to reach the Standard Ref menu key. It also 
allows to reach the Jumper Ref menu key if Power meter function is associated 
with Source function onto another unit (see “Carrying out the reference in loop-
back mode” on page 102).

Combo PM/OTDR
If the ExpertOTDR mode is activated at the same time as the Powermeter, a menu key 
Combo PM/OTDR is displayed in the powermeter page.

It allows to launch an OTDR acquisition on the same port as the powermeter, clicking on 
Yes in the dialog box displayed.

 

Figure 55 Combo Powermeter / OTDR
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Result page of the Source
Once the source icon is selected, the results page displays and the Source can be 
configured.

• Laser On / Laser Off
Activation or shut-down of the laser (same function as the 
START/STOP button)

When the laser is on, the icon  is displayed.

The parameters of the source can be accessed directly on the result screen:

Wavelength To change the wavelength when a multi-wavelength source is 
present (depending on option).

The wavelength value is displayed.

Mode To vary the mode of emission of the source. Possible modulation 
values are:

–  270 Hz / 330 Hz / 1 kHz / 2 kHz

– Auto (the sources emit on determined frequencies to enable the power meter 
to detect the wavelength used automatically)

– TwinTest (cyclical emission on all available wavelengths for a few seconds on 
each wavelength), compatible with the VIAVI OLP 34/35/38.

– CW (continuous emission)

CAUTION

Only the following Modules  used in combination with the powermeter, have 
the Combo PM/OTDR function:

- For T-BERD/MTS 2000/4000 V2: E4136RMAx, E4136RMPx, E4136RMP, 
Exx1xRMAx and Exx1xRMPx.

- For SmartOTDR: E117FA65PPM-PC, E117FA65PPM-APC, E136FB-PC 
and E136FB-APC.

Figure 56 Source result page
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The mode used is displayed, above the icon .

Standard Reference
To perform a side by side reference measurement (see “Carrying out 
the side by side reference” on page 100).

If the power meter function is selected onto the equipment (either on Base-Unit or on 
OTDR module) the menu keys are different on screen:

Source Config: allows to display the Wavelength and Mode menu keys

The Source Reference menu key allows to open a sub-menu with the following keys:

Standard Ref to perform a reference in side by side mode (see “Carrying out the 
side by side reference” on page 100).

Jumper Ref: to perform a reference measurement in loopback mode (see 
“Carrying out the reference in loopback mode” on page 102).

Performing the power level measurement
The power meter is started up as soon as the function  is activated in the HOME 
page.

1 Connect the light source to be tested to the rear connector (see "Connection to 
the power meter" page 92).

2 In the SETUP menu, choose the units dBm or Watts.

3 Press the START/STOP key to start the measurement. 

The result will appear in the results page and can be memorized in the table (see 
"Table of results" page 96).

4 Press the START/STOP key to stop the measurement.

It is not possible to use simultaneously the Source function and the 
Powermeter function, when both options are set onto the OTDR mod-
ule, as they use the same connector.

Power measurement is automatically updated in consequence. The value 
«<-50 dBm» is displayed when the laser is switched off and if the source 
output is looped on to the power meter input.
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Performing the insertion loss measurement
Using light source and power meter options, an insertion loss measurement can be 
performed, having previously carried out a reference measurement.

Setting the zero value of the power meter
1 Fix the plug over the optical input of the power meter so that no light can reach 

the photodiode of the power meter. If the zero adjustment is made without this 
plug, an error message may be displayed, as the photodiode will detect too much 
light.

2 In the Results page, press Powermeter config. > Zero soft key and validate.

Carrying out the reference
Using two T-BERD/MTS platforms or two SmartOTDR, with an OTDR module including  
a laser source option and a Power meter option, an insertion loss measurement in 
continuous wave can be performed.

Two types of reference are available: referencing in side by side mode and referencing 
in loopback mode.

Carrying out the side by side reference 
This reference can be carried out when both units are connected together meaning they 
have to be at the same location.

It is important to set the zero of the power meter before making any mea-
surements where accuracy is required, as the noise from the germanium 
photodiode fluctuates over time and with variations in temperature.

Figure 57 Side by side reference

OTDR
Source

Mainframe, USB or 
OTDR module
Power meter

T-BERD/MTS / SmartOTDR(2)T-BERD/MTS / SmartOTDR (1) Bulkhead 
connector

Jumpers
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1 Before connecting fiber/jumper, use appropriate cleaning tool to clean connector 
end-faces.

2 Connect the two jumpers together via a bulkhead connector.

3 Set, on equipment (1), the OTDR light source as "Standard Ref"

a Press the HOME key

b Use the arrow keys or touchscreen to select the Source function on Home 

page .

c Press RESULTS key 

d In the Results page, press Source Config.> Source Reference > Stan-
dard Ref

e Press Exit and go back to the result Page

f Select the Twintest mode by skipping through the different modes

g Press Laser On key to activate the source

4 Set, on equipment (2), the power meter (from OTDR module, from the Base-unit 
or from USB) as "Standard Ref"

a Press the HOME key

b Use the arrow keys or touchscreen to select the Powermeter function in 

Home page .

c Press RESULTS key. 

d In the Results page, press Pow.Reference > Standard Ref. 

The actual power level is set as the new reference level for the selected 
wavelength. Then, the displayed value is around 00.00 dB. 

e Press Exit and go back to the Results page.

The reference levels are stored into the unit, and have been automatically filled into the 
setup.

NOTE

The reference can be performed with one T-BERD/MTS 2000 at one side 
and one T-BERD/MTS-4000 V2 at the other side.
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Carrying out the reference in loopback mode
This reference can be carried out when the units are separated, at different locations. It 
is made using the OTDR source and the power meter built-in the platform.

1 To reference the OTDR light source, on equipment (1)

a Select the OTDR Source icon in Home page , on the OTDR area.

b Press RESULTS key

c In the LTS result page, press Source Config. > Source Reference > 
Jumper Ref..

A popup message appears

d Connect the jumper from the OTDR source to the mainframe power meter, 
and then press OK.

The reference measurement is performed automatically.

A popup message appears when it's done: press any key to continue

2 To reference the mainframe power meter, on equipment (2)

a Select the Optical powermeter icon of the mainframe in Home page 
 (on the upper part, on the base options line)

b In the LTS result page, press Pow. Reference > Jumper Ref..

A popup message appears

c Connect the jumper from the OTDR port to the mainframe power meter, and 
then press OK

NOTE

Each platform must be equipped with a power meter set onto the base-unit.

Figure 58 Reference in loopback mode

OTDR

MTS / BERD / SmartOTDR (1)

Mainframe

Source of the 
OTDR module

Power meter of 
Base unit

OTDR
Source of the 
OTDR module

Power meter of 
Base unit

MTS / BERD / SmartOTDR (2)

Mainframe
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The reference is performed automatically.
A popup message appears once done. Press any key to continue

The reference levels are stored into the unit, and have been automatically filled into the 
setup.

Measurements on the fiber under test
Once the references have been performed on both units:

1 After loopback reference, disconnect the jumper from the powermeter port on the 
T-BERD/MTS or SmartOTDR (1) and the jumper from the Source port on the T-
BERD/MTS  or SmartOTDR (2).

After a reference in Side by side mode, disconnect the bulkhead connector and 
keep the jumpers connected to the Source and Powermeter ports.

2 Connect the jumpers to the fiber under test using the appropriate method (ex. 
keying mechanism for FC/PC types).

3 On MTS / T-BERD or SmartOTDR (1) select Laser On to activate the light 
source.

Measurement using a mode conditioner

To perform an Insertion Loss measurement with a Source that is compliant to IEC 
61280-4-1 Ed2 Standard on encircled flux, it is recommended to use a mode conditioner 
after the OTDR Source port.
Once the Source on T-BERD/MTS or SmartOTDR (1) and the Powermeter on T-BERD/
MTS or SmartOTDR (2) are referenced in loopback or side-by-side mode:

1 Connect the Multimode source (1) to the mode conditioner 

2 Connect the Powermeter port (2) to the jumper

3 Connect extremities of the mode conditioner and jumper to the fiber under test 
using the appropriate method (ex. keying mechanism for FC/PC types).

Figure 59 Measurement of the fiber under test

OTDR Module:
Source port

Mainframe
Power meter port

Fiber Under Test
Equipment (1) Equipment (2)

Jumper
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4 On equipment (1) select Laser On to activate the light source.

Storing and reloading results

File Setup
Click on the button FILE to access the File setup. See "Description of the explorer" page 
236 for a complete description of all parameters, options and the explorer.

Storing results
In order to save the results of a measurement, click on FILE and select Store trace. Two 
files are being saved:

• The first file is to be used with the product and allows to retrieve all measurement 
results. It is saved with the extension .Lts.

• The second file is a text file using tabulations to separate values.
It is saved with the extension «.txt» and can be opened by the Platform via the 
Web Browser. It has been designed to be used with a spreadsheet program on a 
PC where it allows to retrieve all measurement results and format them in a nice 
customized table. 

Loading results
In order to load the results of a measurement, select a file  with the extension 
«.Lts» in the file explorer (see Chapter 13), click on Load > View trace.

The LTS tab is displayed with the loaded results in the table.

Figure 60 Measurement of the Insertion Loss with a mode conditioner
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Terminated PON Powermeter (SmartOTDR only)
The SmartOTDR referenced E118FA65PPM offers a Terminated PON powermeter.

This Powermeter allows to perform PON Power Measurement at the premises to check 
the presence of signal(s) and verify power level(s).

The SmartOTDR Terminated PON Power Meter measures simultaneously 1490 & 1550 
nm or 1490 & 1578 nm downstream signals.

Configuring the powermeter
To activate the function:

1 Press the HOME button

2 Select the PON power meter icon in the section of the OTDR Module

The icon turns yellow .

The effect of this action will to be to bring the power meter into use.

The measurement parameters can be accessed with the SETUP key.

Figure 61 Signals measurement with Terminated PON powermeter

Splitter

Terminated PON 
Power Meter

ONT
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Configuring the alarm parameters
• Alarm Activation of the Alarm function: any result below the lower 

threshold or above the upper threshold will be displayed in red 
on the Results page.

• Min and max thresholds
Choice of lower and upper thresholds for each available 
wavelength, from -60 to +40 dBm.

Configuring the Measurement parameters
In the Setup page, press Measur’t soft key (if one parameter is selected in the current 
screen, press Top Menu soft key to display the right menu keys and click on Measur’t) 

• Lambda click to toggle between 1490/1550 nm and 1490/1578 nm.

Configuring the Link parameters
In the Setup page, press Link soft key (if one parameter is selected in the current 
screen, press Top Menu soft key to display the right menu keys and click on Link).

Figure 62 Configuration of power measurement

See OTDR chapter: 
“Configuring the File 
parameters” on page 43

NOTE

To copy one value of the Lower or/and Upper threshold for all wavelengths, 
select the reference value and click on Update for All Wavel..
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The information entered in the Link Description window concerns the editing and/or the 
modifications of the cable and fiber parameters. When a trace is recalled without recall 
of the configuration, the parameters of this trace will be present only in its signature.

Test Point / OLT Id / ONT Id / Distribution Id / Feeder Id
Those parameters allow to enter an identification for each element of the network (test 
point, OLT, ONT...) using the Edition menu.

Fiber Number
Select the parameter Fiber Number and modify the parameter using the left and right 
direction keys.

The fiber number can be automatically incremented/decremented at each new file save 
if it has been configured in the following parameter.

Change Fiber Nbr 
Increment the fiber number is automatically incremented at each new file-save.

Decrement the fiber number is automatically decremented at each new file-save

User defined Use Edit Number softkey to enter the increment/decrement value for 
fiber number.

Note: to decrement the number, enter the sign «-» before the number. 
Example: -1.
Min: -999 / Max: 999 / Auto: 0

No the Fiber number must not automatically modified.

Technician Id
Use the arrow  to enter the name of the operator carrying out the measurement.

Comment
In contrast to the other data in this menu, the comment is specific to a fiber. This line is 
thus used to enter a new comment and not to display it. The comment appears at the 

NOTE

The softkey Copy File/Link To all is displayed when one parameter is 
selected in the Link or File Setup page and when the Powermeter or Source 
function is active. 

It allows to apply the Link and File configuration parameters of the current 
applications to all the other active Fiber Optic applications).
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top of the screen, with the other parameters of the fiber.
This comment will remain available for the next acquisition, unless it is deleted. It is also 
saved when a trace is saved with a comment.

Setting the zero value of the power meter
1 Fix the plug over the optical input of the power meter so that no light can reach 

the photodiode of the power meter. If the zero adjustment is made without this 
plug, an error message may be displayed, as the photodiode will detect too much 
light.

2 In the Results page, press Zero soft key and validate.

3 Wait until the dialog box Dark current calibration completed displays.

4 Hit any key to continue

Measuring the signals
To perform the measurement:

1 Connect the fiber to a source and to the PON Powermeter of the SmartOTDR.

2 Activate the source.

3 In the results page of the powermeter, check the value for each wavelength.

It is important to set the zero of the power meter before making any mea-
surements where accuracy is required, as the noise from the germanium 
photodiode fluctuates over time and with variations in temperature.
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For each wavelength, the power value is displayed in green if it does not exceed 
the alarm thresholds defined in the setup menu, and in red if it exceeds the 
thresholds.

The results are displayed in blue if no alarm is defined.

4 Press Keep results to keep the current results in the table.

5 Press Wavelength to toggle between 1490 / 1550 nm (for video) & 1490 / 1578 
nm (for XGPON network)

Combo PM/OTDR
If the ExpertOTDR mode is activated at the same time as the PON Powermeter, a 
menu key Combo PM/OTDR is displayed in the powermeter page.
It allows to save the powermeter results and launch an OTDR acquisition on the same 
port as the powermeter, clicking on Yes in the dialog box displayed.

Figure 63 Terminated PON Powermeter results

CAUTION

Only the following OTDR modules or SmartOTDR models  used in combina-
tion with the powerme-ter, have the Combo PM/OTDR function;

- SmartOTDR: E117FA65PPM-PC, E117FA65PPM-APC, E136FB-PC and 
E136FB-APC.

- Modules for 4000 V2 and 2000 Platforms: E4136RMAx, E4136RMPx, 
E4136RMP, Exx1xRMAx et Exx1xRMPx.
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The report will contain both results (.sor and power meter results) in the .sor and/or .pdf 
file.

 

Storing results
In order to save the results of a measurement, click on FILE and select Store > Save.

The file is saved with the extension .Lts, and is represented by the icon .

Figure 64 In-Service OTDR
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Chapter 7FTTA-SLM Software option

This chapter describes the use of the FTTA-SLM option, when the software license has 
been purchased with an OTDR module.

The topics discussed in this chapter are as follows:

• “Principle of FTTA-SLM” on page 112

• “Configuring the Reflectometry test for FTTA network” on page 114

• “Launching the acquisition” on page 120

• “Results page” on page 122

• “Saving the trace(s) and generating a report” on page 127
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Principle of FTTA-SLM
FTTA-SLM is an OTDR software application that is delivered as an option of the OTDR 
module (see references in the ordering information section), and is installed onto the 
mainframe as a license key (see the 2000/4000 V2 base-unit user manual for the 
instructions on license files installation).

FTTA-SLM simplifies OTDR testing for cell-tower technicians and eliminates complexi-
ties of result interpretation.

In a FTTA environment, the OTDR module, associated with the FTTA-SLM application, 
allows to:

• Characterize and measure the fiber link loss, measure the loss and reflectance of 
each passive element, and provide the position for each one: Acceptance 
Testing

• Locate and identify causes of failure on a fiber link: Troubleshooting / Mainte-
nance.

Acceptance Testing
One way to judge installation quality is to use a loopback device (a retractible/expand-
able fiber leash cable or a patchcord) on duplex fiber to test at the junction box or RRU 
location and shoot with an OTDR from the BBU or fiber-patch panel location to qualify 
the entire fiber channel.
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Troubleshooting Testing
An OTDR from the BBU or fiber patch panel location will troubleshoot the fiber link up to 
the RRU/RRH. Before performing the OTDR measurement, make sure that the fiber 
being tested has no signal and the equipment is shut down.

Figure 65 Acceptance Testing
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Configuring the Reflectometry test for FTTA 
network

Once the OTDR module is set into the T-BERD/MTS, and the FTTA-SLM license 
installed:

1 Select the FTTA-OTDR icon .

The results page automatically displays.

2 Press SETUP hard key to display the OTDR configuration screen for FTTA 
network.

Figure 66 Troubleshooting Testing
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Acquisition (FTTA)
In the first screen, configure the following parameters:

Laser
The acquisition will be carried out on the wavelength(s) selected (for multiple-wave-
length modules). In case of a multi-wavelength module, select All to perform a measure-
ment for all the wavelengths available (this parameter visible exclusively on modules 
with one single OTDR port). The possible values depend on the module used. 

Network Config.1

This parameter is used to identify the network type:

Cell Tower Typical macro cell tower topology

Rooftop Tenant Rooftop topology 

Rooftop Penthouse Rooftop topology

Das Distributed Antenna System 

Figure 67 FTTA OTDR Setup

See “Configuring the 
File parameters” on 
page 431

1  From the Link Setup page of the OTDR function, for Technician Id parameter, see “Technician Id” on page 43 and for Comment parameter, 

see “Comment” on page 43

1.Active exclusively if the License «FTTA Extended» is installed

MTS2100 4100 Module US rev015.book  Page 115  Jeudi, 14. janvier 2021  3:41 15



Chapter 7 FTTA-SLM Software option
Configuring the Reflectometry test for FTTA network

116 User Manual 77000010208 Rev. 015

Config.
This parameter displays the last configuration file loaded and cannot be modified unless 
a new configuration file is loaded.

Alarms
In the Setup page, press the Alarm menu key (if one parameter is selected in the current 
screen, press Top Menu soft key to display the right menu keys and click on Alarms).

Figure 68 Network configurations

Rooftop Tenant Rooftop Penthouse

DAS

Cell Tower
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Alarms > Threshold
• None The alarm function is not active.

• User Define your own thresholds values for one or several elements: 
Splice Loss / Connector Loss / Reflectance / Fiber Length Min / 
Link Loss Max / ORL

• TIA-568 3 / TIA-568 3.RL35 / ISO/IEC 11801 2002 or 2010 / ISO/IEC 14763-3 
2006 or 2014 / Default / G.697/G.98x PON / G.697/IEEE PON

Select one of this parameter to configure the alarm thresholds with 
predefined values:

If results are above the thresholds, they will be highlighted in red in the table of results, 
and the icon  will appear at the top right of the screen.

If all the results lie within the thresholds (no result is in red), results are displayed in 
green in the table and the icon is .

Analysis
In the Setup page, press Analysis softkey (if one parameter is selected in the current 
screen, press Top Menu soft key to display the right menu keys and click on Analysis).

This screen allows to configure the network:

Table 5 Singlemode Module

Splice Loss Connector loss Slope Reflectance ORL

Default > 0.20 dB > 0.50 dB > 1.00 dB/km > - 35 dB < 27 dB

TIA-568.3

> 0.30 dB

> 0.75 dB > 1.00 dB/km No

No

TIA-568.3 RL35 > 0.75 dB > 1.00 dB/km > - 35 dB

ISO/IEC 11801 
(2002)

> 0.75 dB > 1.00 dB/km No

ISO/IEC 11801 
(2010)

> 0.50 dB > 0.40 dB/km > - 35 dB

ISO/IEC 14763-3 
(2006)

> 0.50 dB > 1.00 dB/km No

No
ISO/IEC 14763-3 
(2014)

> 0.75 dB > 0.40 dB/km No
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BBU Jumper
Test from the patchcord that will be plugged into BBU.
(not applicable for DAS networks)

RRU Jumper
Test from the patchcord that will be plugged into RRU.
(not applicable for DAS networks)

Mode
Select the kind of acquisition to be performed:

• Construction Select this mode to perform the OTDR acquisition in the case 
of an Acceptance Testing (see “Acceptance Testing” on 
page 112).

• Maintenance Select this mode to perform the OTDR acquisition in the case 
of Troubleshooting (see “Troubleshooting Testing” on 
page 113).

Loopback Cable
Select if a loopback cable is used (parameter available exclusively in Construction 
mode).

Launch Cable End / Receive Cable Start (not available in Maintenance 
mode)
No All the results are displayed and referenced on the basis of the board of 

the module.

Evt 1, 2, 3 The results relating to the launch cable are eliminated from the table. 
Attenuation and distances are then measured on the basis of the marker 
Evt 1, 2 or 3 selected.

Distance Use the Edit Number key to enter a distance (Min= 0 / Max=50 km / 
164.042 kfeet / 31.075 miles) or affect the active cursor value, using the 
Set Cursor Distance key.

Link
In the Setup page, press Link softkey (if one parameter is selected in the current screen, 
press Top Menu soft key to display the right menu keys and click on Link).
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The information entered in the Link Description window concerns the editing and/or the 
modifications of the cable and fiber parameters. When a trace is recalled without recall 
of the configuration, the parameters of this trace will be present only in its signature.

Base Station Id or Headend Id (in case of DAS)
If known, enter the name of the Base Station using the edition keypad, displayed 
pressing the right arrow key.

RRU Id or Remote End Id (in case of DAS)
If known, enter the name of the RRU/RRH (Remote Radio Unit / Head) using the edition 
keypad, displayed pressing the right arrow key.

Fiber Code / Fiber Num
To use the Fiber Code convention, with Rx/Tx labeling, choose between the following 
config files: FTTA_Rx_Tx.SM-OTDR or FTTA_Rx_Tx.MM-OTDR.

For a simple labeling of the fiber number (1 to 24), load one of the following config files: 
FTTA_Simple.SM-OTDR or FTTA_Simple.MM-OTDR

Example of fiber code in:

• Construction mode (with loopback): from 1-Rx_1-Tx to 24-Rx_24-Tx

• Maintenance mode: from 1-Rx to 24-Rx

Change Fiber Nbr
Select if the fiber number must be automatically Incremented or Decremented at each 
new file save.

Increment the fiber number is automatically incremented at each new file-save.

Decrement the fiber number is automatically decremented at each new file-save

NOTE

The name of Location A entered in ExpertOTDR configuration is displayed 
by default in this parameter (see “Location A” on page 40).

NOTE

The name of Location B entered in ExpertOTDR configuration is displayed 
by default in this parameter (see “Location B” on page 41).
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User defined Use Edit Number softkey to enter the increment/decrement value for 
fiber number.

Note: to decrement the number, enter the sign «-» before the number. 
Example: -1.

Min: -999 / Max: 999 / Auto: 0

No the Fiber number must not automatically modified

Distance unit

Select the unit to be used for distance (km / kfeet / miles / meter / feet).

Launching the acquisition

1 Press START/STOP hard key to launch measurement.

The red Test indicator goes on to show that the T-BERD/MTS is in process of 
acquisition and the screen displays the trace in process of acquisition.

2 The quality of the connection is displayed for a few 
seconds (see Table 3 on page 53)

3 Then, a bar graph shows elapsed and remaining acquisition time. 

Inspect & clean all fiber connections prior connecting fiber cables into 
the ports (BBU, distribution boxes, OVP and RRU/RRH and SFP ports).
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At the end of the acquisition, a beep is emitted, the trace is displayed and an 
automatic measurement is started.

If the module possesses several lasers, to perform successive acquisitions on all the 
wavelengths:

1 In the SETUP menu, check in Laser line, that several lasers are selected or 
select All.

2 Start the acquisition by pressing the START/STOP button.

3 Once the acquisition for the first wavelength is finished, the acquisition for the 
following wavelength starts automatically.

or 

To stop manually the acquisition for current wavelength, click on Stop Wave-
length. This will allow to automatically start the measurement for the following 
wavelength.

A beep is emitted once the acquisitions on all lasers are completed.

Figure 69 Acquisition in progress

Number of 
averages calculated

Elapsed 
acquisition time Total acquisition 

time
Elapsed time

NOTE

During acquisition, the traffic on fiber is automatically detected (see “Traffic 
detection” on page 53)
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The different traces appear in the same window and can be managed as traces in 
overlay (see “Overlay trace function” on page 83).

Results page
The trace(s) acquired or recalled from a memory is/are displayed on the Results page.

Trace View
The Trace view is displayed by default once OTDR acquisition is completed.

Once trace is displayed, you can:

• Zoom on trace (see “Zoom function” on page 72).

• Set Cursor A and/or Cursor B (see “Cursors” on page 70).

• Save the traces and launch a report of results (see “Saving the trace(s) and 
generating a report” on page 127).

The available event types are similar to the events for OTDR measurement (see 
“Results table” on page 68) except the Merged Connector Loss . In FTTA results:

Loss per connector = total group loss / nb of events in the group

Figure 70 FTTA OTDR Trace
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Detailed description of an event

When clicking on one event icon in the results table, a popup window describes the 
event type and provides a diagnosis to help troubleshoot faulty optical elements (indi-
cated in red).

Press SETUP hard key to go back to FTTA Setup screen and modify the parameters 
before launching a new acquisition.

SmartLink view
1 Click on the menu key Trace/SmartLink to select SmartLink.

A screen as the following one is displayed:

Figure 71 Event description

C
lic

k

Figure 72 SmartLink function

Zone 1

Zone 2

Zone 3
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The screen is divided into three zones:

• Zone 1: Graphical representation of the link, with icons symbolizing the different 
events detected.

• Zone 2: Link Table, which gives a summary of results for each wavelength, with 
results within/without thresholds in green/red (according to Alarm thresholds 
defined in the setup screen).

• Zone 3: Alarms table (if any)

Merged connectors
When 2 or more connectors are very close to eahc others (in the attenuation dead zone), 
usually the reflectances can be measured but the loss of the individuals can’t be - the 
loss of these connectors is "merged" .

The following formula is then applied (only in FTTA mode):

loss per connector = (total group loss) / (nb of connectors in the group)

Getting a diagnostic of an event
Diagnosis is used to provide further information about events and eventual problems, 
such as root cause possibilities of a failed optical element.

1 Select the event to be described (underlined in yellow).

2 Click on Event Diagnostic soft key

A new window, on the lower part of the screen, gives the details of the selected 
event: 

– its type

– the thresholds applied for this event.

– the possible causes of the alarm

If several traces are displayed in overlay, with the same wavelength, 
then only the Zone 2 is displayed, there is no graphical representation 
of the link (Zone 1).
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Results Table

To display exclusively the results table from the SmartLink page, press the Results 
Table softkey.

Press again the Results Table menu key to return to SmartLink display.

Event View
1 Click on Event View menu key to display a detailed description of one event 

detected on trace.

Figure 73 Event Detail window

Figure 74 FTTA Smart Link: Results Table
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In this view, an algorithm automatically detects the elements of the FTTA link and 
label them.

2 Select the event to be described on the graphic (highlight in yellow).

The corresponding event description is displayed on the Zone 3, with a recall of 
alarm threshold for this event:

3 Click on Trace View to display the selected event in the results table and zoomed 
on trace.

Changing the name of an event
Once the SmartLink screen is displayed, the name of an event can be modified:

1 Select the event to be modified (highlighted in yellow) .

2 Press Rename Event menu key

3 In the edition keypad, select the pre-defined parameters available or, press abc 
key to enter a name manually for the file. Then, press Enter to validate.

Figure 75 SmartLink: Event View

NOTE

The event is framed in red if it is above the alarm thresholds defined in the 
setup menu.
It is framed in green if it lies within the thresholds.
It is framed in purple if no alarm has been defined for this type of event.
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4 Click on Enter to return to Event View.

The event name is displayed under the icon, and replaces the previous FTTA 
label .

Click on Replay Label to rename the event as it was previously (at last saving).

Saving the trace(s) and generating a report
Once the results page is displayed, the trace(s) can be saved and a report can be gener-
ated directly from the results screen.

Saving and report can have been automatically generated if, in the file configuration, the 
Auto Store parameter has been set to Yes (see page 46) with the appropriate Save 
Mode.

Saving results and creating a report from results page
To save the trace and generate a report:

1 Press Fast Report key  -> .

A menu displays under the trace.

2 In the menu, configure the file saving mode (and the report)

Figure 76 Rename Event
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a In the Fiber Code / Fiber Number parameter use the left and right direction 
keys to define the fiber code / fiber number by scrolling the available codes/
numbers.

Fiber Code: from 1-Rx_1-Tx to 24-Rx_24-Tx if the configuration file 
selected is FTTA_Rx_Tx.SM-OTDR or FTTA_Rx_Tx.MM-OTDR.

Fiber Number: from 1 to 24 if the configuration file selected is FTTA_-
Simple.SM-OTDR or FTTA_Simple.MM-OTDR.

b In the Save Mode parameter, select the report format to be generated:

txt file select Yes to save the results in a .sor file and to generate a txt 
file of the results.

pdf file select Yes to save the results in a .sor file and to generate a 
report in a pdf file.

json file select Yes to save the results in a .sor file and to generate a 
json file.

If all parameters are defined with No, only the .sor (or .msor) file will be saved.

3 Once all the parameters are configured, press Save All menu key.

4 Enter a name for the file in the edition keypad.

or

Click on Auto Filenaming menu key to apply the file name defined in the Setup 
screen, in Filenaming parameter (see page 45).

5 Press Enter to validate

Figure 77 Fast report configuration

MTS2100 4100 Module US rev015.book  Page 128  Jeudi, 14. janvier 2021  3:41 15



Chapter 7 FTTA-SLM Software option
Saving the trace(s) and generating a report

User Manual 77000010208 Rev. 015 129

The icon  displays during saving process.

Once saving is completed, a sound is emitted onto the Platform.

Opening a report
1 To open the report, press FILE hardkey

2 In the Explorer page, in the directory selected, select the file/report.

The file name is: 

For the txt file: trace file_sor.txt

For the pdf file: trace file.sor.pdf

3 Press Load.

The file opens on the T-BERD/MTS.

NOTE

The sor file and the txt or pdf file will have the same name.

NOTE

The file and the report are saved in the last storage media and directory 
selected.
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Figure 78 Fast Report with FTTA-SLM option

CAUTION

To modify the VIAVI logo, set by default on the header of the pdf report, save 
your logo in a jpg file called logo.jpg and place it to the root of the disk: 
disk > logo.jpg.

NOTE

A pdf report can also be generated from the File Explorer page onto the T-
BERD/MTS (see “Generating pdf report(s)” on page 244).

MTS2100 4100 Module US rev015.book  Page 130  Jeudi, 14. janvier 2021  3:41 15



8

User Manual 77000010208 Rev. 015 131

Chapter 8FTTH-SLM Software option

This chapter describes the use of the FTTH option, when the software license has been 
purchased with an OTDR module.

The topics discussed in this chapter are as follows:

• “Principle of FTTH” on page 132

• “Configuring the Reflectometry test for FTTH network” on page 133

• “Launching the acquisition” on page 139

• “Results page” on page 140

• “FTTH Premium software option” on page 147

• “Specific OTDR features with FTTH option” on page 150

• “FTTH Assistant” on page 150

• “Saving results for FTTH-SLM Assistant” on page 156

NOTE

Patented, as described at www.viavisolutions.com/patents.
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Principle of FTTH
FTTH-SLM is an OTDR software application that is delivered as an option of the OTDR 
module (see references in the Chapter 15 on page 267), and is installed onto the main-
frame as a license key (see the 2000/4000 V2 base-unit user manual for the instructions 
on license files installation).

FTTH-SLM application brings an FTTH user interface and a specific algorithm for OTDR 
measurements, especially through PON splitters (Passive Optical Network).

In a FTTH environment, the OTDR module, associated with the FTTH-SLM application:

• Selects optimized test parameters to conduct reliable measurements, especially 
through optical splitters, and to detect close events near the start (Central Office 
splices/ connectors) (OptiPulses Automatic Algorithm).

• Automatically identifies all network elements such as PON splitter types/ratios 
(Discover Mode).

• Iconically displays a map of OTDR trace results (SmartLink View)

• Guarantees measurements with automatic PASS/FAIL analysis to ITU-T/IEEE 
PON standards or customer-defined specifications.

Figure 79 FTTH network
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Configuring the Reflectometry test for FTTH 
network

Once the OTDR module is set into the T-BERD/MTS, and the FTTH-SLM license 
installed:

1 Select the FTTH-OTDR icon .

The results page automatically displays.

2 Press SETUP hard key to display the OTDR configuration screen for FTTH 
network.

FTTH setup
In the first screen, configure the following parameters:

Acquisition
Laser

The acquisition will be carried out on the wavelength(s) selected (for multiple-wave-
length modules). In case of a multi-wavelength module, select All to perform a measure-
ment for all the wavelengths available (this parameter visible exclusively on modules 
with one single OTDR port). The possible values depend on the module used. 

Figure 80 FTTH OTDR Setup

See “Configuring the File parameters” on page 43
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Direction
• OLT: Optical Line Terminal (switch at the Central Office)

• ONT: Optical Network Terminal (media converter and gateway in the Home)

Select the direction of the measurement:

– Downstream: from OLT to ONT (OLT -> ONT) 

– Upstream: from ONT to OLT (ONT -> OLT)

Number of Splitters

If known, enter the number of splitters installed in the FTTH network.

None: no splitter is installed

Discover: auto-detection and identification of PON splitter types.

1 / 2 / 3: select the number of splitters.

This selection opens a sub menu into which the splitters types must be defined for all 
splitters installed.

Splitters types

Define the splitter type among the list:

– 1x2 / 1x4 / 1x8 / 1x16 / 1x32 / 1x64

– 2x2 / 2x4 / 2x8 / 2x16 / 2x32 / 2x64

Launch Cable End / Receive Cable Start
No All the results are displayed and referenced on the basis of the board 

of the module.

Length Use the Edit Number key to enter a distance (Min= 0 / Max=50 km / 
164.042 kfeet / 31.075 miles) or affect the active cursor value, using 
the Set Cursor Distance key.

It is preferred to know the number of splitters in order to get Pass/Fail 
status for the splitters’ loss.

NOTE

The Discover mode does not allow Pass/Fail analysis
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Distance Unit

Define the unit of the distances displayed: km, kfeet, miles, meter, feet.

Index of refraction
Choice of group refraction index of the whole fiber. 

User Define for each wavelength (1310 SM, 1360-1510 SM, 1550 SM, 
1590 - 1650 SM) a refraction index of 1.30000 to 1.69999. The selec-
tion of an index alters the value of the section AB (actual distance 
between cursors A and B).

or,

If the actual distance between the cursors A and B is known, enter its 
value under Section AB to establish the index of the fiber. Selection 
of this distance causes the display of the indices. The extreme 
distance values are given by the index values (1.30000 to 1.70000).
or

You can also enter the Link Length, if it is known, using the Numeric 
keypad.

Predefined It is possible to choose one of the predefined values given for certain 
cables. The corresponding indices given in the table below are 
repeated on the screen.

Table 6 Predefined index values (Single Mode)

Wavelength (nm) 1310 SM 1360 - 1510 SM 1550 SM 1625 - 1650 SM

Generic G652 G657 1.46750 1.46800 1.46800 1.46850

Generic G653 G655 1.46750 1.46800 1.46800 1.46850

ATT SM 1.46600 1.46700 1.46700 1.46700

Corning SMF-28 1.46750 1.46810 1.46810 1.46810

Corning SMF-DS 1.47180 1.47110 1.47110 1.47110

Corning SMF-LS 1.47100 1.47000 1.47000 1.47000

Corning-Leaf 1.46890 1.46840 1.46840 1.46900

Draka SMF 1.46750 1.46800 1.46800 1.46850

Draka Longline 1.46700 1.46700 1.46710 1.46750

Draka Teralight 1.46820 1.46820 1.46830 1.46850

Draka Benbright 1.46750 1.46750 1.46800 1.46850

Fitel Furukawa 1.47000 1.47000 1.47000 1.47000
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Config.

This parameter displays the configuration file selected for acquisition, and cannot be 
modified from Setup page. To modify the configuration file to be used:

1 Click on the menu header Acquisition.

2 Click on Load Config. menu key 

3 Select the file in the Explorer.

Alarms parameters
Press the Alarm menu key (or Next key when one parameter of the Setup page is 
selected) to configure the alarm thresholds for the OTDR measurement.

None The alarm function is not active.

OFS Lucent Allwave 1.46750 1.46750 1.46750 1.46850

Lucent Truewave 1.47100 1.47100 1.47000 1.47000

SpecTran SM 1.46750 1.46810 1.46810 1.46810

Sterlite 1.46700 1.46700 1.46750 1.46750

Sumitomo Litespec 1.46600 1.46600 1.46700 1.47000

Sumitomo Pure 1.46600 1.46600 1.46700 1.47000

Table 7 Predefined index values (MultiMode) - Not available SmartOTDR

Wavelength (nm) 850 MM 1300 MM

Corning 62.5 1.50140 1.49660

Corning 50 1.48970 1.48560

SpecTran 62.5 1.49600 1.49100

Generic 50 1.49000 1.48600

Generic 62.5 1.49000 1.48700

Generic OM1-62/125 1.49600 1.49100

Generic OM2-3-4  50/125 1.48200 1.47700

Table 6 Predefined index values (Single Mode)

Wavelength (nm) 1310 SM 1360 - 1510 SM 1550 SM 1625 - 1650 SM
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User Define your own thresholds values for one or several elements: 
Splice Loss / Connector Loss / Reflectance / Splitter Alarm / Fiber 
Length Min / Link Loss Max / ORL

Default / TIA-568 C / ISO/IEC 11801 / G.697/G.98x PON / G.697/IEEE PON

Select one of this parameter to configure the alarm thresholds with predefined values:

If results are above the thresholds, they will be highlighted in red in the table of results, 
and the icon  will appear at the top right of the screen.

If all the results lie within the thresholds (no result is in red), results are displayed in 
green in the table and the icon is .

Table 8 Alarms thresholds

Default
G.697/G.98x PON & G.697/

IEEE PON
TIA-568C & ISO/

IEC 11801

Splice Loss > 0.20 dB > 0.30 dB > 0.30 dB

Connector Loss > 0.50 dB > 0.50 dB > 0.75 dB

Slope > 1.00 dB/km - > 1.00 dB/km

Reflectance > - 35 dB > - 35 dB

ORL < 27 dB < 27 dB

Splitter Alarm

Splitter 1x2 > 5.0 dB > 4.2 dB

Splitter 1x4 > 8.0 dB > 7.8 dB 

Splitter 1x8 > 11.0 dB > 11.4 dB

Splitter 1x16 > 14.0 dB > 15.0 dB

Splitter 1x32 > 17.0 dB > 18.6 dB

Splitter 1x64 > 21.0 dB > 22.0 dB

Link Loss Max Select: No, Manual or: 

• for G.697/G.98x PON: 20 
dB (A) / 25 dB (B) / 30 dB 
(C)

• for G.697/IEEE PON: 23 dB 
(PX-10) / 26 dB (PX-20)
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Link parameters
In the Setup page, press Link softkey, or press Next if one parameter is selected in the 
current screen until the Link Setup page displays.

The information entered in the Link Description window concerns the editing and/or the 
modifications of the cable and fiber parameters. When a trace is recalled without recall 
of the configuration, the parameters of this trace will be present only in its signature.

Test Point / OLT Id / ONT Id / Distribution Id / Feeder Id

Those parameters allow to enter an identification for each element of the network (test 
point, OLT, ONT...) using the Edition menu.

Fiber Number
1 Select the parameter Fiber Number and modify the number of the fiber to be 

tested.

The fiber number can be automatically incremented/decremented at each new file save 
if it has been configured in the Change Fiber Nbr parameter (see "Change Fiber Nbr" 
page 138).

Change Fiber Nbr 
Increment the fiber number is automatically incremented at each new file-save.

Decrement the fiber number is automatically decremented at each new file-save

No the Fiber number must not automatically modified.

User defined Use Edit Number softkey to enter the increment/decrement value for 
fiber number.

Note: to decrement the number, enter the sign «-» before the number. Example: -
1.

Min: -999 / Max: 999 / Auto: 0

Technician Id

Use the arrow  to enter the name of the operator carrying out the measurement.

Comment

Use the arrow  to enter a comment, which will be displayed in the file signature, on the 
upper part of the screen.
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Launching the acquisition

1 Press START/STOP hard key to launch measurement.

The red Test indicator goes on to show that the T-BERD/MTS is in process of 
acquisition and the screen displays the trace in process of acquisition.

2 The quality of the connection is displayed for a few 
seconds (see Table 3 on page 38)

3 Then, a bar graph shows elapsed and remaining acquisition time. 

At the end of the acquisition, a beep is emitted, the trace is displayed and an 
automatic measurement is started.

If the module possesses several lasers, to perform successive acquisitions on all the 
wavelengths:

Inspect & clean all fiber connections prior connecting fiber cables into 
the ports (patch panels, OLT or ONT...).

Figure 81 Acquisition in progress

Number of 
averages calculated

Elapsed 
acquisition time

Total acquisition 
time

Elapsed time

NOTE

During acquisition, the traffic on fiber is automatically detected (see “Traffic 
detection” on page 39)
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1 In the SETUP menu, check in Laser line, that several lasers are selected or 
select All.

2 Start the acquisition by pressing the START/STOP button.

3 Once the acquisition for the first wavelength is finished, the acquisition for the 
following wavelength starts automatically.

or 

To stop manually the acquisition for current wavelength, click on Stop Wave-
length. This will allow to automatically start the measurement for the following 
wavelength.

A beep is emitted once the acquisitions on all lasers are completed.

The different traces appear in the same window and can be managed as traces in 
overlay (see “Overlay trace function” on page 63).

Results page
The trace(s) acquired or recalled from a memory is/are displayed on the Results page.

Trace View
The Trace view is displayed by default once OTDR acquisition is completed.

Figure 82 FTTH OTDR Trace
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Once trace is displayed, you can:

• Zoom on trace (see “Zoom function” on page 51).

• Set Cursor A and/or Cursor B (see “Cursors” on page 50).

• Save the traces and launch a report of results (see “Saving results for FTTH-SLM 
Assistant” on page 156)

Detailed description of an event

When clicking on one event icon in the results table, a popup window describes the 
event type and provides a diagnosis to help troubleshoot faulty optical elements (indi-
cated in red).

Press SETUP hard key to go back to FTTH Setup screen and modify the parameters 
before launching a new acquisition.

Multi-pulses traces

In case of multi pluses traces, the display is simplified to handle traces: only the “useful” 
traces and sections (cut section of traces) are displayed.

Ex: The 7 events detected in the example below are coming from 3 acquisitions, a 
combined trace is created showing only the 3 useful sections.

Figure 83 Event description

C
lic

k
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SmartLink view
1 Click on the menu key Trace/SmartLink to select SmartLink.

A screen as the following one is displayed:

Figure 84 FTTH results traces in multi-pulses
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The screen is divided into three zones:

• Zone 1: Graphical representation of the link, with icons symbolizing the different 
events detected.

• Zone 2: Link Table, which gives a summary of results for each wavelength, with 
results within/without thresholds in green/red (according to Alarm thresholds 
defined in the setup screen).

• Zone 3: Alarms table (if any)

Getting a diagnostic of an event
Diagnosis is used to provide further information about events and eventual problems, 
such as root cause possibilities of a failed optical element.

1 Select the event to be described on the graphic (underlined in yellow).

2 Click on Event Diagnostis soft key

A popup window, on the lower part of the screen, gives the information related to 
the selected event: 

– its type

– thresholds applied for this event.

– possible causes for the fail status of the selected link element

Figure 85 SmartLink function

Zone 1

Zone 2

Zone 3

If several traces are displayed in overlay, with the same wavelength, 
then the Zone 2 indicates the results for each wavelength. The graphi-
cal representation of the Zone 1 is a combination of multiple pulses 
and wavelengths acquisitions.
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Results Table
To display exclusively the results table, press the Results Table softkey.

Press again the Results Table menu key to return to SmartLink display.

Event View
«Event View» provides the possible loss and reflectance of the selected event, per 
tested wavelengths.

1 Click on Event View menu key.

An algorithm automatically identifies the elements of the link and label them

Figure 86 Event Diagnosis window

Figure 87 FTTH Smart Link: Results Table
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2 Select the event to be described on the graphic (highlight in yellow).

The corresponding event description is with a recall of alarm thresholds.

3 Click on Trace View to display the selected event in the results table and zoomed 
on trace.

Changing the type of an event
Once the Event View is displayed, the type of event can be modified:

1 Select the event to be modified (highlighted in yellow)

2 Press Event Code menu key

3 Click on the event type to be applied to the selected event:

Figure 88 SmartLink: Event View

NOTE

The event is framed in red if it is above the alarm thresholds defined in the 
setup menu.
It is framed in green if it lies within the thresholds.
It is framed in purple if no alarm has been defined for this type of event.
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4 Click on Exit to return to Event View.

5 Click back on Event View menu key to return to Summary screen

or

Click on Trace View menu key to return to trace (and table) results screen.

Splitter sub-menus

The Splitter icon is different according to the menu key pressed in the Splitter sub-
menus.

Example:

If the menu key  is pressed, the icon  is displayed

If the menu key  is pressed, the icon  is displayed.

Moreover, the icon and splitter configuration is different according to the number of 
«clicks» on one menu key.

Figure 89 Event Code

Click on one event code to 
modify the selected event

NOTE

The event modification is automatically applied on trace and in the results 
table.
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Example with the menu key :

• Click once: the icon is 

• Click twice: the icon is 

• Click three times: the icon is 

• Click four times: the icon is 

Click a fifth time to reset the event by default.

FTTH Premium software option
The FTTH-SLM Premium is a fully featured software for the characterization of any 
FTTH infrastructure.

In addition to the auto multi-pulses measurement and PON splitter detection and identi-
fication, this option allows:

• the measurement of closely spaced cascaded splitters (< 100m)

• the PON discovery mode

• the management of unbalanced or Tapered splitters

• the compatibility with E2E-SLM (FCOMP).

The Premium software option allows to set the complete cascaded network which 
includes UNBALANCED or TAPERED optical splitters. 
These elements are automatically detected and identified with their respective ratio, and 
their loss value compared to the setup thresholds.

In case of 2 closely spaced splitters, FTTH-SLM can identify a cluster of splitters, as 
dictated in the PON configuration settings, and applies the correct pass/fail criteria.

NOTE

If the splitters are in cascade mode, update to FTTH-SLM Premium (see 
“FTTH Premium software option” on page 147).
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Configuring the FTTH-SLM optimum option
For generic configuration of FTTH measurement, see “Configuring the Reflectometry 
test for FTTH network” on page 133. With Premium software option, in FTTH Acquisition 
Setup page:

1 Define the PON Config. parameter to Unbalanced in 
order to configure the unbalanced couplers.

2 In the Unbalanced Couplers parameter:

a Set the Number of unbalanced couplers per the 
plan

– Set the ratio for each unbalanced coupler

b Set the last Splitter ratio (usually 1x8 or 1x16)

c Set the test point: Last splitter or Coupler 1...9.

3 Once all acquisition parameters defined, click on Alarms to 
define the pass/fail loss thresholds for each Unbalanced 
coupler, if Alarm Threshold parameter is defined with User:

Select Unbalanced Coupler Alarm and define each coupler 
thresholds: click on left and right arrows to modify the value, 
or click on Edit Number and enter the value on the numeric 
keypad and validate.

Launching the test and displaying results
1 Once all configuration is correctly defined for FTTH measurement with PON 

network, press START/STOP button to launch the acquisition.

2 Once the acquisition is completed, the SLM results display.

Figure 90 PON Topology
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SLM Results

The unbalanced or tapered optical splitters are identified with their respective 
ratio, and their loss value compared to the Alarm thresholds defined.

In case of 2 closely spaced splitters, a cluster of splitters is identified, as 
dictated in the PON configuration settings, and applies the correct pass/fail 
criteria.

For other SLM functions, see “SmartLink view” on page 142.

Results Trace

Press Trace/Smartlink key to display the FTTH trace.

Figure 91 SLM View

Figure 92 FTTH «Premium» results trace
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For more information on trace features, see “Results display” on page 62.

Specific OTDR features with FTTH option
When the FTTH software option is installed (basic or Premium), the ExpertOTDR func-
tion allows to perform OTDR acquisitions for different networks.

1 On the Home page, select ExpertOTDR icon.

2 In the Acquisition > Network Config. parameter, define the network installed: 

– Point to Point 

– PON

– Unbalanced (only with FTTH Premium option).

In case of Point to Point configuration, the parameters are identical to the Exper-
tOTDR standard configuration.

In case of PON configuration, the Number of Splitters parameter can be 
defined: see "Number of Splitters" page 134).

In case of Unbalanced configuration, the Unbalanced Couplers parameter can 
be defined: see  step 2 on page 148.

The Acquisition and Results page are described in the OTDR chapter: see Chapter 5 on 
page 51.

FTTH Assistant
The software option FTTH assistant allows to perform FTTH acquisition with a simple 
step by step process.

Selecting the configuration file
1 On the Home page, select the FTTH icon

The configuration file selection screen displays.

2 In the selection file screen, select the configuration file to be used for the acquisi-
tion.

The file is underlined in purple.
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3 Press Load to load the selected file and display the current parameters for this 
configuration.

4 Once loaded, the configuration parameters that can be modified displays.

Modifying some parameters before the acquisition
In FTTH Assistant mode, the user have access to 5 parameters he can modified before 
launching the test.

NOTE

If necessary click on the key  to reach the upper level of directory.

Figure 93 Load file as FTTH Configuration

Location of the 
configuration 
files for FTTH
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• Laser The acquisition will be carried out on the wavelength(s) 
selected (for multiple-wavelength modules). In case of a 
multi-wavelength module, select All to perform a 
measurement for all the wavelengths available (this 
parameter visible exclusively on modules with one single 
OTDR port). The possible values depend on the module 
used.

• Number of Splitters see “Number of Splitters” on page 134.

If at least one Splitter is defined, the Splitter sub-displays and allows to define the 
type of splitter:

For Splitter 1: Discover / 1x2 / 1x4 / 1x8 / 1x16 / 1x32 / 1x64 / 2x2 / 2x4 / 2x8 / 
2x16 / 2x32

For Splitter 2 and 3: Discover / 1x2 / 1x4 / 1x8 / 1x16 / 1x32.

• Distance unit select the unit to be used for distance (km / kfeet / miles / 
meter / feet / inch).

• Launch cable Define if the Launch Cable must be taken into account for
the acquisition: No / Yes.
If Yes is selected, set the length clicking on the number
field and enter the distance using the numeric keypad, or
click on Measure to enter the length detected. Click on 
to validate (or on  to cancel) 

Figure 94 FTTH-SLM Assistant Setup page
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• Alarms Define if alarms thresholds must be applied for the acquisition:
Select No if no alarm thresholds must be applied.
Select Yes to define alarms, and press Alarm Level to define 
the pre-defined thresholds for the acquisition.

See Table 8 to get the values for each pre-defined alarm thresholds.

The thresholds can be modified only in Expert mode and saved in a new configu-
ration file.

Once all configuration parameters are correctly defined, the acquisition can be 
launched.

Press the Config key to return to configuration selection screen (see Figure 94 on 
page 152).

Performing a measurement 
1 From the Setup page, press Start Test key  to launch measurement 

(see Figure 94 on page 152).

or

From the Setup page, press Real Time key  (see Figure 94 on 
page 152).
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The red Testing indicator goes on to show that the T-BERD/MTS is in process of 
acquisition and the screen displays the trace in process of acquisition.

2 The quality of the connection is displayed for a few 
seconds (see Table 3 on page 53)

3 Then, a bar graph shows elapsed and remaining acqui-
sition time.

In «normal» mode, at the end of the acquisition, a beep is emitted, and the measure-
ments are displayed, in SLM view, with a dialog box indicating the pass or fail verdict and 
asking if results must be saved.

Real time acquisition specific features

• During an acquisition in real time, several actions can be made on results in prog-
ress: see "Actions on trace during acquisition" page 58.

• To stop or interrupt an acquisition in real time mode, press the START/STOP key at 
any time.

Figure 95 Example of acquisition in progress

NOTE

During acquisition, the traffic on fiber is automatically detected (see "Traffic 
detection" page 53)
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Results display with FTTH-SLM Assistant option
Once the acquisition is completed, the SLM view automatically displays:

For the menu keys description, refer to the chapter “SmartLink view” on page 142.

Click on Assistant to return to configuration screen (see “FTTH-SLM Assistant Setup 
page” on page 152) and modify some parameters before launching a new acquisition.

Click on Trace menu key to display the trace:

Click on Save menu key to return to Recording Information screen (see Figure 98 on 
page 156).

Figure 96 SLM View with FTTH-SLM Assistant
s

Figure 97 Trace view with FTTH-SLM Assistant
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Saving results for FTTH-SLM Assistant
Once the acquisition is completed, the results trace displays, in Smart Link view, with the 
Save menu keys displayed. 

1 Click on Save menu key  to save the results in a file.

The Recording Information page displays

2 Click on one parameter configuration (white background) to modify it using the 
edition or numeric keypad displayed:

– Fiber Id: click on the fiber name currently defined to display the edition 
keypad and enter a new fiber name.

– Fiber Number; click on the fiber number currently defined to display the 
numeric keypad and enter a new fiber number.

– ONT Id / OLT Id: click on the ONT/OLT name currently defined to display 
the edition keypad and enter a new name.

– Job Id: click on the Job description currently defined to display the edition 
keypad and enter a new description.

Figure 98 Save results in FTTH-SLM Assistant mode

NOTE

The file is saved automatically by default with the Job Id parameter.

Example: if the Job Id is defined with Test Fiber 1, the otdr filename will be 
Test Fiber 1.sor (name is indicated at the bottom of the screen).
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3 Once the recording information are defined as wished, select the saving mode 
wished:

– Click on FILE ONLY  to save exclusively the results trace to the 
.sor format

– Click on FILE + PDF  to save the results trace in a .sor file and to 

generate a pdf report of the results.

– Click on Results  to return to Smart Test result view.

Saving the trace(s) and generating a report
Once the results page is displayed, the trace(s) can be saved and a report can be gener-
ated directly from the results screen.

Saving and report can have been automatically generated if, in the file configuration, the 
Auto Store parameter has been set to Yes (see page 46) with the appropriate Save 
Mode.

Saving results and creating a report from results page
To save the trace and generate a report:

1 Press Fast Report key  -> .

A menu displays under the trace.

2 In the menu, configure the file saving mode (and the report)

CAUTION

If one of the parameters is not defined (empty), a red caution icon is dis-
played on the parameter field  and the file saving is not 
possible (keys are deactivated).

NOTE

The Save process is different for FTTH-SLM Assistant option (see “Saving 
results for FTTH-SLM Assistant” on page 156), and the report generation is 
not available with this option.
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a In the Fiber Number parameter use the left and right direction keys to 
define the fiber number by scrolling the available numbers.

b In the Save Mode parameter, select the report format to be generated:

txt file select Yes to save the results in a .sor file and to generate a txt 
file of the results.

pdf file select Yes to save the results in a .sor file and to generate a 
report in a pdf file.

json file select Yes to save the results in a .sor file and to generate a 
json file.

If all parameters are defined with No, only the .sor (or .msor) file will be saved.

c In the Cable Id parameter, enter/modify the name of the Cable using the 
edition keypad.

d In the Direction parameter, select/modify the direction, to define if the 
measurement has been performed from Origin to Extremity (A -> B) or from 
Extremity to Origin (B -> A)

e In the Location A and Location B parameters, enter/modify the name of 
Origin and Extremity.

3 Once all the parameters are configured, press Save All menu key.

4 Enter a name for the file in the edition keypad.

or

Click on Auto Filenaming menu key to apply the file name defined in the Setup 
screen, in Filenaming parameter (see page 45).

5 Press Enter to validate

Figure 99 Fast report configuration
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The icon  displays during saving process.

Once saving is completed, a sound is emitted onto the Platform.

Opening a report
1 To open the report, press FILE hardkey

2 In the Explorer page, in the directory selected, select the file/report.

The file name is: 

For the txt file: trace file_sor.txt

For the pdf file: trace file.sor.pdf

3 Press Load.

The file opens on the T-BERD/MTS.

NOTE

The sor file and the txt or pdf file will have the same name.

NOTE

The file and the report are saved in the last storage media and directory 
selected.
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Figure 100 Fast Report with FTTH-SLM option

CAUTION

To modify the VIAVI logo, set by default on the header of the pdf report, save 
your logo in a jpg file called logo.jpg and place it to the root of the disk: 
disk > logo.jpg.

NOTE

A pdf report can also be generated from the File Explorer page onto the T-
BERD/MTS (see “Generating pdf report(s)” on page 244).
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Chapter 9Cable-SLM option

This chapter describes the use of the Cable-SLM option, when the software license has 
been purchased with an OTDR module.

The topics discussed in this chapter are as follows:

• “Principle of Cable-SLM” on page 162

• “Configuring the Cable-SLM project” on page 162

• “Starting project test process” on page 165

• “Results of project cable” on page 166

• “Files and Project storage” on page 168
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Principle of Cable-SLM
The Cable-SLM option is a function used to manage a cable commissioning or a multi-
fiber test project.

The aims of this option is to:

• improve workflow in cable commissioning (P2P links even with different 
distances, for example FTTH drops)

• ensure test consistency

• reduce manipulation errors / issue

• generate a report text file

Configuring the Cable-SLM project

Configuring the project
Once the OTDR module is set into the T-BERD/MTS, and the Cable-SLM license 
installed:

1 From the Home page, select the Expert OTDR function.

The results page automatically displays.

If not, press RESULTS hard key to display results page.

2 Press SETUP hard key to display the OTDR configuration screen and:

– Configure the OTDR Acquisition parameters (see page 25)

– Configure the OTDR Alarms parameters (see page 31)

– Configure the OTDR File parameters (see page 43)

3 Press Link Cable menu key .

4 Configure the Link Description parameters (see page 38)

5 In the new window Project Information, configure the project as required:

• Use the Edition keypad to enter a name for Technician ID / Job Id / Contractor 
Id / Sub Contractor Id / Engineer Id.

• Define the Display mode of the Project: Numbering or Labelling.
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If Numbering is defined:

– On the parameter Start Fiber, press Edit Number soft key to enter the 
number of the first fiber of the cable to be tested (Min 1 / Max 100).

– On the parameter Number Of Fibers, press Edit Number soft key to enter 
the total number of fibers of the cable (Min 1 / Max 100).

If Labelling is defined:

– On the parameter Fiber Count, select the type of connector: Simplex / 
Duplex / MPO (8/12) / MPO (12/12) / MPO (20/24) / MPO (24/24)

• Press the right direction key to enter a Comment if necessary, using the edition 
keypad. 

Saving the project
Once all configuration parameters are defined, save the project:

1 Press Create Project soft key (displayed when one parameter of the Cable 
Project window is displayed).

2 In the Edition keypad opened, enter a name for the project and press Enter to 
validate.

The project file (.prj) contains Acquisition / Alarms / Link / File parameters and is 
saved in root disk or Harddisk under Project > EXPERT_OTDR > OTDR_SM or 
OTDR_MM directory.

Figure 101 Cable SLM Setup

Cable SLM configuration
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A directory is automatically generated with the project name, and it is saved under 
(hard)disk > Project > EXPERT_OTDR > OTDR_SM or OTDR_MM. Measurements 
are stored into this directory, as well as a summary text file.

Loading an existing project
To open the project just created or to load an existing project:

1 Press the Manage Project soft key on the Results screen .

2 Select the project file to be used (.prj) in Project > EXPERT_OTDR > OTDR_SM 
or OTDR_MM directory.

3 Press Open Project softkey.

A summary table of all fibers and measurements performed is displayed.

NOTE

Once a project is created, the parameters cannot be modified except the 
acquisition ones.

Figure 102 Loading a project

Recall of the 
Cable Project 
parameters
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Starting project test process

Once the project is loaded, the following screen is displayed.

1 Click on the first fiber to be tested.

The fiber number is underlined in purple (n°1 in Figure above)

2 Press START/STOP hard key to start the acquisition.

3 Once all wavelengths have been measured, a window opens, asking: 

– Click on Yes to test next fiber

– Click on No to return to project table.

Inspect & clean all fiber connections prior to connecting fiber under 
test to the OTDR port.

Figure 103 Cable view

View «List» View «Number»See page 162

If a test is launched onto a fiber already tested, a dialog box displays: 
«Test already done. Do you really want to repeat the test? 
Results files will be deleted.». 

Click on Yes to confirm the new test, and then, to delete existing file(s). 

Click on No to cancel the test.
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Trace saving
The traces are automatically stored into the project directory and according to defined 
filenaming convention.

Results of project cable
Once fibers have been tested, the project page updates on the fly:

Description of the table
An icon is displayed to indicate if the alarm thresholds have been exceeded:

•  Pass

•  Fail

•  No alarm or no test performed

Figure 104 Cable project Labelling
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Deactivate the fiber test
Before starting the test, some fibers can be deactivated so that the acquisition will not 
be performed.

1 Select the fiber number which does not need to be tested (underlined).

2 Click on the soft key Deactivate fiber test.

3 Repeat the process for the fibers which do not have to be tested.

The deactivated fibers will be skipped while moving to next fiber to test.

View Trace
1 In the project page, click on the fiber for which you want to display the corre-

sponding trace.

2 Click on View Fiber Test soft key.

The trace result page displays.

Figure 105 Fibers 4 and 6 deactivated

If a test is deactivated on a fiber already tested, a dialog box displays: 
«You’re about to delete acquisition files. Are you sure?». 

Click on Yes to confirm the deactivation, and by consequence, to delete cor-
responding trace(s). 

Click on No to cancel the deactivation.
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Click on View Cable to return to project page.

Files and Project storage
As soon as a project is saved from Setup page (see “Saving the project” on page 163), 
a folder is automatically generated with associated sub-directories.

The project and all corresponding test files are saved in the  automatically created folder 
EXPERT_OTDR.

The project file is saved in the directory EXPERT_OTDR > OTDR_SM or OTDR_MM.

Figure 106 Trace from fiber selected in project

Name of the project Number of the fiber selected

Click to return to 
project

Figure 107 Project files
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For each project, a subdirectory with the project Id is created, containing test OTDR files 
and summary results (in text format): EXPERT_OTDR > OTDR_SM or OTDR_MM > 
Project_Id.

Explorer when one project is open

If a project is open, press the FILE button to open the project in the explorer: the explorer 
displays all the link information exclusively for the project measurement results.

An icon representing the alarm status  is displayed for each measurement result (if alarm 
thresholds have been defined).

The project file is not visible in the explorer until the project is closed.

Figure 108 Project directory structure with file contents

Figure 109 Project in the Explorer
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Text file content
As soon as one acquisition is performed from the project, a summary text file (.txt) is 
associated to the OTDR test data. 

Each new test is inserted into the text file as project process evolves.

This file contains all the summary values of all tested fibers:

– Link loss

– Link distance

– Link ORL

This file uses tabulations to separate values. It is saved with the extension «.txt» and can 
be opened by the Platform.

The txt file is not available if the explorer is opened while a project is 
opened (see Figure 109 on page 169).

Figure 110 Text file
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Chapter 10Enterprise-SLM Software option

This chapter describes the use of the Enterprise-SLM option, when the software license 
has been purchased with an OTDR module.

The topics discussed in this chapter are as follows:

• “Principle of Enterprise-SLM” on page 172

• “Configuring the Enterprise-SLM” on page 172

• “Simple OTDR Testing (for single fiber)” on page 179

• “Managing projects for multi-fibers Testing” on page 179

• “Testing MPO” on page 182

• “Results of project” on page 183

• “Saving the trace(s) and generating a report” on page 187
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Principle of Enterprise-SLM
The Enterprise-SLM is designed to simplify and automate the characterization (TIER-2) 
and troubleshooting of structured cabling in Enterprise & Data Centers.

Goals of this function are to:

• characterize/certify the entire link including passive elements such as connectors, 
cassettes, splices, couplers or splitters, at the installation

• be used as a troubleshooting tool to detect faults such as breaks, bends or exces-
sive losses

• generate all-in-one PDF certification reports on site for each fiber link

Configuring the Enterprise-SLM 

Loading a SmartConfig™ 
The SmartConfig™ is defined with pre-defined test settings to be used as a base config-
uration that can be customized. 

Once the Enterprise-SLM license is installed:

1 From the Home page, select the Otdr Entreprise function .

The results page automatically displays.

2 Press SETUP hard key to display the OTDR configuration screen.

3 Press Load Config. to select a configuration file from the list:

The configuration file includes pre-defined test parameters and label schemes 
(for automatic file labels generation)

– TIA-606A Class 2 Single Building Horizontal Link = ENTERPRISE_-
Class2_Hlink

– TIA-606 Class 2 Single Building Backbone Cable = ENTERPRISE_-
Class2_BBCable

– TIA-606 Class 3 Campus Backbone Cable = ENTERPRISE_Class3_BB-
Cable

– TIA-606 Customized Hierarchical Cable Labeling Scheme = ENTER-
PRISE_Custom

– TIA Colour Coding = ENTERPRISE_Color

– Simple Cable Label (Cable Id, Fiber Id, Fiber Num) = ENTERPRISE_-
Simple
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4 Once the file selected, press Load as ENTREPRISE Config..

5 Once desired configuration file is loaded, Acquisition, Alarms, Link Cable and 
File setup menus can be configured.

Acquisition
In the first screen, configure the following parameters:

Laser
The acquisition will be carried out on the wavelength(s) selected (for multiple-wave-
length modules). In case of a multi-wavelength module, select All to perform a measure-
ment for all the wavelengths available (this parameter visible exclusively on modules 
with one single OTDR port). The possible values depend on the module used. 

Index of refraction
Choice of group refraction index of the whole fiber. 

User Define for each wavelength (1310 SM, 1360-1510 SM, 1550 SM, 
1625 SM) a refraction index of 1.30000 to 1.69999. The selection of 
an index alters the value of the section AB (actual distance between 
cursors A and B).

or,

If the actual distance between the cursors A and B is known, enter its 

Figure 111 OTDR - Enterprise SLM Configuration
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value under Section AB to establish the index of the fiber. Selection 
of this distance causes the display of the indices. The extreme 
distance values are given by the index values (1.30000 à 1.70000).

Predefined It is possible to choose one of the predefined values given for certain 
cables. See OTDR chapter, Figure 19 on page 34.

Scatter coefficient
Define the scatter coefficient of the fiber. See OTDR chapter “Scatter coefficient” on 
page 35.

Launch Cable End / Receive Cable Start
Configure the parameters Launch Cable End and Received Cable Start as explained 
in the OTDR chapter, page 28.

Distance Unit
Define the unit of the distances displayed: km, kfeet, miles, meter, feet.

Config.
This parameter displays the last configuration file loaded and cannot be modified unless 
a new configuration file is loaded.

Alarms
In the Setup page, press the Alarm menu key (if one parameter is selected in the current 
screen, press Top Menu soft key to display the right menu keys and click on Alarms).

Alarms > Threshold

Define the alarm thresholds as described in OTDR chapter, page 174.

Note that the pre-defined thresholds G.697/G.98x PON and G.697/IEEE PON are not 
available with Enterprise SLM function.

Site Info Labeling
In the Setup page, press Site Info Labeling softkey (if one parameter is selected in the 
current screen, press Top Menu soft key to display the right menu keys and click on Site 
Info Labeling).

MTS2100 4100 Module US rev015.book  Page 174  Jeudi, 14. janvier 2021  3:41 15



Chapter 10 Enterprise-SLM Software option
Configuring the Enterprise-SLM

User Manual 77000010208 Rev. 015 175

The Site Info Labelings screen allows configuring the Site Properties and the Labeling.

Site Properties
In the Site Properties box, click on the right arrow key for each parameter to define the 
Site Properties, the Technician Identification and the Job Identification.

Labeling
The Labeling box differs according to the configuration file loaded and currently used.

Label Format
This parameter displays the label format applied to the project according to the configu-
ration file selected.

Fiber Count (mandatory for project creation)
This parameter is available once the configuration file «ENTERPRISE_Custom_List.XX-
OTDR.fo_cfg» is loaded.

Select the right Fiber Count for the cables being tested:

Fiber Prefix
Press the right arrow key to enter the prefix applied to the fiber, as an identification.

• Simplex (single fiber strand) • Duplex (dual fiber strand) 

• MPO 

MPO (8/12): 8 fibers used over 12

MPO (12/12): 12 fibers used over 12

MPO (20/24): 20 fibers used over 24

MPO (24/24): 24 fibers used over 24
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Fiber Number
Use the left and right arrow keys to increment or decrement the fiber number.

Fiber Code
Once selected, press the right arrow key to modify some fields of the fiber code. The 
structure must follow TIA-606 standards.

Change Fiber Number
Increment the fiber number is automatically incremented at each new file-save.

Decrement the fiber number is automatically decremented at each new file-save.

User defined Use Edit Number softkey to enter the increment/decrement value for 
fiber number.

Note: to decrement the number, enter the sign «-» before the number. Example: -1

Min: -999 / Max: 999 / Auto: 0

No the fiber number is not automatically modified at each new file-save.

Direction
The direction shows if the acquisition must be performed from the origin to the extremity 
(A->B) or from the extremity to the origin (B->A).

Location A
The name of the Location A of the link may be entered here.

Location B
The name of the Location B of the link may be entered here.

Label Structure
The Label Structure sub-menu is different according to the configuration file selected.

• Fiber Code Displays the fiber code previously configured in the Labeling 
box (see "Fiber Code" page 176). It cannot be modified from 
the Label Structure sub-menu.

NOTE

See in OTDR Chapter, "Cable structure" page 41 for a description of the 
Cable Structure sub-menu available with «Color» configuration.

MTS2100 4100 Module US rev015.book  Page 176  Jeudi, 14. janvier 2021  3:41 15



Chapter 10 Enterprise-SLM Software option
Configuring the Enterprise-SLM

User Manual 77000010208 Rev. 015 177

• Floor Press  to open the sub-menu, different according to the 
selected configuration:

- define the Type of Label (Alphabetical / Numerical / None) and enter 
the Min and Max values and the Separator type1 (No; «.»; «:»; «-»: 
«/»; «_»).
or

- enter a floor number for Floor 1 & Floor 2.

• Telecom Room Press  to open the sub-menu, different according to the 
selected configuration:

- define the Type of Label (Alphabetical / Numerical / None) and enter 
the Min and Max values and the Separator type (No; «.»; «:»; «-»: 
«/»; «_»)1

or

- enter an identification for Telecom Room 1 and Telecom Room 2.

• Rack-X / Rack-Y Press  to open the sub-menu, define the Label Type 
(Alphabetical / Numerical / None) and enter the Min and Max 
values and the Separator type (No; «.»; «:»; «-»: «/»; «_»).

• Panel Slice Press  to open the sub-menu, define the Label Type 
(Alphabetical / Numerical / None) and enter the Min and Max 
values and the Separator type (No; «.»; «:»; «-»: «/»; «_»).

• Panel Press  to open the sub-menu, define the Label Type 

(Alphabetical / Numerical / None)2 and enter the Min and Max 

values and the Separator type (No; «.»; «:»; «-»: «/»; «_»)1.

• Port/Position Press  to open the sub-menu, define the Label Type 

(Alphabetical / Numerical / None)1 and enter the Min and Max 
values.

• Backbone Cable Press  to open the sub-menu and enter the Min and Max 
values according to the Label Type defined (not changeable).

• Cable Press  to open the sub-menu and enter the Min and Max 
values according to the Label Type defined (not changeable).

• Building Enter an identification for Building 1 and Building 2.

1. This parameter can be modified exclusively with «Custom» configuration
2. This parameter can be modified exclusively with «Custom» configuration
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File
In the Setup page, press File softkey (if one parameter is selected in the current screen, 
press Top Menu soft key to display the right menu keys and click on File).

The file configuration is identical to the OTDR file configuration menu: see, in the OTDR 
chapter, “Configuring the File parameters” on page 43.

Table 9 Parameters available according to configuration file loaded

Label Format Simple Custom Color
TIA-606 Class 2 
Single Building 
Horizontal Link 

TIA-606 Class 2 
Single Building 
Backbone Cable

TIA-606 Class 3 
Campus 
Backbone Cable

List

Fiber Count x

Fiber Prefix x x x x x x

Fiber Code Fib. Num. x x x x x x

Change Fiber 
Number

x x x x x x

Direction x x

Location A / B x x

Label Structure x1

Fiber Code x x x x

Floor x x x x

Telecom Room x x x x

Rack -X / -Y x

Panel Slice x

Panel x x

Port/Position x x

Backbone Cable x x

Cable x x

Building x

1. See in OTDR Chapter, "Cable structure" page 41

NOTE

The Default Filename, with the Enterprise SLM option, differs according to 
the configuration file selected.
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Simple OTDR Testing (for single fiber)
The OTDR Enterprise Option can be use to test single fibers, with the optimum acquisi-
tion parameters automatically applied.

1 Select the OTDR Enterprise icon (MM or SM) and validate .

2 From the results page, press SETUP button.

3 In the Setup screen, press Load configuration to load an Enterprise SmartCon-
figTM file.

4 Select the file in the explorer and press Load as ENTERPRISE Config.

5 Modify / complete the parameters wished (see “Configuring the Enterprise-SLM” 
on page 172)

6 If necessary, press Save Config. to save the new configuration in a file , and 
reuse it for other tests.

7 Press Start/Stop button to launch the acquisition for the fiber.

See Results for description of the results page.

Managing projects for multi-fibers Testing
The Enterprise OTDR option allows to generate projects in order to easily control and 
document all test results.

Some existing projects are available on the Platform, and configured automatically. A 
configuration file exist for each Fiber count (= connector type): Simplex, Duplex and 
MPO cables.

A project may also be created by the user, with configuration previously defined.

Opening an existing project
Once the OTDR Enterprise icon is validated:

1 Press RESULTS to open the result page:

2 Press Manage Project menu key .

3 In the Explorer, select the project file to be used.
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4 Press Open Project menu key.

The Project displays, with a list of labels to be tested.

5 Click on the label arrow to open the list of fibers to be tested for this label.

Creating a project from the Setup page
Once the OTDR Enterprise icon is validated, the results page automatically opens:

1 Press SETUP button to open the Setup page.

2 Load the file ENTERPRISE_Custom-list SmartConfig™

3 Modify setup menus (Acquisition, Alarms, Site Info Labels and File) if needed.

4 In the Site Info Labels menu, make sure the Fiber count parameter is defined 
according to the network configuration:

– Simplex: generate a project for one single fiber test

– Duplex: generate the project for double fiber test

– MPO: generate a project for MPO cables

See “Fiber Count (mandatory for project creation)” on page 175.

5 Once all parameters are configured, press Save Config. to save the current 
configuration in a file.

Figure 112 Select Project file

NOTE

In Simplex mode, only the label is available as it represents the single fiber.
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6 Press Import Label List top right soft key.

7 Select the csv file that includes the list of labels / Cable Ids to be tested:
Simplex: 1 label = 1 fiber
Duplex: 1 label = 2 fibers
MPO: 1 label = up to 24 fibers

8 Press Create Project menu key to generate the project.

9 The project displays, with the list of labels defined in the csv file.

Warnings on CSV file
The csv file used for labeling must include the following instructions:

– 1 label per line, starting from row 1 of the spreadsheet.

– the number of characters per label cannot exceed 120.

– avoid the use of special characters, such as: *; /; \; %; &; #...

Project display
Once the project is loaded on the Platform, it is displayed as follows:

CAUTION

If the list of labels exceeds the maximum number of labels authorized by the 
software (1000 fibers / 500 for Duplex / 83 for MPO (12) / 41 for MPO (24)), 
a warning displays: Label max numbers reached, next labels 
are ignored. Hit any key to continue.

Figure 113 Example of Project
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The icon  displays on the upper banner, indicating a project is opened.

Click on the label to open the sub-menu where the fiber numbers are displayed.

Note; This sub menu cannot be opened for Simplex mode as 1 label corresponds 
to 1 fiber.

Disable a test

Before starting the test, some fibers can be disabled so that the acquisition will not be 
performed. on those

1 Select the fiber number which does not need to be tested (underlined).

2 Click on the soft key Disable fiber test.

3 Repeat the process for the fibers which do not have to be tested.

The disable fibers will be skipped while moving to the next fiber test.

To activate the fiber, select it and press Enable Fiber Test.

Testing MPO
Once the project is opened, the OTDR acquisitions can be launched.

1 Connect the Switch to the Platform, via a USB cable.

Figure 114 Fibers 4 and 6 deactivated

If Disable Fiber Test is pressed while a tested fiber is selected, a dialog 
box displays: «You’re about to delete acquisition files. Are you 
sure?». 

Click on Yes to confirm the deactivation, and by consequence, to delete cor-
responding trace(s). 

Click on No to cancel the deactivation.
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2 Activate the USB Switch icon on the Platform 

3 On the Project page, select the label or fiber to be tested.

If a label is selected (highlighted in blue), all the active fibers of this label will be 
tested one after the other.

If one fiber number is selected (in blue), the test will be performed exclusively for 
this fiber.

4 Press START/STOP button to launch the test.

The fiber number being tested in displayed on the Switch.

5 Once a test is completed, a dialog box is displayed to test for next label/fiber.

6 Press Yes to launch a new acquisition or No to stop the acquisition and return to 
project screen.

Stopping the test
The test stops automatically once the label/fiber test is completed; or the user can press 
the Start/Stop button at any time to stop the test in progress.

In this case, the icon  is displayed on the label row to indicate that not all of the fibers 
have been tested.

Trace saving
The traces are automatically stored into the project directory and according to defined 
filenaming convention.

Results of project
After each fiber/label tested, the project page is updated, on the fly.
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Description of the table
The status for each label is indicated on the right of the label row:

Pass

Fail

The number of fiber is highlighted in different color according to the alarm status:

View Trace
1 In the project page, click on the fiber number for which you want to display the 

corresponding OTDR trace (e.g. ).

2 Click on View Trace(s) soft key.

The trace result page displays.

Figure 115 Enterprise OTDR - Project

  Pass    No Alarm defined

   Fail   No test performed on the fiber
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Once the traces are displayed, one can:

• Zoom on trace (see “Zoom function” on page 72).

• Set Cursor A and/or Cursor B (see “Cursors” on page 70).

• Save the traces and create a report (see “Saving the trace(s) and generating a 
report” on page 187).

• Analyze and visualize the different events (see “Results table” on page 68).

Detailed description of an event

When clicking on one event icon in the results table, a popup window describes the 
event type and provides a diagnosis to help troubleshoot faulty optical elements (indi-
cated in red).

Figure 116 Trace from fiber selected in project

Name of the label Number of the fiber tested

Click to return to 
project
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SmartLink view
1 Click on the menu key Trace/SmartLink to select SmartLink.

A screen as the following one is displayed:

The screen is divided into three zones:

• Zone 1: Graphical representation of the link, with icons symbolizing the different 
events detected.

• Zone 2: Link Table, which gives a summary of results for each wavelength, with 
results within/without thresholds in green/red (according to Alarm thresholds 
defined in the setup screen).

• Zone 3: Alarms table (if any)

See “Smart Link view” on page 62 to get a description of the SmartLink view.

Figure 117 Event description

C
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k

Figure 118 SmartLink function

Zone 1

Zone 2

Zone 3
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Saving the trace(s) and generating a report
Once the results page is displayed, the trace(s) can be saved and a report can be gener-
ated directly from the results screen.
Storing and reporting could have been automatically generated if, in the file configura-
tion, the Auto Store parameter was set to Yes (see page 46) with the appropriate Save 
Mode.

To save the trace(s) and generate a report:

1 Press Fast Report key  -> .

A short menu displays below the trace.

2 In the menu, configure the file saving mode (and the report)

a In the Save Mode parameter, select:

txt file select Yes to save the results in a .sor file and to generate a txt 
file of the results.

pdf file select Yes to save the results in a .sor file and to generate a 
report in a pdf file.

json file select Yes to save the results in a .sor file and to generate a 
json file.

If all parameters are defined with No, only the .sor (or .msor) file will be saved.

a In the Fiber Code/Number parameter use the left and right direction keys 
to modify this field.

1 Once all the parameters are configured, press Save All menu key.

2 Enter a name for the file in the edition keypad.

Figure 119 Fast report configuration

MTS2100 4100 Module US rev015.book  Page 187  Jeudi, 14. janvier 2021  3:41 15



Chapter 10 Enterprise-SLM Software option
Saving the trace(s) and generating a report

188 User Manual 77000010208 Rev. 015

or

Click on Auto Filenaming menu key to apply the file name defined in the Setup 
screen, in Filenaming parameter (see page 45).

3 Press Enter to validate

The icon  displays during saving process.

Once saving is completed, a sound is emitted onto the Platform.

NOTE

The sor file and the txt or pdf file will have the same name.

NOTE

The file and report are saved in the last storage media and directory selected

Figure 120 Fast Report with Enterprise OTDR option
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CAUTION

To modify the VIAVI logo, set by default on the header of the pdf report, save 
your logo in a jpg file called logo.jpg and place it to the root of the disk: 
disk > logo.jpg.

NOTE

A pdf report can also be generated from the File Explorer page onto the T-
BERD/MTS (see “Generating pdf report(s)” on page 244).
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Chapter 11FiberComplete Modules

This chapter describes the functions of the FiberCompleteTM modules (Combined 
OTDR or Fault Finder and auto bidirectional IL/ORL and Distance) and their use.

The topics discussed in this chapter are as follows:

• "General introduction" page 192

• "Activating the function" page 195

• "Establishing References" page 195

• "Configuring the units" page 200

• "Performing the tests" page 207

• "Results screen" page 210

• "Saving results and generating a report" page 213

• "File management" page 216

This function is not available with SmartOTDR.
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General introduction

Principle
FiberComplete is used to perform automatically and through a single connection port, 
the following tests:

• Bidirectional insertion loss (IL)

• Bidirectional optical return loss (ORL) using the continuous wave method 
(OCWR) 

• Distance/length measurements

• Unidirectional / Bidirectional OTDR or fault analysis

To carry out the measurements, 2x T-BERD/MTS are needed, both equipped with Fiber-
Complete capable modules (see references in Chapter 15) and broadband power 
meters on the mainframes. 

Using one unit at each end of the fiber under test and without any connection/disconnec-
tion, IL/ORL and distance measurements are performed and results exchanged via the 
fiber under test (FUT). 

If the OTDR is selected, an OTDR measurement is launched automatically:

• Unidirectional mode: the OTDR acquisition is performed from the primary unit 
where the test has be initiated. Traces are saved locally

• Bidirectional mode: the OTDR acquisition is initiated successively from each 
unit. The traces are saved locally.

A failed value of IL or ORL may trigger the Fault Finder function automatically in order 
to identify the faulty event.
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Configurations
Two configurations are available, depending on the tests that have to be performed:

• Construction/Installation tests with loss, optical return loss, distance and OTDR.

• Acceptance Tests with loss, optical return loss and distance, and faults detection 
in case of problem.

Construction/Installation Test

In this configuration, bidirectional IL and ORL, length and/or unidirectional/bidirectional 
OTDR measurements are performed. The bidirectional IL/ORL and length results are 
stored on each unit, the OTDR traces are stored on the locally unit (where the test has 
been initiated).

Figure 121 Configuration for FiberComplete function

Local

Remote
IL / ORL / Distance / 
OTDR

Acquire
Measure Bidir IL 
& ORL and OTDR

Analyze
Locate failures 
with Fault Finder

Report
Save all the results 
automatically

NOTE

The FiberComplete function can be performed with one T-BERD/MTS-2000 
and one T-BERD/MTS-4000 V2.
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Acceptance Tests

In this configuration, the bidirectional IL, ORL and length measurements are performed 
and results are automatically stored on each unit.

If the Fault Finder function has been selected in the Setup menu, and if at least one 
result exceeds the defined thresholds, the predominant defects causing the failure are 
identified and located.

The FiberComplete screen displays an easy to interpret result table that prompts 
predominant issues for easy troubleshooting.

Figure 122 Construction/Installation Test

Do an OTDR measurement and store it on the units

Next 
Fiber

Measure ORL A & ORL B, and store/display on both units

Measure Loss A->B, B->A, and Avg and store/display on both units

Press START/STOP button to launch the measurements

Setup Units A & B (Measurement and File parameters)

Reference Source and power meter on Units A & B

If a Bidirectional OTDR measurement is performed, the OTDR results 
are automatically saved on each unit;

• The OTDR results trace for acquisition performed from Location A to 
Location B is stored on the primary unit (Location A)

• The OTDR results trace for acquisition performed from Location B to 
Location A is stored on the secondary unit (Location B)
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Activating the function
1 Press the HOME button.

2 Select the icon FCOMP.

The icon turns yellow and Fiber Complete is displayed .

3 Validate the icon  if the Fault Finder option must be used and is available 
on the module.

Establishing References
To get a meaningful measurement, the two leads or patch cords used for the measure-
ment have to be referenced. The references are valid for all fibers that will be tested 

Figure 123 Acceptance Test

Pass

Next 
Fiber

Measure ORL A & ORL B, and store/display on both units

Measure Loss A->B, B->A, and Avg and store/display on both units

Press START/STOP button to launch the measurements

Setup Units A & B (Measurement and File parameters)

Reference Source and power meter on Units A & B

Compare results with defined thresholds

Fail

Fault finder
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during the day with the same patch cords. If, at anytime, the patchcords are discon-
nected from the test instruments and/or have been contaminated by dirt or dust, the 
patchcords have to be re-inspected and referencing stage has to be redone.

Reference methods for insertion loss and ORL testing

Reference stage process
The Power Meter option is mandatory onto the Mainframe.

Table 10 Reference methods for Insertion Loss and ORL Testing

IL Loopback 
Reference Method

IL Side-by-side 
Reference method

Zero ORL reference 
method

Setup 
requirement

No specific require-
ment

Units shall be at the same 
location for references

No specific require-
ment

Description

Each unit is perform-
ing its own IL refer-
ence, with its source 
from the module port 
and powermeter from 
the base-unit, this with 
one dedicated jumper.

Each unit is performing its 
own IL reference, and 
units are connected using 
two jumpers and a bulk-
head adapter.

Each unit is perform-
ing its own ORL refer-
ence, with its source / 
powermeter from the 
module, this with one 
dedicated jumper

Recommendat
ions

Easiest process.
Not recommended for 
short links.
One the reference is 
performed, do not dis-
connect jumper from 
the source

Most accurate setup, but 
both units must be at the 
same location for refer-
ences.
Once the reference is 
performed, do not discon-
nect jumper from units 
ports.

Easy process.
Once the reference is 
performed, do not dis-
connect jumper from 
the source.
Use of non reflective 
terminator is manda-
tory for bend insensi-
tive jumper.

Loss principle

Link ORL, including 
link connectors.

Link IL including one link 
connector

Link ORL measure-
ment after jumper, for 
optimized testing. 
Requires mandrel 
wrap or non reflective 
termination at link 
end.

Adapter Adapter

Link under test

Adapter Adapter

Link under test
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Each test equipment must set its own references and conform to the following process:

1 Press RESULTS button

2 Press References > Take Refs keys and follow the step by step instructions to 
perform references on each unit.

3 Choose between side by side or loopback for you loss referencing method

Loopback Referencing method
The loopback referencing is used when the two units are at different location.

After clicking on Loopback, the wizard will guide you through two steps:

1 The self reference is used for loss and ORL testing. Connect the jumper from the 
module port to the mainframe powermeter and press Ok to start referencing.

Figure 124 Select the reference to be performed

Figure 125 Self reference

Power meter of the 
2000 platform

OTDR Module port
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The reference values are stored and displayed at the end

1 The zero ORL reference is necessary for ORL testing. Once the self reference 
measurement has been carried out, the Zero ORL adjustment can be performed

Connect the jumper from the module port to the non-reflective termination via a 
mating sleeve. If you don't have a non-reflective termination, a mandrel can be 
used. Press Ok to start referencing.

Side-by-Side referencing method
The side-by-side referencing is used when the two units are at the same location and is 
the preferred method for better loss measurement accuracy.

After clicking on Side/Side, the wizard will guide you through three steps:

1 The side-by-side reference is used for ORL testing. Connect the jumper from the 
module port to the mainframe powermeter and press Ok to start referencing.

Figure 126 Zero ORL reference

Non-reflective termination 
(or mandrel)

OTDR port

NOTE

Non-reflective terminations are mandatory when bend insensitive jumpers 
are used.

MTS2100 4100 Module US rev015.book  Page 198  Jeudi, 14. janvier 2021  3:41 15



Chapter 11 FiberComplete Modules
Establishing References

User Manual 77000010208 Rev. 015 199

2 The zero ORL reference is necessary for ORL testing. Once the self reference 
measurement has been carried out, the Zero ORL adjustment can be performed

Connect the jumper from the module port to the non-reflective termination via a 
mating sleeve. If you don't have a non-reflective termination a mandrel can be 
used. Press Ok to start referencing.

3 For the loss reference, connect the jumper from the module port of the primary 
unit, toward the module port of the secondary one via a mating sleeve. Press Ok 
to start referencing.

Factory References
In the Take Refs sub-menu, the softkey Factory Refs is available. 

It allows to apply the reference values defined by default in factory.

The following figure show the values defined by default in factory:

NOTE

The side-by-side loss reference is bidirectional and performed automatically 
on both units.

Figure 127 Loss Reference

Mating sleeve

Jumper
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Configuring the units
Once references have been taken on both Units, the acquisition parameters must be 
configured.

1 Press SETUP button to display the Setup menu of the FiberComplete function.

Figure 128 Factory References

The Laser selection and Analysis parameters must be configured on 
both units. Other acquisition setups shall be set on the primary unit.
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Acquisition parameters
• Laser select the desired wavelength(s).

All: acquisition is performed for all wavelengths available in the 
instruments.

• OTDR Measurement select the measurement method for OTDR.

None.: OTDR measurement is not performed after 
FiberComplete test.

Unidir.: OTDR measurement is performed in one way: 
from the primary unit toward the secondary one.

Figure 129 FiberComplete Setup

See “Configuring the 
Link parameters” on 
page 38See “Configuring the 

File parameters” on 
page 43

NOTE

It is possible to select individual wavelength per unit. For example, one can 
make 1490/1550 nm test from one end, and 1310 nm from the other end.

The following acquisition parameters are only taken into account if the 
test is performed from this unit. If not, those parameters are not taken 
into account.
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Bidir.: OTDR measurement is performed with parame-
ters defined in automatic mode in the two ways: from 
primary to seconday unit, and from secondary to primary 
unit.

• OTDR Acquisition if OTDR measurement is configured with Unidir or Bidir 
parameter, select the acquisition mode for OTDR.

Auto.: OTDR acquisition is performed with parameters 
defined in automatic mode.

ExpertOTDR; OTDR measurement is performed with 
the parameters defined in the OTDR Setup menu (see 
"Configuring the test in Expert OTDR" page 25).

• Loss measurement select the loss measurement mode.

Unidir.: loss is measured in one direction only

Bidir.: loss is measured in both direction

None: loss is not measured.

• ORL measurement select the ORL measurement mode.

Unidir.: ORL is measured in one direction only

Bidir.: ORL is measured in both direction

None: ORL is not measured.

• Length Measurement select if the fiber length must be measured during the 
test.

Yes: the fiber length will be measured.

No: the fiber length will not be measured during the test.

• Fault Finder select if Fault Finder function must be activated.

Yes: if a result for Loss and/or ORL exceeds one limit value defined in the 
Thresholds parameters (see “Alarms parameters” on page 203), the Fault 

NOTE

Those two OTDR parameters are not available when only the Fault Finder 
function is available in the module.

A measurement will be performed only if at least Loss or ORL parame-
ter is selected.
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Finder function is automatically triggered in order to identify the faulty 
events.

No: the Fault finder function is not activated (no fault finding occurs, even if 
one value exceeds the thresholds).

Alarms parameters
In the Setup page, press Alarms softkey (if one parameter is selected in the current 
screen, press Top Menu soft key to display the right menu keys and click on Alarms).

• Thresholds select the user defined thresholds to be used: User 1 / User 2 / 
User 3 / User 4 and enter limits for:

- Loss: enter a loss threshold for each wavelength (dB) 

- ORL: enter an ORL threshold for each wavelength (dB)

Or select the Default parameter to define thresholds by default for Loss and 
ORL values:

- Loss: > 40 dB for each wavelength 

- ORL: < 27 dB for each wavelength

Select None if alarm thresholds must not be defined

Analysis parameters
In the Setup page, press Analysis softkey (if one parameter is selected in the current 
screen, press Top Menu soft key to display the right menu keys and click on Analysis).

Unit
Select the unit for the distance measurement: km / kfeet / miles / meter / feet.

If «Fault Finder» parameter is set to Yes, the «OTDR» parameter is 
automatically set to No, and vice-versa.

The following parameters, defined on master unit, are automatically 
applied/transferred to the slave unit: Laser - IL/ORL Bidir. - OTDR 
Acquisition Auto (if OTDR Acquisition is defined on Manual, both units 
will performed a manual measurement, but according to their own configura-
tion in the OTDR tab: the parameters can then be different).
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Table View
Allows to choose the kind of table to be displayed at the end of acquisition.

• Fiber displays detailed results for one fiber: Loss B -> A and loss A -
> B at each wavelength; the average loss at each wavelength 
and the ORL A and ORL B at each wavelength. See "Fiber 
View" page 211.

• Cable displays cable result of multiple fibers: the average loss and 
the ORL A and ORL B at each wavelength. See "Cable view" 
page 210.

File parameters
The File storage parameters must be also configured, in order to define how the results 
traces will be saved onto the MTS/T-BERD.Result storage.

All the parameters of the File screen are described in the OTDR configuration chapter: 
see “Configuring the File parameters” on page 43.

Only the Filenaming parameter, defined with default filename, is different for FiberCom-
plete configuration.

Filenaming
Select Filenaming parameter and press the right arrow key to modify the name of the 
file for the result trace.

In the edition keypad, select the pre-defined parameters available or, press abc 
key to enter a name manually for the directory. Then, press Enter to validate.

NOTE

If Fiber View is selected, and if results are stored, then the filenaming con-
vention is; [fiber Id][fiber Num]. Therefore, the unit will generate one IL / OLR 
/ Distance file per fiber.

NOTE

If Cable View is selected, and if results are stored, then the filenaming con-
vention is; [cable ID]. Therefore, the unit will generate one IL / OLR / dis-
tance file per complete cable.
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See Figure 24 on page 45.

or

Press Default Filename to apply the name by default to the file.

Default Filename for FCOMP results
Filenaming convention in Fiber View

In Fiber View, the filenaming convention is as follows:

[Fiber_Id][Fiber_Num]

Filenaming convention in Cable View

In Cable View, the filenaming convention is as follows:

[Cable_Id]

As soon as the Cable Id changes, the result table is cleared and the next tests are stored 
with the new Cable Id name.

The table view can be modified in the Setup page (see Figure 121 on page 193).

Filenaming convention for Fault Finder results

If the fault finder is selected, the fault finderresult is using the following filenaming 
convention:

Fiber View: [Cable_Id]

Cable View: [Fiber_Id][Fiber_Num]

The name of the file is displayed in grey under Filenaming parameter

Automatic configuration
Press the key Auto Setup to configure automatically the acquisition parameters as 
follows:

• Lasers: All

• Loss Measurement: Bidir.

• ORL Measurement: Bidir.

• Distance: Yes

• OTDR Measurement: None

• Fault Finder: No

• Table View: Fiber
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• Threshold: Default

Saving the parameters from FiberComplete 
configuration

Once the OTDR and FCOMP File and Measurement parameters are configured, it can 
be saved in a configuration file.

This configuration file can then be recalled for future acquisition in FiberComplete mode.

To save parameters in a configuration file:

1 In the Setup page, select one parameter & press menu key .

An edition keypad displays

2 Enter a name for the configuration file.

3 Press Enter to validate

The configuration file is saved with the extension «fo_cfg» (icon ).

Figure 130 Save Configuration file - Edition keypad

Directory into which 
file will be saved

NOTE

Configuration file is saved by default in the directory disk / config / FCOMP.
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Loading a configuration file FiberComplete 
FiberComplete configuration file includes OTDR and FCOMP setup and file parameters.

To load a configuration file previously created and apply parameters to new tests:

1 Press FILE hard key

2 Select the configuration file in the wished directory.

3 Press Load > Load Config.

• Press SETUP hard key to display the OTDR and FCOMP acquisition parameters 
saved in the configuration file.

You can modify some acquisition or file storage parameters, and save them in a new 
configuration file (see “Saving the parameters from FiberComplete configuration” on 
page 206).

Performing the tests
Once Setup is configured on both units, they can be linked to the fiber to be tested.

1 Press RESULTS hard key to display the results page for FiberComplete function

Automatic pairing / continuity check

As soon as the secondary (B) unit is connected to the fiber, the primary (A) unit detects 
it (and vice-versa).

NOTE

The FiberComplete configuration file includes data storage and measurement 
settings of FCOMP and SM_OTDR. This configuration file can be shared and 
reused with other units.

NOTE

Some configuration files are available in the Platform: press FILE and select 
disk > config > FCOMP.
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Sending a message to the distant Platform
Once both Platforms are paired via the fiber to be tested, each one can send a message 
to the other Platform.

This message can be sent to launch a test, to wait before launching the test, to clean the 
connectors...

To send a message to the distant Platform:

1 Go to the Results page.

2 Press Send Message softkey.

A new screen displays.

3 Select the message to send.

4 Press the Send Message softkey.

One unit is disconnected of the fiber link, or 
there is a break Both unit are connected to the same fiber

Figure 131 Messages list

NOTE

If the message "Go to Fiber Nb" is selected, use left and right direction keys 
to decrement/increment the fiber number.
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The message displays automatically on distant Platform.

Starting the test
Below are described the steps when bidirectional IL/ORL and distance are selected in 
the Setup menu.

1 Press START/STOP button to launch the test

a Unit A and B are performing IL test and mutually exchange their result 
values

b Unit A and B are performing ORL test (using OCWR method) and mutually 
exchange their result values.

c Distance measurement is performed and recorded on both units.

Figure 132 Receipt of the message on the distant Platform

Figure 133 Test in progress
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d Once all tests are performed, results are displayed on both units

e If OTDR parameter is set to Auto or Manual in the Setup menu, the OTDR 
acquisition starts.

If Fault Finder parameter is set to Yes and an IL or ORL value reaches one 
of the user defined thresholds, the Fault Finder starts.

See “Configuring the units” on page 200.

Results screen
Once the tests are completed, the results screen displays on both units.

Cable view
If, in the Setup page, the parameter Table View is set to Cable, the following result table 
is displayed:

The Cable View allows to display results of multiple fibers:

– the average loss at each wavelength

– the ORL A and ORL B at each wavelength

– the distance is displayed on top of the screen

Figure 134 Result Cable View
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Fiber View
If, in the Setup page, the parameter Table View is set to Fiber, a screen as the following 
one displays:

The Fiber View allows to display results of one fiber:

– Loss B -> A and loss A -> B at each wavelength

– the average loss at each wavelength

– the ORL A and ORL B at each wavelength

– the distance is displayed on top of the screen

Fault Finder
If, in the Setup page, the Fault Finder parameter is set to Yes, a Fault analysis is auto-
matically launched, if one value exceeds the thresholds defined in the Setup menu.

As soon as the Fault Finder finishes its analysis, an easy to interpret table displays. It 
indicates the attenuation values and/or reflectance of the predominant defects that may 
have caused the IL / ORL values to fail.

NOTE

In order to erase the results table, the Cable ID must be modified in the File 
Setup menu (see “Description of the explorer” on page 236).

Figure 135 Result Fiber View
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1 Select Table IL/ORL - Fault to switch between the IL/ORL and Fault Finder 
result.

OTDR
If the OTDR parameter has been set to Manual or Auto, the OTDR acquisition is 
launched and the trace(s) can be seen by selected the OTDR tab at the bottom of the 
screen.

Figure 136 Fault finder result screen

Figure 137 OTDR trace
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Saving results and generating a report
Once the results page is displayed, the results can be saved and a report can be gener-
ated directly from the results screen.

Saving and report can have been automatically generated if, in the file configuration, the 
Auto Store parameter has been set to Yes (see page 46) with the appropriate Save 
Mode.

Saving results and creating a report from results page
To generate a report:

1 Press Fast Report soft key  -> .

A menu displays under the trace.

2 In the menu, configure the file saving mode (and the report)

NOTE

In Unidir/Bidir modes, the wavelengths selected for IL/ORL are also used 
for OTDR testing.

In Manual mode, all the OTDR parameters can be adjusted in the OTDR 
setup menu.

NOTE

To go from one tab to the other one, press the RESULTS button or, with touch-
screen, directly select the tab wished.

NOTE

In bidirectional mode:

- The OTDR results trace for acquisition performed from Location A to Loca-
tion B is stored on the primary unit (Location A)

- The OTDR results trace for acquisition performed from Location B to Loca-
tion A is stored on the secondary unit (Location B).
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a Modify the Fiber Number / Fiber Code using the key .

The parameter is different according to the Cable Structure configuration 
(see “Cable structure” on page 41). 

Or

If the Fiber number parameter is displayed, click on the current number to 
open the numeric keypad and enter a new number. Press Enter to validate.

b In the Save Mode parameter, select:

txt file select Yes to save the results in a .sor file and to generate a txt 
file of the results.

pdf file select Yes to save the results in a .sor file and to generate a 
report in a pdf file.

json file select Yes to save the results in a .sor file and to generate a 
json file.

If all parameters are defined with No, only the .sor (or .msor) file will be saved.

c In the Cable Id parameter, enter/modify the name of the Cable using the 

edition keypad.

d In the Direction parameter, select/modify the direction, to define if the 
measurement has been performed from Origin to Extremity (A -> B) or from 
Extremity to Origin (B -> A)

Figure 138 Fast report configuration

NOTE

The report layout is defined in the parameter name: Save Mode (Std) if the 
Report Layout parameter is defined to Standard in the File Setup screen, 
or Save Mode (Combo) if the Report Layout parameter is defined to Con-
solidated in the File Setup screen 

See "Report Layout" page 46.
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e In the Location A and Location B parameters, enter/modify the name of 
Origin and Extremity.

3 Once saving is configured as wished, press Save All menu key 

4 Enter a name for the file in the edition keypad

or

Press Auto Filenaming to apply the file name defined in the Setup screen, in 
Filenaming parameter (see “Filenaming” on page 204)

5 Press Enter to validate

The icon  displays during saving process.

Once saving is completed, a sound is emitted onto the Platform.

Opening a report
1 To open the report, press FILE hardkey

2 In the Explorer page, in the directory selected, select the file of the report.

For the txt file: trace file_sor.txt

For the pdf file: trace file.sor.pdf.

3 Press Load.

The file opens on the T-BERD/MTS.

NOTE

The blts file and the txt or pdf file will have the same name.

NOTE

The file and the report are saved in the last storage media and directory 
selected.
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File management

Storing results 
Although each measurement is automatically stored, it is possible to save the results 
under a different file name, directory etc.

Once the results are displayed: 

1 Press the FILE button 

2 Select Setup with the key Setup/Explorer 

3 Modify the parameter you want in the File configuration menu

Figure 139 Example of PDF report

CAUTION

To modify the VIAVI logo, set by default on the header of the pdf report, save 
your logo in a jpg file called logo.jpg and place it to the root of the disk: 
disk > logo.jpg.

NOTE

A pdf report can also be generated from the File Explorer page onto the T-
BERD/MTS or SmartOTDR (see “Generating pdf report(s)” on page 244).
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Filenaming convention
The filenaming convention is automatically generated by the unit.

Filenaming convention in Fiber View

In Fiber View, the filenaming convention is as follows:

[Fiber_Id][Fiber_Num]

One blts file is created per each individual fiber tested. The Fiber Number is automati-
cally incremented.

Filenaming convention in Cable View

In Cable View, the filenaming convention is as follows:

[Cable_Id]

The cable results, which includes all fibers, are stored in a .blts file.

As soon as the Cable Id changes, the result table is cleared and the next tests are stored 
with the new Cable Id name.
The table view can be modified in the Setup page (see Figure 129 on page 201).

Filenaming convention for OTDR results

If the OTDR is set to Auto, the sor traces have the following filenaming convention:

[Cable_Id][Fiber_Id][Fiber_Num]

A pre formatted .txt file can also be generated automatically at each measurement. It 
includes the Fault Finder table.

Please refer to Chapter 13 “File management” for more information on storage/recall 
functions.
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Chapter 12TestPro Software option

This chapter describes the use of the TestPro software option, when the software license 
has been purchased with an OTDR module.

The topics discussed in this chapter are as follows:

• "General introduction" page 220

• "Configuring the TestPro Test" page 221

• "Performing the tests" page 226

• "Results screen" page 227

• "Saving results and generating a report" page 230
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General introduction

Principle
The TestPro Software license allows to perform an OTDR Unidirectional or Bi-direc-
tionnal measurement on 2 fibers, at the same time, using a single test device.

To perform a loopback measurement using the license, you need only:

• Launch cable

• Loopback cable

• Receive cable

• Validation of the continuity using a VFL or the real-time OTDR 

Unidirectional measurement using loopback method

For unidirectional measurement, the technician must launch a test from the Launch 
cable.

Bidirectional measurement using loopback method

To perform the bidirectional, the technician must connect launch fiber to the MTS/T-
BERD, set the feeder cable, then the Loopback cable and the receive cable.

Figure 140 Unidirectionnal measurement using TestPro solution
Launch Cable

Receive Cable

Loopback 
Cable
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1 Once installation and configuration are performed, press START/STOP to launch 
the first test.

2 Once completed, disconnect the Launch fiber from the MTS/T-BERD and connect 
the receive cable, which will then become the launch fiber.

3 Press START/STOP to launch the test on the other side.

Configuring the TestPro Test
Once the license is installed onto the T-BERD/MTS (see Base Unit User Manual), the 

icon  displays on the Home page:

1 Validate the icon  on the Home page.

2 Press SETUP to display the configuration screen.

Figure 141 Bidirectionnal measurement using TestPro solution

MTS2100 4100 Module US rev015.book  Page 221  Jeudi, 14. janvier 2021  3:41 15



Chapter 12 TestPro Software option
Configuring the TestPro Test

222 User Manual 77000010208 Rev. 015

Acquisition parameters
You can choose the OTDR acquisition parameters. 

1 Once the Setup page is displayed, press Acquisition menu key to configure the 
Acquisition parameters.

Laser
The acquisition will be carried out on the wavelength(s) selected (for multiple-wave-
length modules). In case of a multi-wavelength module, select All to perform a measure-
ment for all the wavelengths available (this parameter visible exclusively on modules 
with one single OTDR port). The possible values depend on the module used. 

OTDR Measurement
Select the otdr measurement type to be perform: Unidirectional (see Figure 140 on 
page 220) or Bidirectional (see Figure 141 on page 221).

OTDR Acquisition
Select the type of acquisition to be performed:

Auto The acquisition is automatically performed using the best pulse, range
and resolution.

Expert OTDR The acquisition is performed according the parameters configuration for
in Expert OTDR mode (see “Configuring the Acquisition parameters” on
page 25).

Figure 142 TestPro configuration

See “Configuring the 
File parameters” on 
page 43

See “Configuring the 
Link parameters” on 
page 38
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Launch Cable End / Receive Cable Start
No All the results are displayed and referenced on the basis of the board 

of the module.

Evt 1, 2, 3 The results relating to the launch cable are eliminated from the table. 
Attenuation and distances are then measured on the basis of the 
marker Evt 1, 2 or 3 selected.

Length Use the Edit Number key to enter a length (Min= 0 / Max=50 km / 
164.042 kfeet / 31.075 miles) or affect the active cursor value, using 
the Set Cursor Distance key.

Link parameters
Only different or extra parameters than the otdr link parameters are described (see 
“Configuring the Link parameters” on page 38)

1st Fiber / 2nd Fiber
Click on 1st fiber or 2nd Fiber and in the sub-menu 

Fiber Id Select the Fiber Id and modify if necessary 
the fiber name.

Fiber Number Select the Fiber number parameter and 
click on left or right arrow to modify the Number

Figure 143 Launch Cable / Receive Cable

OTDR 

Launch Cable Receive Cable
Fiber Under Test

Launch 
Cable end

Receive Cable 
start

Distance of the 
launch cable

Distance of the 
receive cable
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Change Fiber Nbr Select Change Fiber Nbr and select 

Increment the fiber number is automatically incremented at each new 
file-save.

Decrement the fiber number is automatically decremented at each 
new file-save

User defined Use Edit Number softkey to enter the increment/decre-
ment value for fiber number.

Note: to decrement the number, enter the sign «-» before the number. Example: -1.

Min: -999 / Max: 999 / Auto: 0

No the Fiber number must not automatically modified.

Cable Id Select the Cable Id parameter and click on the right arrow to 
display the edition keypad and enter/modify the cable identifier.

Saving the parameters from configuration
Once the File and Measurement parameters are configured, it can be saved in a config-
uration file.

This configuration file can then be recalled for future acquisition in TestPro mode.

To save parameters in a configuration file:

1 In the Setup page, select one parameter & press menu key .

An edition keypad displays

2 Enter a name for the configuration file.

NOTE

The configuration from TestPro Setup page can be saved exclusively if the 
ExpertOTDR function is selected at the same time on the Home page.
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3 Press Enter to validate

The configuration file is saved with the extension «fo_cfg» (icon ).

Loading a configuration file 
The TestPro configuration file includes OTDR and TestPro setup and file parameters.

To load a configuration file previously created and apply parameters to new tests:

1 Press FILE hard key

2 Select the configuration file in the wished directory.

3 Press Load > Load Config.

• Press SETUP hard key to display the OTDR and TestPro acquisition parameters 
saved in the configuration file.

You can modify some acquisition or file storage parameters, and save them in a new 
configuration file (see “Saving the parameters from configuration” on page 224).

Figure 144 Save Configuration file - Edition keypad

Directory into which 
file will be saved

NOTE

Configuration file is saved by default in the directory disk / config / FCOMP.

NOTE

The configuration file includes data storage and measurement settings of 
TESTPRO and SM_OTDR. This configuration file can be shared and reused 
with other units.
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Performing the tests
Below are described the steps when bidirectional OTDR measurement has been 
selected and inspection of the connectors has been validated.

Once measurement is completed, the results display in SmartLink mode.

NOTE

Some configuration files are available in the Platform: press FILE and select 
disk > config > FCOMP.

1 Connect a loopback cable at one 
extremity of each fiber

2 Connect a launch cable at 
Extremity A and a receive cable 
at Extremity B

3 Connect the launch cable to the 
Module.

4 Launch the measurement from 
Launch cable toward Receive 
cable

Once completed, a pop up mes-
sage displays on the Platform:

5 Follow the instructions displayed: 
connect the receive cable to the 
Module of the Platform.

6 Press START/STOP lo launch the 
measurement from Receive 
cable toward Launch cable
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Results screen
Once the tests are completed, the results screen displays, both with TestPro view (tab 
TestPro) and with OTDR result trace (tab ExpertOTDR).

TestPro results page
The Results page can display either:

• the Process view, displaying the graphical representation of the measurement 
and the Loss results for each fiber

or

• the SmartLink view, for the 1st and the 2nd fiber.

Process View

On the upper part, a graphical representation of the installation for the test is displayed, 
with the Identifier for each component (name of the location and of the loopback, fiber 
numbers...).

NOTE

For unidirectional measurement, the process stops at step 4 on page 226.

Figure 145 Result TestPro Bidirectional measurement - Process view
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The second part displays a summary table of the loss measurement for the first and 
second fiber.

The results displayed in green or red are values for which a threshold has been defined: 
in green, the value does not exceed the thresholds defined in OTDR setup, in red it 
exceeds the thresholds. See “Configuring the Alarms parameters” on page 31.

SmartLink view
Click on SmartLink softkey to display a SmartLink view of each measured fiber:

Click on the softkey 1st Fiber/2nd Fiber to select the 

Click on one event on the graphical representation to display the loss and reflectance 
values for each wavelength, and the event description, at the bottom of the display.

The event is framed in red if it is above the alarm thresholds defined in the setup menu.

It is framed in green if it lies within the thresholds.

OTDR results trace / SmartLink results

OTDR Results trace

In OTDR tab, the OTDR results traces are displayed with the results table.

Figure 146 SmartLink View
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The results displayed in green or red are values for which a threshold has been defined: 
in green, the value does not exceed the thresholds defined in OTDR setup, in red it 
exceeds the thresholds. See “Configuring the Alarms parameters” on page 31.

SmartLink view

Press Trace/SmartLink menu key to display the SmartLink view of the results.

Figure 147 OTDR Results trace

Figure 148 SmartLink results page
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Saving results and generating a report
Once the results page is displayed, the results can be saved and a report can be gener-
ated directly from the results screen.

Saving and report can have been automatically generated if, in the file configuration, the 
Auto Store parameter has been set to Yes (see page 46) with the appropriate Save 
Mode.

Saving results and creating a report from results page
To generate a report:

1 Press Fast Report soft key  -> .

A menu displays under the trace.

2 In the menu, configure the file saving mode (and the report)

a In the Location A and Location B parameters, enter/modify the name of 
Origin and Extremity.

b In the Direction parameter, select/modify the direction, to define if the 
measurement has been performed from Origin to Extremity (A -> B) or from 
Extremity to Origin (B -> A).

c Click on 1st fiber or 2nd Fiber and in the sub-menu 

– Select the Fiber number parameter and click on left or right arrow to modify 
the Number

– Select the Fiber Id and modify if nec essary the fiber name.

– Select Change Fiber Nbr and select 

Increment the fiber number is automatically incremented at each new 
file-save.

Figure 149 Fast report configuration
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Decrement the fiber number is automatically decremented at each 
new file-save

User defined Use Edit Number softkey to enter the increment/decre-
ment value for fiber number.

Note: to decrement the number, enter the sign «-» before the number. 
Example: -1.

Min: -999 / Max: 999 / Auto: 0

No the Fiber number must not automatically modified.

– Select the Cable Id parameter and click on the right arrow to display the 
edition keypad and enter/modify the cable identifier (and second fiber 
identifier.

d In the Save Mode parameter, select:

txt file select Yes to save the results in a .sor file and to generate a txt 
file of the results.

pdf file select Yes to save the results in a .sor file and to generate a 
report in a pdf file.

json file select Yes to save the results in a .sor file and to generate a 
json file.

3 Once saving is configured as wished, press Save All menu key 

4 Enter a name for the file in the edition keypad

or

Press Auto Filenaming to apply the file name defined in the Setup screen, in 
Filenaming parameter: [Fiber Id][Fiber_Num].

5 Press Enter to validate

NOTE

The report layout is defined in the parameter name: Save Mode (Std) if the 
Report Layout parameter is defined to Standard in the File Setup screen, 
or Save Mode (Combo) if the Report Layout parameter is defined to Con-
solidated in the File Setup screen 

See "Report Layout" page 46.

NOTE

The blts file and the txt or pdf file will have the same name.
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Once saving is completed, a sound is emitted onto the Platform.

The pdf report is composed of two files: the pdf report for 1st Fiber and the pdf 
report for 2nd fiber.

Opening a report
1 To open the report, press FILE hardkey

2 In the Explorer page, in the directory selected, select the file of the report.

For the txt file: trace file_sor.txt

3 For the pdf file: trace file.sor.pdf Press Load.

The file opens on the T-BERD/MTS.

NOTE

The file and the report are saved in the last storage media and directory 
selected.

Figure 150 Example of PDF report
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CAUTION

To modify the VIAVI logo, set by default on the header of the pdf report, save 
your logo in a jpg file called logo.jpg and place it to the root of the disk: 
disk > logo.jpg.

NOTE

A pdf report can also be generated from the File Explorer page onto the T-
BERD/MTS or SmartOTDR (see “Generating pdf report(s)” on page 244).
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Chapter 13File management

The topics discussed in this chapter are as follows:

• “Description of the explorer” on page 236

• “Saving and loading files” on page 239

• “Exporting files” on page 241
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Description of the explorer

Opening the file explorer
To access the Explorer

1 Press the FILE button

The explorer is used to select the storage medium, and to create or rename directories 
and files:

– The left-hand part presents the storage architecture. Click on the left of the 
screen or use the keys  and  to move around among all the media 
and their respective directories. 

– The right-hand part displays all the files present in the directory selected.

The direction keys can be used to move horizontally between the two parts and vertically 
within each zone.

At the top of the screen, the file signature selected is repeated (see Figure 152 on 
page 237).

Managing tabs
Tabs give access to the File menu of each application present in the modules of the 
instrument. 

Figure 151 Example of explorer

Free space available 
on the selected media
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It is possible to open a file even if the corresponding module is not present in the instru-
ment. A new tab then temporarily manages this application.

When several different applications (corresponding to modules for different measure-
ments) are managed by the SmartOTDR, pressing the FILE key several times in succes-
sion changes from one tab to another to give access to the file configuration of the 
desired application (e.g. FCOMP, LTS etc.).

File signature
The acquisition parameters of the trace contained in the selected file are displayed at 
the top of the screen together with a small-scale representation of the trace (provided it 
was acquired on a MTS / T-BERD).

Figure 152 Example of signature of an OTDR file (in the File Menu)

Date of acquisition of 
the signal

Pass / Fail indicator

Mini-trace

Acquisition time

Origin / End

Refraction IndexResolution

Laser
Module used for 
acquisition Fiber Id

Fiber NumberPulse width

Figure 153 Example of signature with FCOMP file

Date of acquisition

Pass / Fail 
indicatorOrigin / End

Measurement 
parameters

Module used

Fiber Id

Cable Id

Fiber Number
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Buttons on the right of the screen

 Saving traces

Three buttons are used to save one or more traces.

• Save: allows to save the current trace opened.

• Save All: allows to store all the traces displayed in overlay (OTDR) in 
one single file.

• The softkey Next Trace is used to activate the menu of the following 
trace, when several OTDR traces are in overlay.

Storage media
For saving or recalling data, the equipment offers a wide choice of media, both built-in 
and external.

Free space on selected media is clearly displayed at the bottom of the left panel.

Directories and files editing function
The Files and directories editing functions are similar to those available in the Explorer 
page of the Platform.
Refer to 2000/4000 V2 Platform or SmartOTDR User Manual if you want to work on 
directories and files (copy/paste, rename...).

Remote Base Unit and data transfer

During a data transfer (with the option Data/Talkset), the distant Base-Unit 
hard drive connected by the fiber is displayed as a storage media. File and 
directory edition features may all be used in the same manner with this stor-
age media as with the other ones
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Saving and loading files

Saving files from the Explorer
When the explorer is displayed, the active trace for the selected tab is displayed in the 
File Signature.

You can then save the active trace:

1 Select a directory by clicking once on it

2 Click on Store to save the active trace

A new sub-menu displays

3 For OTDR traces only click on Next Trace to change the file signature on the top 
part of the screen and to save the next trace from traces in overlay

4 Click on Save All or on Save (OTDR files only).

The Save All menu key in OTDR tab allows to save all the traces opened, 
whereas the Save menu key allows to save exclusively the trace described in the 
file signature.

5 If you wish, click on FILE button to display the Explorer page for another applica-
tion and save, using the same method, the active trace from this application.

This will open automatically the edition keypad, in order to give a filename for the 
active trace.

Figure 154 Saving active trace from the explorer (with OTDR trace)

The trace described in the file signature 
will be saved in the directory selected (in 
this example: demo)

Displayed when two active 
overlaid traces are open.

The «Store» menu key is not available if the type of saving for OTDR 
files is defined to «All Traces» in the File Content parameter (see “File 
Content” on page 45).
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Loading files and displaying traces
To access the functions for loading one or more files, select the file(s) in the explorer and 
press Load.

Simple loading
The key View Trace(s) enables simple loading of traces, using the current parameters 
of the MTS/T-BERD or SmartOTDR. The current trace is then replaced with this new 
trace.

Load with configuration
The key Load Trace + Config will display the traces, recalling the configuration 
recorded in the file. Thus the zooms, cursors and parameters present at the time of 
acquisition will be used for the display. 

This function also enables to recall and set the parameters defined in the screens corre-
sponding respectively to the FILE and SETUP keys.

It is then possible to perform an acquisition under the same conditions as those of the 
trace recalled.

• If the SmartOTDR was equipped with a different module from the current one 
when the trace was acquired, certain configuration parameters cannot be 
updated. A message warns the user of this.

• If several traces are selected, the configuration used will be that of the first trace.

• If the number of traces added and the number of traces present is greater than 8, 
then the last traces added will not all be taken into account.

NOTE

For TXT, PDF, LTS and FCOMP, only one file can be opened at a time.

The configuration cannot be recalled if the trace was not originally cre-
ated by a SmartOTDR or T-BERD/MTS.
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Loading several traces in overlay
Up to 8 traces in the same application (OTDR) can be displayed simultaneously in 
overlay. 
To obtain a display of multiple traces, two methods are possible:

• Select all the files to be loaded at the same time (see 2000 or 4000 V2 Platform 
User manual for multiple selection of files) and click on Load > View Trace(s)

• Define a reference trace in a first time, open it, then come back to the explorer to 
select the other traces to be added (see “Reference Trace function” on page 86).

Exporting files
Click on the Export menu key allows to display a sub-menu from which selected files 
can be:

• generated into one/several reports

• merged into one file (for txt/pdf files only)

• sent by e-mail

Explorer/Link Manager
Before exporting file(s), the display can be modified, and the Link Manager can be 
selected instead of the Explorer using the Explorer/Link Mgr menu key.

The Link Manager function allows to display the explorer with all the link information 
exclusively for the active application (the function must be activated in Home page, or 
at least one result trace must be opened to get the tab and display files in the Link 
Manager page).

For example, if the Link Mgr. function is selected in the tab OTDR, only the link informa-
tion from the OTDR files will be displayed (whether in multimode or singlemode).
Select Link Mgr with the menu key Explorer/Link Mgr. to display the corresponding 
files for the active tab.
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According to the application selected, the fiber information available are different. The 
table below describes the fiber information displayed for each selected tab:

Figure 155 Explorer and Link Manager display

Tab selected
Explorer View

Link Manager View

NOTE

The files in the Link Manager window can be sorted according each column 
available for a tab.

Table 11 Fiber Information displayed

Column. OTDR & OEO LTS
FCOMP

Cable View
FCOMP

Fiber View

1st Alarm status (icon) & Fiber 
number

Alarm status (icon) & Cable Id Alarm status 
(icon) & Fiber Id

2nd Direction Laser Fiber number Length

3rd Lambda Power 
(dBm)

AL1310: number of fibers with 
loss alarms at 1310 nm

L1310: Average 
loss at 1310 nm

4th Total Loss Loss (dB) AL1550: number of fibers with 
loss alarms at 1550 nm

L1550: Average 
loss at 1550 nm

5th Distance Ref (dBm) AL1625: number of fibers with 
loss alarms at 1625 nm

L1625: Average 
loss at 1625 nm

6th Nb of Event - AO1310: number of fibers with 
ORL alarms at 1310 nm

O1310: worst 
ORL at 1310 nm

7th Max Splice - AO1550: number of fibers with 
ORL alarms at 1550 nm

O1550: worst 
ORL at 1550 nm
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Editing function
The same editing functions as those from the Explorer are available with the Link 
Manager function, except the merging function (as this is used with txt files):

Refer to 2000/4000 V2 Platform or SmartOTDR User Manual if you want to work on 
directories and files (copy/paste, rename...).

Moreover, the Edit menu from the Link Manager page allows to export the whole direc-
tory, with the files corresponding to the active tab, in a txt file.

Exporting a directory in a txt file
1 Click on Export and select the Link Manager function

2 Select the tab corresponding to the files you want to use

3 Select the directory to open

4 Select one file from the list

5 Click on Export menu key.

The txt file is automatically generated, in the same directory as the one selected 
for the export.

The name by default for the txt file is: fiber_info_”name of application 
selected”.txt.

For example, for the export of the Fiber Information from the OTDR application, 
the txt file will be called: fiber_info_otdr.txt

This file is made of two parts:

8th Total ORL - AO1625: number of fibers with 
ORL alarms at 1625 nm

O1625: worst 
ORL at 1625 nm

Table 11 Fiber Information displayed

Column. OTDR & OEO LTS
FCOMP

Cable View
FCOMP

Fiber View

NOTE

The txt file can be renamed once it is saved.
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• The Header, with general information: the equipment used and its serial number, 
the date and time of export, the location of the file, and the number of files 
exported.

• The table, containing all the fibers information coming from the files of the active 
tab.

Once generated, the txt file can be transferred onto a PC and opened via a spreadsheet 
program (e.g. Excel...).

Generating pdf report(s)
Several files of a same type (example: all OTDR files) can be generated in one/several 
pdf report(s).

1 Select the file(s) to be generated in a pdf report

2 Press Export menu key

3 Using the menu key  select:

– 1 Trace if the report must be generated with one trace per page 

– Multi if the report must be generated with up to three traces per page (for 
OTDR files only).

– ODM: to convert the odm files in pdf.

4 Click on Build Report.

5 In the edition menu displayed, enter the name for the report

6 Press Enter to validate and launch the report

The icon  display during report generation.

Figure 156 Example of a directory exported in a txt file (open with Excel)

Header of 
the txt file

Recall of the Fiber 
Information displayed on 
the SmartOTDR (except 
alarm status)

File name

MTS2100 4100 Module US rev015.book  Page 244  Jeudi, 14. janvier 2021  3:41 15



Chapter 13 File management
Exporting files

User Manual 77000010208 Rev. 015 245

Once report is generated, a beep is emitted.

Using the Merge key, with the txt/pdf files
The txt or pdf files that have been saved/generated from a results page can be merged 
into one txt/pdf file from the Explorer.

Figure 157 Report: 1 Trace and Multi (with OTDR files)

PDF Report: «1 Trace» mode PDF Report: «Multi» mode

CAUTION

To modify the VIAVI logo, set by default on the header of the pdf report, save 
your logo in a jpg file called logo.jpg and place it to the root of the disk: 
disk > logo.jpg.

NOTE

The report is saved in the same directory as the selected files.
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The key Merge is used to merge several txt or pdf files into one file, putting together the 
results of all files.

1 In the explorer, select the txt/pdf files generated with the trace files you want.

2 Click on Export > Merge key

The icon  displays during merging process, and a beep is emitted once 
process is completed.

The file is saved with the filename: merged_yyyy_mm_day__hr_mn_sec.pdf/txt

It is automatically saved in the same directory as the one where the txt/pdf files 
have been selected.

The merging can be done exclusively from files of the same format. 
Pdf and txt files cannot be selected at the same time to generate a 
merged file.

NOTE

The file can be renamed once it is saved.
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Chapter 14  Technical specifications

This chapter shows the technical specifications of the OTDR modules and of the options 
available for the or T-BERD/MTS 2000 or SmartOTDR, and the OTDR technical speci-
fications for SmartOTDR.

The topics discussed in this chapter are as follows:

• “OTDR modules for T-BERD/MTS 2000/4000 V2” on page 248

• “Environmental conditions” on page 256

• “Technical specifications of the Power meter function on OTDR module for T-
BERD/MTS-2000/4000 V2” on page 258

• “Technical specifications of the Source function on OTDR module for T-BERD/
MTS-2000/4000 V2” on page 259

• “Technical specifications of the FiberComplete modules” on page 260

• “MPO Switch Module Technical specifications” on page 261

• “OTDR Technical specifications for SmartOTDR” on page 261

NOTE

For specifications regarding the environment, refer to the Base-Unit user 
manual.
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OTDR modules for T-BERD/MTS 2000/4000 V2

Characteristics of reflectometry measurements 
Distance measurement 
• Dual cursor 

• Distance displayed takes into account the calibration of the refractive index of the 
fiber.

• Index adjustable from 1,30000 to 1,70000 in steps of 0,00001

• Resolution of display: 1 cm max.

• Resolution of cursor: 1 cm max.

• Spacing of measurement points: from 4 cm, with up to 256 000 acquisition points.

• Accuracy: ± 1m± sampling resolution ±10-5 x distance for LA, MM and QUAD 
(excluding errors of calibration of refractive index of the fiber).

± 0.5m± sampling resolution ±10-5 x distance for MA2, MA3, MP2, B 
and C Modules (excluding errors of calibration of refractive index of the 
fiber).

• Display span: 3.25 m up to 400 km, according to the Module

Attenuation measurement 
• Dual cursor

• Resolution of display: 0,001 dB

• Resolution of cursor: 0,001 dB

• Linearity: ± 0.05 dB/dB with LA Modules

± 0.03 dB/dB with MA2, MA3, MP2, QUAD/MM, B and C Modules

• Display span: 1.25 dB to 55 dB

Reflectance Measurement
• Resolution of display: 0,01 dB

• Accuracy: ± 2 dB

Automatic measurement
• Automatic measurement of all the elements of the signal. Slope measurement by 

least squares or 2 points of measurement.
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• Display threshold of faults:

- 0 to 5.99 dB in steps of 0.01 dB for event thresholds 
- -11 to -99 dB in steps of 1 dB for the reflectance 
- 0.01 to 5.99 dB in steps of 0.01 dB for attenuation

• Display of slope and attenuation for a segment of fiber.

• Display of the position of a fault and of attenuation.

• Display of the reflectance of the fault.

• Display of ORL

Manual Measurement
• Measurement of slope between the cursors.

• Measurement of attenuation between two segments of fiber.

• Measurement of reflectance of a reflecting element.

• Measurement of ORL between the two cursors.

• Measurement of splice by 2 or 5 points method 

Typical specifications
Typical values, measured at 25°C for all modules, unless specified.

Multimode Module

Multimode OTDR Module 41XXMM

Central Wavelength1

1. Laser in CW mode, at 25° C

850 / 1300 nm ± 30 nm

Typical RMS Dynamic Range2

2. Typical value corresponding to the difference (in dB) between the level of back-diffusion 
extrapolated at the beginning of the fiber and the RMS noise level, after 3 minutes of averag-
ing, with the largest pulse width.

26 / 24 dB

Distance Range Up to 80 km

Pulse width 3 ns to 1 µs

Event Dead Zone3

3. EDZ measured at +/- 1.5 dB below the peak of a non-saturated reflecting event at shortest 
pulse width.

0.8 m

Attenuation Dead Zone4 

4. ADZ measured at +/- 0.5 dB on the basis of a linear regression, using a - 40 dB type reflec-
tance, at shortest pulse width.

4 m
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LA/MA2/MA3/MP2 Modules

B and C Modules

Singlemode 
Modules

LA
41xxLA

MA2
41xxMA2

MA3
41xxMA3

MP2
41xxMP2

Central Wavelength 1
1310 ± 20 nm
1550 ± 20 nm
1650 ± 20 nm

1310 ± 20 nm2

1383 ± 3 nm2

1550 ± 20 nm2

1625 ± 15 nm2

1310 ± 20 nm2

1550 ± 20 nm2

1625 ± 10 nm
1650 + 10/-5 nm

1310 ± 20 nm
1550 ± 20 nm
1625 ± 10 nm
1650 ± 15 nm

RMS Dynamic Range 3
35 dB
33 dB
30 dB

40 dB
37 dB
38 dB
38 dB

43 dB
41 dB
41 dB
41 dB

45 dB
43 dB
43 dB
42 dB

Distance Range up to 260 km Up to 400 km

Pulse width 5ns to 20 µs

Event Dead Zone 4 1.5 m
0.7 m

1383 nm: 1.76 m5 0.7 m 0.65 m

Attenuation Dead Zone 6 6 m
3 m

1383 nm: 5.27 m7 3 m 2.5 m

Typical Splitter Attenua-
tion Dead Zone

- - 45 m8 35 m9

1. Laser at 10 µs and 25° C
2. Laser in CW and 25° C
3. Typical value corresponding to the difference (in dB) between the level of back-diffusion extrapolated 

at the beginning of the fiber and the RMS noise level, after 3 minutes of averaging, with the largest 
pulse width.

4. EDZ measured at 1.5 dB below the peak of a non-saturated reflecting event at shortest pulse width.
5. EDZ measured at 1.5 dB below the peak of a non-saturated reflecting event at 10 ns.
6. ADZ measured at +/- 0.5 dB on the basis of a linear regression from a reflectance of type FC/UPC (-55 

dB) at shortest pulse width, at 1310 nm.
7. ADZ measured at +/- 0.5 dB on the basis of a linear regression from a reflectance of type FC/UPC (-55 

dB) at 10 ns.
8. At 200ns, 1550nm, with 16dB loss non reflective, SADZ threshold at 1dB.
9. At 100ns, 1550nm, with 16dB loss non reflective, SADZ threshold at 1dB

Singlemode Modules 41xxB 41xxC

Central Wavelength 1

1310 ± 20 nm2

1550 ± 20 nm2

1625 ± 10 nm
1650 + 10/-5 nm

1310 ± 20 nm
1550 ± 20 nm
1625 ± 10 nm
1650 ± 15 nm
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Multimode and QUAD Modules

RMS Dynamic Range 3

42 dB
40 dB
40 dB
40 dB

45 dB
43 dB
43 dB
42 dB

Distance Range Up to 260 km Up to 400 km

Pulse width 5 ns to 20 µs

Event Dead Zone 4 0.65 m

Attenuation Dead Zone 5 3 m 2.5 m

Typical Splitter Attenuation Dead Zone 45 m6 20 m7

1. Laser at 10 µs and 25° C
2. Laser in CW and 25° C
3. Typical value corresponding to the difference (in dB) between the level of back-diffusion 

extrapolated at the beginning of the fiber and the RMS noise level, after 3 minutes of averag-
ing, with the largest pulse width.

4. EDZ measured at 1.5 dB below the peak of a non-saturated reflecting event at shortest pulse 
width.

5. ADZ measured at +/- 0.5 dB on the basis of a linear regression from a reflectance of type FC/
UPC (-55 dB) at shortest pulse width.

6. Measured on a 16 dB loss (typical 1x32 split ratio) non-reflective splitter at 1310nm, using 
200ns pulsewidth.

7. Measured on a 16 dB loss (typical 1x32 split ratio) non-reflective splitter at 1310nm, using 
100ns pulsewidth

Singlemode Modules 41xxB 41xxC

Multimode / Singlemode OTDR Module

Central Wavelength 1 850 / 1300 nm ± 30 nm 1310 / 1550 nm± 20 nm

Typical RMS Dynamic Range 2 26 / 24 dB 37 / 35 dB

Distance Range Up to 80 km Up to 260 km

Pulse width 3 ns to 1 µs 3 ns to 20 µs

Event Dead Zone 3 0.8 m 0.9 m

Attenuation Dead Zone 4 m4 4 m5

1. Laser in CW mode, at 25° C
2. Typical value corresponding to the difference (in dB) between the level of back-diffusion extrapolated at the 

beginning of the fiber and the RMS noise level, after 3 minutes of averaging, with the largest pulse width
3. EDZ measured at +/- 1.5 dB below the peak of a non-saturated reflecting event at shortest pulse width
4. ADZ measured at +/- 0.5 dB on the basis of a linear regression using a -40 dB type reflectance, at short-

est pulse width.
5. ADZ measured at +/- 0.5 dB on the basis of a linear regression from a reflectance of type FC/UPC (-55 

dB) at shortest pulse width, at 1310 nm.
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CWDM Modules

DWDM Modules

CWDM Modules 41CWDM8U 41CWDM10U 41CWDM10L

Central Wavelength1

1471 ±3 nm
1491 ±3 nm
1511 ±3 nm
1531 ±3 nm
1551 ±3 nm
1571 ±3 nm
1591 ±3 nm
1611 ±3 nm

1431 +/-3 nm
1451 +/-3 nm
1471 +/-3 nm
1491 +/-3 nm
1511 +/-3 nm
1531 +/-3 nm
1551 +/-3 nm
1571 +/-3 nm
1591 +/-3 nm
1611 +/-3 nm

1271 ± 3 nm
1291  ± 3 nm
1311 ± 3 nm
1331 ± 3 nm
1351 ± 3 nm
1371 ± 3 nm
1391 ± 3 nm
1411 ± 3 nm
1431 ± 3 nm
1451 ± 3 nm

RMS Dynamic Range2 35 dB

Distance Range Up to 260 km

Puse Width 10 ns to 20 µs

Event Dead Zone 3 1.50 m

Attenuation Dead Zone4 5 m

Output power of the 
source in continuous mode

-3.5 dBm

 Modes5 CW, 270Hz, 330Hz, 1kHz, 2kHz

1. Guaranteed, with laser at 25°C measured at 10 µs.
2. Value corresponding to the difference (in dB) between the backscattered level extrapolated at the origin 

of the fiber and the RMS noise level , after 3 minutes of averaging, with the largest pulsewidth.
3. EDZ measured at 1.5 dB below the peak of a non-saturated reflecting event at shortest pulsewidth.
4. ADZ measured at +/- 0.5 dB on the basis of a linear regression from a reflectance of type FC/PC (-55 

dB) at shortest pulsewidth.
5. Remove 3 dB if used in modulation mode (270/330/1k/2kHz/Twintest/Auto)

DWDM Modules 41DWDMC

Wavelengths C-Band tuning - C62 to C12 
(1527.9 nm - 1567.95 nm)

Channel Spacing 50/100/200 GHz

Puse Width 10 ns to 20 µs

RMS Dynamic Range1 44 dB
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Ranges

Ranges for LA Modules

Distance Range Up to 260 km

Event Dead Zone 2 1.50 m

Attenuation Dead Zone3 4 m

Output power of the source in continuous mode 0 dBm

 Modes4 CW, 270Hz, 330Hz, 1kHz, 2kHz

1. Value corresponding to the difference (in dB) between the backscattered level extrapolated at the origin 
of the fiber and the RMS noise level , after 3 minutes of averaging, with the largest pulsewidth.

2. EDZ measured at 1.5 dB below the peak of a non-saturated reflecting event at shortest pulsewidth.
3. ADZ measured at +/- 0.5 dB on the basis of a linear regression from a reflectance of type FC/PC (-55 

dB) at shortest pulsewidth.
4. Remove 3 dB if used in modulation mode (270/330/1k/2kHz/Auto)

DWDM Modules 41DWDMC

5 ns 30 ns 60ns 100 ns 300 ns 1 μs 3 μs 10 μs 20 μs

0.1 km x x

0.5 km x x

1 km x x x

2 km x x x x

5 km x x x x x

10 km x x x x x x

20 km x x x x x x x

40 km x x x x x x x x x

80 km x x x x x x x x

260 km x x x x x
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Ranges for MA2, MA3 Singlemode and B OTDR Modules

Ranges for MP2 Singlemode and C OTDR Modules

 5ns 10ns      30ns      100ns      200ns      500ns      1us      3us      10us      20us

100 m    x  x  x

200 m    x  x  x

500 m    x  x  x            

1 km     x  x  x  x

2 km     x  x  x  x  x  x

5 km     x  x  x  x  x  x  x

10 km    x  x  x  x  x  x  x

20 km    x  x  x  x  x  x  x  x

40 km    x  x  x  x  x  x  x  x  x  x

80 km  x  x  x  x  x  x  x  x

160 km  x  x  x  x  x  x

260 km  x  x  x  x

5ns 10ns 30ns 100ns 200ns 500ns 1us 3us 10us 20us

100 m x x  x

500 m x x  x

1 km x x  x x

2 km x x  x x x  x

5 km x x  x x x  x x

10 km x x  x x x  x x

20 km x x  x x x  x x x

40 km x x  x x x  x x x  x x

80 km x x  x x x  x x x

160 km x x  x x x  x

260 km x x  x x

400 km x x
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Ranges for Multimode Modules

Ranges for CWDM Modules

Ranges for DWDM Modules

3 ns 10 ns 30 ns 100 ns 300 ns 1 µs

0.5 km x x

1 km x x x

2 km x x x x

5 km x x x x x

10 km x x x x x x

20 km x x x x x

40 km x x x

80 km x x x

10 ns  30 ns 100 ns 300 ns 1 µs 3 µs 10 µs 20 µs

0,5 km x x

1 km x x

2 km x x x

5 km x x x x

10 km x x x x x

20 km x x x x x x

40 km x x x x x x x x

80 km x x x x x x x

160 km x x x x x

260 km x x x

10 ns  30 ns 100 ns 300 ns 1 µs 3 µs 10 µs 20 µs

0,5 km x x

1 km x x x

2 km x x x x

5 km x x x x x

10 km x x x x x

20 km x x x x x x
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Class of the lasers of the OTDR modules

OTDR modules measurement
Weight: approx. 300 g (0,66 lbs) (400g for the QUAD OTDR Module / 510g for the 
DWDM Module)

Dimensions (in mm) - w x h x d: 128 x 134 x 41

OTDR Module supply
OTDR modules are powered by the mainframe which they are attached to.

• Rated range supply 8 -15 VDC

• Maximum power consumption is 8 W

Environmental conditions

Indoor/outdoor
• Backlight high visibility color screen

• High visibility capacitive touchscreen for indoor and outdoor use.

40 km x x x x x x x x

80 km x x x x x x x

160 km x x x x x x

260 km x x x

10 ns  30 ns 100 ns 300 ns 1 µs 3 µs 10 µs 20 µs

Module Standard IEC 60825-1, Ed 1.2, 2001 -08 FDA21CFR§1040.10

Singlemode LA,, MA2, B 
and C OTDR Modules

Class1 Class 1

Singlemode MA3 and 
MP2 OTDR Module

Class 1M @ 1310 nm
Class 1 @ 1490, 1550, 1625 & 1650 nm

Class 1

Multimode OTDR Mod-
ules

Class 1M @ 850 nm
Class 1 @ 1300 nm

Class 1
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• Use in altitude up to 4000m.

Temperature

IEC 61010-1 Temperature range from 0 to 40°C.

Humidity
• 5 to 95% without condensation

Pollution degree
• Pollution degree: 2

VIAVI recommends that customers dispose of their instruments and peripherals in an 
environnmentally sound manner. Potential methods include reuse of parts or whole 
products and recycling of products components, and/or materials.

Waste Electrical and electronic Equipment (WEEE) Directive

In the European Union, this label indicates that this product should not be 
disposed of with household waste. Il should be deposited at an appropriate 
facility to enable recovery and recycling.

CAUTION

It is strongly recommended to work on the Platform in its glove when the 
product is used outdoor, in rainy weather.

CAUTION

 AC/DC power supply must be used indoor!

The Platform battery charging must be performed indoor only!

• Platform operating temperature range Refer to platform’s specification sheet

• Storage
-20°C to +60°C
(-4°F to +140°F)
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Technical specifications of the Power meter 
function on OTDR module for T-BERD/MTS-2000/
4000 V2

Specifications given for 25°C, after 20 minutes stabilization time and after zero setting.

Power meter option for Singlemode Modules

Power meter option for Multi/Single mode Modules

Plug-ins 
Singlemode

Power meter for MA2, MA3, MP2, B and 
C Modules

Power meter for 
E4126 LA Module

Measurement 
Wavelength

1310 / 1490 / 1550 / 1625 / 1650 nm 1310 / 1490 / 1550 nm

Calibrated 
Wavelength

1310 / 1490 / 1550 / 1625 / 1650 nm 1310 / 1550 nm

Accuracy at 
calibrated 
wavelengths1

± 0.5 dB ± 0.5 dB

Input power range -55 to -3 dBm - 50 to -2 dBm

Display resolution 0.01 dB / 0.01nW 0.01 dB / 0.01nW

Linearity within 
the specification 
range

± 0.5 dB
(- 50 to - 3 dBm)

(-50 to -3.5 dBm for OTDR MA3 Modules)
-

1. typical value at -30dBm, excluding connector uncertainty, at calibrated wavelengths

Plug-ins Single / Multi 
mode

Singlemode Power meter
Multimode Power 

meter

Measurement 
Wavelength

1310 / 1490 / 1550 / 1625 / 1650 nm 850 and 1300 nm

Calibrated Wavelength 1310 / 1490 / 1550 / 1625 / 1650 nm 850 and 1300 nm

Accuracy at calibrated 
wavelengths

± 0.5 dB (at -30 dBm) ± 1 dB (at -15 dBm) 1
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Technical specifications of the Source function on 
OTDR module for T-BERD/MTS-2000/4000 V2

Input power range - 50 to - 2 dBm - 30 to -3 dBm

Maximum resolution 0.01 dB / 0.01nW

Linearity within the 
specification range

± 0.5 dB (- 45 to - 5 dBm) -

1. Using a mode conditioner

Plug-ins Single / Multi 
mode

Singlemode Power meter
Multimode Power 

meter

Laser Class Class 1

Wavelengths Same as OTDR Ports (see page 250)1

1. Except filtered wavelengths

Output Power Level
- 3.5 dBm typical for continuous signal (CW)

0 dBm typical for the DWDM Module

Modulated Mean Level
-6.5 dBm typical

- 3 dBm typical for DWDM Module

Output Power Accuracy ± 0.65 dB (for B Module only)2

2. Excluding connector uncertainty

Stability
(over 8 hours after 20 minutes 
warm-up time)

± 0.05 dB @25°C for MA2 and MP2 Modules
± 0.1dB @25°C for MA3, B and C Modules.

Tone Generation 270 Hz/330 Hz/1kH/2kHz

Auto λ Mode3

3. Twintest Mode available for LA, MA2, MA3, MP2, B and C OTDR Modules

Yes (with VIAVI Power meters)

Spectral Bandwith (for DWDM 
only)

2.5 GHz
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Technical specifications of the FiberComplete 
modules

Typical values, measured at 25°C unless specified.

For the OTDR specifications, please refer to page 248.

This function is not available with SmartOTDR.

E41XXMA3XXXX B Modules

Wavelength 1310 / 1490 / 1550 / 1625 nm 1
1310 nm ± 20 nm
1550 nm ± 20 nm

1625 ± 10 nm

Insertion Loss

Dynamic range 40 dB 40 dB

IL uncertainty2 +/- 0,25 dB +/- 0,2 dB

IL repeatability3 < 0,05 dB 0.05 dB

Display resolution 0.01 dB

ORL

ORL display range up to 45 dB from 10 to 55 dB

ORL uncertainty +/- 0,9 dB4 +/- 0.5 dB5

ORL repeatability < 0,1 dB4

Display resolution 0.01 dB

Length 

Measurement range 150 km

Length uncertainty6 +/- 30m from 50 m to 20 km range7

+/- 100m above 20 km7 0/+5m +/-10-5 x distance8

1. 1625nm not available with filtered version
2. side by side reference
3. 10 consecutive measurements, without disconnection
4. from 20 to 40 dB range
5. from 10 to 40 dB range, with user reference, excluding connector uncertainty
6. measurement @ 1550 nm
7. with an index of refraction n = 1.468
8. excluding group index uncertainty
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MPO Switch Module Technical specifications

OTDR Technical specifications for SmartOTDR

OTDR Optical Interfaces
Switchable optical connectors: FC, LC, SC

OTDR Optical characteristics

Wavelength range 1270 to 1650 nm

Insertion Loss1 2

1. Measured at 1310, 1550 and 1625 nm
2. 2.5 dB maximum

1.2 dB typ

Input port SC/APC

Output port MPO APC (pinned)

Laser safety class (21 CFR) Class 1

Distance units Kilometer, meter, feet, and miles

Group index range 1.300000 to 1.700000 in 0.00001 steps

Number of data points Up to 256,000 data points

Distance measurement Automatic or dual cursor

Display range 0.1 km to 260 km for single-mode

Cursor resolution 1 cm

Sampling resolution 4 cm for single-mode

Accuracy
±1 m ±sampling resolution ±1.10–5 * x distance 

(Excluding group index uncertainties)
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Warning labels

Due to the reduced dimensions of the optical modules, it is not always possible to attach 
the required warning labels to them. In line with the provisions of Article 5.1 of the IEC 
60825-1 standard, the laser class identification labels are shown below:

The user must take the necessary precautions concerning the optical output of the 
instrument and follow the manufacturer’s instructions.

Characteristics of reflectometry measurements 
Distance measurement 
• Automatic or Dual cursor 

• Distance displayed takes into account the calibration of the refractive index of the 
fiber.

• Index adjustable from 1,30000 to 1,70000 in steps of 0,00001

• Resolution of display: 1 cm max.

• Resolution of cursor: 1 cm max.

Dangerous voltage (> 70VDC) is present inside of the product.

Do not attempt to remove cover when product is in use.

Standard Ref. IEC 60825-1, Edition 1.2, 2001-08 FDA21CFR§1040.10

Class 1

Class 1M

Class 2

Measurements on optical fibers are difficult to execute and the preci-
sion of the results obtained depends largely on the precautions taken 
by the user.

CLASS 1
LASER PRODUCT
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• Spacing of measurement points: from 4 cm, with up to 256 000 acquisition points.

• Accuracy: ± 1m± sampling resolution ±1.10-5 x distance 
(excluding errors of calibration of refractive index of the fiber).

• Display span: 0.1 km m to 260 km for single mode

Attenuation measurement 
• Automatic, manual, 2-point, 5-point, and LSA

• Resolution of display: 0,001 dB

• Resolution of cursor: 0,001 dB

• Linearity: ± 0.04 dB/dB for single mode

• Display span: 1.25 dB to 55 dB

Reflectance / ORL Measurement
• Resolution of display: 0,01 dB

• Accuracy: ± 2 dB

Automatic measurement
• Automatic measurement of all the elements of the signal. Slope measurement by 

least squares or 2 points of measurement.

• Display threshold of faults:

- 0 to 5.99 dB in steps of 0.01 dB for event thresholds  
- -11 to -99 dB in steps of 1 dB for the reflectance 
- 0.01 to 5.99 dB in steps of 0.01 dB for attenuation

• Display of slope and attenuation for a segment of fiber.

• Display of the position of a fault and of attenuation.

• Display of the reflectance of the fault.

• Display of ORL

Manual Measurement
• Measurement of slope between the cursors.

• Measurement of attenuation between two segments of fiber.

• Measurement of reflectance of a reflecting element.

• Measurement of ORL between the two cursors.

• Measurement of splice by 2 or 5 points method 

Typical specifications
Typical values, measured at 25°C unless specified.
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Characteristics of the Source (standard) and Power 
Meter (optional)

Source
• Output Power Level1: -3.5 dBm

• Stability long term (8h): ± 0.05 dB2

100B Series 100A Series

Central Wavelength1
1310 ± 20nm
1550 ± 20nm

filtered 1625 nm ± 20nm 

1310 nm ± 20nm
1550 nm ± 20nm

filtered 1650 nm ± 20 nm

Cut Wavelength range on 
live port (filtered)

1290 - 1580 nm
Isolation > 45 dB

Typical RMS Dynamic 
Range2 40 / 40 / 41 dB 37 / 35 / 32 dB

Distance Range3 Up to 260 km

Pulse width 3 ns to 20µs 5 ns to 20µs

Event Dead Zone4 0.90 m 1.35 m

Attenuation Dead Zone5 2.5 m 4 m

Splitter Attenuation Dead 
Zone

45 m after 15dB splitter loss N/A

1. Laser, at 25° C and measured at 10 µs
2. Typical value corresponding to the one-way difference (in dB) between the extrapolated backscatter-

ing level at the beginning of the fiber and the RMS (SNR = 1) noise level, after 3 minutes averaging 
and high dynamic resolution, using the largest pulse width.

3. At 1550 nm
4. EDZ measured at ± 1.5 dB below the peak of a unsaturated reflective event using the shortest pulse 

width.
5. ADZ measured at ± 0.5 dB from the linear regression, using a FC/UPC- type reflectance, at shortest 

pulse width.

1.+/- 1 dB
2.After 30min light source stabilization time
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Power meter (through OTDR port)
Specifications given for 25°C, after 20 minutes stabilization time and after zero setting.

• Calibrated wavelengths: 1310 / 1490 / 1550 / 1625 / 1650 nm

• Accuracy at calibrated wavelengths: ± 0.5 dB (at -30 dBm)1

• Input power range: -60 dBm to +10 dBm

• Maximum resolution: 0.01 dB / 0.01nW

• Measurement range:0 to -55 dBm

• Linearity: ± 0.5 dB2

PON/XG-PON Power Meter (E118FA65PPM version)
• Wavelengths: 1490/1550 nm; 1490/1578 nm

• Measurement ranges

– 1490 nm: -35 to +5 dBm

– 1550/1578 nm: -35 to +23 dBm

• Measurement accuracy: ± 0.5 dB

• Channels isolation from external source: 

– 1310/1490: > 40dB

– 1550 to 1650: > 20dB

1.Except 1650 nm
2.from -5 dBm to -50 dBm
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Chapter 15Options and accessories

This chapter shows the references of the options and accessories for the modules of the 
T-BERD/MTS-2000 or T-BERD/MTS-4000 V2, and the references for the SmartOTDR.

The topics discussed in this chapter are as follows:

• “Commercial References of measurement modules for T-BERD/MTS-2000/4000 
V2” on page 268

• “Commercial References of the SmartOTDR” on page 273

• “Commercial references of the User manuals” on page 274

• “Commercial References of optical connectors and adapters” on page 274
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Commercial References of measurement modules 
for T-BERD/MTS-2000/4000 V2

Product marking is based on the commercial reference excluding the first letter. Example 
: Commercial reference E4146QUAD is identified 4146QUAD on the product

OTDR Modules1

Multimode Module

Singlemode Module

1. Specify optical connector of each OTDR ports

Modules
Commercial 
Reference

Multimode 850 / 1300 nm OTDR Module E4123MM

LA Modules
Commercial 
References

LA OTDR 1310/1550 nm Module with source option E4126LA

LA OTDR 1550 nm Module with source option E4115LA

LA OTDR filtered 1650 nm Module E4118RLA65

MA2 Modules
Commercial 
References

Metro-Access 1310/1550 nm OTDR Module with APC connector and 
continuous light source

E4126MA2-APC

Metro-Access 1310/1550 nm OTDR Module with PC connector and 
continuous light source

E4126MA2-PC

Metro-Access 1310/1550/1625 nm OTDR Module with APC connector 
and continuous light source

E4136MA2-APC

Metro-Access 1310/1550/1625 nm OTDR Module with PC connector 
and continuous light source

E4136MA2-PC
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Metro-Access 1310/1383/1550 nm OTDR Module with PC connector 
and continuous light source

E4138MA283-PC

MA2 Modules
Commercial 
References

MA3 Modules
Commercial 
References

Metro-Access/PON Filtered 1650 nm OTDR Module with APC con-
nectors and continuous light source

E4118FMA365-APC

Metro-Access/PON 1310/1550 nm OTDR Module with APC con-
nector and continuous light source

E4126MA3-APC

Metro-Access/PON 1310/1550 nm OTDR Module with PC connec-
tor and continuous light source

E4126MA3-PC

Metro-Access/PON 1310/1550/1625 nm OTDR Module with APC 
connector and continuous light source

E4136MA3-APC

Metro-Access/PON 1310/1550/1625 nm OTDR Module with PC 
connector and continuous light source

E4136MA3-PC

Metro-Access/PON 1310/1550 nm and Filtered 1650 nm OTDR 
Module with APC connector and continuous light source

E4138FMA365-APC

MP2 Modules
Commercial 
References

Metro PON 1310/1550 nm OTDR Module with Source option E4126MP2-PC/-APC

Metro PON 1310/1550/1625 nm OTDR Module with Source option E4136MP2-PC/-APC

Metro PON 1310/1550 nm and filtered 1625 nm OTDR Module with 
APC connectors and Source option

E4136FMP2-APC

Metro PON 1310/1550 nm and filtered 1650 nm OTDR Module with 
APC connectors and Source option

E4138FMP265-APC

B Modules
Commercial 
References

Module B OTDR 1310/1550 nm - PC/APC E4126B-PC/-APC

Module B OTDR 1310/1550/1625 nm - PC/APC E4136B-PC/-APC

Module B OTDR 1310/1550/Filtered 1650 nm - APC E4138FB65-APC

Module B OTDR Filtered 1650 nm - APC E4118FB65-APC
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CWDM OTDR Modules1

DWDM OTDR Modules2

C Modules
Commercial 
References

Module C OTDR 1310/1550 nm - PC/APC E4126C-PC/-APC

Module C OTDR 1310/1550/1625 nm - PC/APC E4136C-PC/-APC

Module C OTDR 1310/1550/Filtered 1650 nm - APC E4138FC65-APC

Module C OTDR 1310/1550/Filtered 1625 nm - APC E4136FC65-APC

Multimode/Singlemode Modules
Commercial 
Reference

Multimode/Singlemode 850/1300/1310/1550 nm OTDR Module E4146QUAD

1. Specify optical connector of each OTDR ports

Modules
Commercial 
References

CWDM OTDR Module from 1471nm to 1611nm for T-BERD/
MTS2000 and 4000 V2

E41CWDM8U

CWDM OTDR Module from 1431nm to 1611nm for T-BERD/
MTS2000 and 4000 V2

E41CWDM10U

CWDM OTDR Module from 1271nm to 1451nm for T-BERD/
MTS2000 and 4000 V2

E41CWDM10L

2. Specify optical connector of each OTDR ports

Modules
Commercial 
References

Tunable DWDM APC OTDR Module - C Band, with Tunable Light 
Source included

E41DWDMC-APC

Tunable DWDM PC OTDR Module - C Band, with Tunable Light 
Source included

E41DWDMC-PC
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MPO Switch Module

FiberComplete modules with OTDR function

Four wavelengths OTDR Module for Corwave application (1290, 1291, 
1293 and 1295 nm)

E41OWDM4C

Modules
Commercial 
References

Modules
Commercial 
Reference

Singlemode MPO Switch Module - 1x12 Pinned MPO - SC/APC E41MPO12SM

Modules Commercial References

Metro-Access/PON 1310/1550 nm FiberComplete Module 
with APC connector. Also includes continuous wave light 
source and built-in Power meter

E4126MA3FCO-APC

Metro-Access/PON 1310/1550 FiberComplete Module with 
PC connector. Also includes continuous wave light source and 
built-in Power meter

E4126MA3FCO-PC

Metro-Access/PON 1310/1550/1625 nm FiberComplete Mod-
ule with APC connector. Also includes continuous wave light 
source and built-in Power meter

E4136MA3FCO-APC

Metro-Access/PON 1310/1550/1625 NM PC FiberComplete 
Module with PC connector. Also includes continuous wave 
light source and built-in Power meter

E4136MA3FCO-PC

Metro-Access/PON 1310/1550/ nm and Filtered 1650 nm 
Fiber Complete module with APC connector. Also includes 
continuous wave light source

E4138FMA365FCO

Module B FiberComplete 1310/1550 nm - PC/APC. Also 
includes continuous wave light source and built-in Power 
meter

E4126B-FCOMP-PC/-APC

Module B FiberComplete 1310/1550/1625 nm - PC/APC. Also 
includes continuous wave light source and built-in Power 
meter

E4136B-FCOMP-PC/-APC
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FiberComplete modules with Fault Finder function

Options

Module B FiberComplete 1310/1550/Filtered 1650 nm - APC.  
Also includes continuous wave light source and built-in Power 
meter

E4138FB65-FCOMP-APC

Modules Commercial References

Modules
Commercial 
References

FiberComplete Fault Finder 1310/1490/1550 nm E4138FCOMP-FF

FiberComplete Fault Finder 1310/1550 nm - APC E4126FCOFF-APC

FiberComplete Fault Finder 1310/1550/1625 nm - APC E4136FCOFF-APC

FiberComplete Fault Finder 1310/1550 nm - APC
Also includes continuous wave light source and built-in power meter

E4126-FCOMPFF-APC

FiberComplete Fault Finder 1310/1550/1625 nm - APC
Also includes continuous wave light source and built-in power meter

E4136-FCOMPFF-APC

Modules
Commercial 
References

Power meter option for OTDR modules E41OTDRPM

Light source option for OTDR modules E41OTDRLS

Mode Conditioner for Multimode fiber
Commercial 
References

Encircled flux mode conditioner embedded in a patchcord for 50 µm 
multimode fiber in FC/PC

EFJEF50CONFCPC 

Encircled flux mode conditioner embedded in a patchcord for 50 µm 
multimode fiber in SC/PC

EFJEF50CONSCPC
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Commercial References of the SmartOTDR

Non Reflective Terminator Packages
Commercial 
References

SC/PC and SC/APC non-reflective terminator package ENRTERMSC

FC/PC and FC/APC non-reflective terminator package ENRTERMFC

OTDR Configurations1 Commercial 
References

SmartOTDR 1550nm A Range Handheld Tester With Continuous 
Light Source & PC Connector

E100A-PC

SmartOTDR 1550nm A-Range Handheld Tester with Continuous 
Light Source & APC Connector

E100A-APC

SmartOTDR filtered 1650 nm A-Range Handheld Tester with APC 
connector

E118FA65-APC

SmartOTDR filtered 1650 nm A-Range Handheld Tester with PON-
XGPON (1490/1550/1578 nm) Power meter and APC connector

E118FA65PPM-APC

SmartOTDR 1310/1550nm A-Range Handheld Tester with Continu-
ous Light Source & PC connector

E126A-PC

SmartOTDR 1310/1550nm A-Range Handheld Tester with Continu-
ous Light Source & APC connector

E126A-APC

SmartOTDR 1310/1550nm & Filtered 1625nm B-Range Handheld 
Tester with Continuous Light Source & PC connector2

E136FB-PC

SmartOTDR 1310/1550nm & Filtered 1625nm B-Range Handheld 
Tester with Continuous Light Source & APC connector

E136FB-APC

SmartOTDR 1310/1550nm & Filtered 1650nm A-Range Handheld 
Tester with PC or APC connector

E138FA65-PC/-APC

1. Comes with AC/DC converter/adapter, hands-free carrying case, stylus and getting started 
manual. 
OTDR connector adapter and battery type (LiPo mandatory for E126A and E136FB) are not 
included.

2. Available with SC OTDR connector adapter (EUSCADS) only
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Commercial references of the User manuals 

Commercial References of optical 
connectors and adapters

User manuals for MTS/T-BERD modules and SmartOTDR
Commercial 
References

Printed user manual for OTDR functions, Options and Soft-
ware applications (French)

E4100M01

Printed user manual for OTDR functions, Options and Soft-
ware applications (English)

E4100M02

Printed user manual for OTDR functions, Options and Soft-
ware applications (German)

E4100M03

NOTE

The User Manuals are available in pdf format, into the unit.

The printed versions are available on option, in French, English or 
German.

Front Panel Optical Connectors for modules1

Single-mode Universal OTDR (Except LA OTDR Modules)
Commercial 
References

Universal PC Connector with FC adapter EUNIPCFC

Universal PC Connector with SC adapter EUNIPCSC

Universal PC Connector with ST adapter EUNIPCST

Universal PC Connector with DIN adapter EUNIPCDIN

Universal APC Connector for SM only with FC adapter EUNIAPCFC

Universal APC Connector for SM only with SC adapter EUNIAPCSC

Universal APC Connector for SM only with ST adapter EUNIAPCST

Universal APC Connector for SM only with DIN adapter EUNIAPCDIN
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1. A connector (universal) must be specified at time of order of the module

Front Panel Optical Connectors for Single-mode LA OTDR 
modules and SmartOTDR1

1. A connector (universal) must be specified at time of order of the module

Commercial 
References

Universal PC Connector with FC adapter (Screw Type) EUNISPCFC

Universal PC Connector with SC adapter (Screw Type) EUNISPCSC

Universal APC Connector ith FC adapter (Screw Type) EUNISAPCFC

Universal APC Connector with SC adapter (Screw Type) EUNISAPCSC

Front Panel Optical connectors for plug-ins1

Multi-mode Universal OTDR

1.  A Connector (fixed or universal) must be specified at time of order of the plug-in

Commercial 
References

Universal PC Connector with FC adapter EUNIPCFCMM

Universal PC Connector with SC adapter EUNIPCSCMM

Universal PC Connector with ST adapter EUNIPCSTMM

Universal PC Connector with DIN adapter EUNIPCDINMM

Universal PC Connector with LC adapter EUNIPCLCMM

 Additional Adapters for Universal Connectors1

1. Interchangeable in the field

Commercial 
References

Universal FC Adapter EUFCAD

Universal FC Adapter (Screw Type) EUFCADS

Universal SC Adapter EUSCAD

Universal SC Adapter (Screw Type) EUSCADS

Universal ST Adapter EUSTAD

Universal LC adapter (Screw Type) EULCADS

Universal DIN Adapter EUDINAD
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